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Proprietary Notice 
The RTS product information and design disclosed herein were originated by and are the property of Telex 
Communications, Inc. Telex reserves all patent, proprietary design, manufacturing, reproduction, use and sales rights 
thereto, and to any article disclosed therein, except to the extent rights are expressly granted to others.  
 
Copyright Notice 
Copyright 2003 by Telex Communications, Inc. All rights reserved. Reproduction in whole or in part without prior 
written permission from Telex is prohibited.  
 
UNPACKING AND INSPECTION  
Immediately upon receipt of the equipment, inspect the shipping container and the contents carefully for any 
discrepancies or damage. Should there be any, notify the freight company and the dealer at once.  
 
WARRANTY INFORMATION  
RTS products are warranted by Telex Communications, Inc. to be free from defects in materials and workmanship for 
a period of three years from the date of sale. The sole obligation of Telex during the warranty period is to provide, 
without charge, parts and labor necessary to remedy covered defects appearing in products returned prepaid to 
Telex. This warranty does not cover any defect, malfunction or failure caused beyond the control of Telex, including 
unreasonable or negligent operation, abuse, accident, failure to follow instructions in the Service Manual or the User 
Manual, defective or improper associated equipment, attempts at modification and repair not authorized by Telex, 
and shipping damage. Products with their serial numbers removed or effaced are not covered by this warranty. To 
obtain warranty service, follow the procedures entitled “Procedure For Returns” and “Shipping to Manufacturer for 
Repair or Adjustment”. This warranty is the sole and exclusive express warranty given with respect to RTS products. 
It is the responsibility of the user to determine before purchase that this product is suitable for the user’s intended 
purpose.  
ANY AND ALL IMPLIED WARRANTIES, INCLUDING THE IMPLIED WARRANTY OF MERCHANTABILITY ARE 
LIMITED TO THE DURATION OF THIS EXPRESS LIMITED WARRANTY. NEITHER TELEX NOR THE DEALER 
WHO SELLS  
RTS PRODUCTS IS LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY KIND. 
 
CUSTOMER SUPPORT  
Technical questions should be directed to:  

Customer Service Department  
RTS/Telex  
12000 Portland Avenue South  
Burnsville, MN 55337 U.S.A.  
Telephone: (800) 392-3497  
Fax: (800) 323-0498 
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Introduction 

Intercom system configuration has never been easier with the advent of Telex's AZedit Intercom System Software. 
AZedit is a Windows®-based, full-featured configuration software, providing online and offline configuration 
capabilities. It gives you the ability to manage multiple intercom systems, assign and reassign users to different ports, 
as well as dynamically add intercom hardware to your system setup without jumper changes, rewiring, or taking the 
system offline. AZedit has the capability to load pre-set configuration files, which means configurations saved to a 
disk can be uploaded to the "live" application at anytime without interruption. AZedit's online and offline configuration 
capabilities allow you to make changes directly to the application or upload changes from a file created at an earlier 
time. 

Features 

• PRINTING OF DESIGNATION STRIPS FOR ZEUS 
FAMILY KEYPANELS: When printing designation 
strips for keypanels, different dimensions for 
the strip height and/ or center-key spacing are 
used for the MKP-4, MKP-12, BKP-4, WKP-4, 
and TKP-4. When a panel contains fewer than 
16 keys, only the actual number of keys is 
printed. 

• ONLINE help: Updated online help file that 
includes help for more items and problem fixes. 

• UPL (USER PROGRAMMABLE LOGIC) CONTROL OF 

IFB PROGRAM INPUT SUPPORT: UPL Control of 
IFB Program Input allows a user to set the 
output action of a UPL statement to change the 
program input of an IFB while the UPL is 
active. (This feature requires ADAM Master 
Controller version 9.16.3 or DBX version 
1.8.2). 

• LOCAL STORAGE OF ADVANCED PARAMETERS: A 
preference setting gives you the ability to store 
Advanced Communications parameters locally, 
so that when a "first birthday" occurs 
connecting to the Intercom with AZedit will 

automatically restore the advanced 
communication settings. 

• AZEDIT: AZedit combines both the ADAMedit and 
ZEUSedit into one program to allow 
communication with both ADAM and ZEUS 
intercoms. 

• MULTIPLE ALPHA SIZES: Permits keypanels with 
different alpha sizes to exist on the same 
intercom. The keypanel view automatically 
changes alpha size to whatever type of keypanel 
is active.  

• ALPHA COUNTERS: Alpha counters permit the live 
update of alphas as they are changed on local or 
remote intercoms. Alpha counters auto-refresh 
alpha changes. 

 Required firmware for Alpha Counters: 

 Adam Master Controller 9.16.0 
 Zeus Master Controller 3.1.0 
 Peripheral Controller 10.8.0 
 DBX 1.8.0 
 AIO Cards 10.2.0 

• VOLUME DISPLAY: Keypanel view shows changed 
and restricted status of volumes. 

 

AZedit Description 

AZedit is automatically configured to work on any Telex intercom system. This means that if you have an ADAM CS 
intercom system, AZedit will display only resources available in your intercom system. On the other hand, if you have 
a multi-frame ADAM intercom system, AZedit will still display all of the resources that are configured to be available in 
your system. 
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Getting Started 

The AZedit software comes with either two 3.5" floppy disks or a CD, used to install the application onto a central 
computer. 

Minimum Requirements for Software Installation 

• Pentium Processor  

• 64 MB Ram 

Note:  The larger the intercom system the more RAM is required to run the software effectively. 
For example, a seven-frame intercom system will require more RAM than a one-frame system. 

• Microsoft® Internet Explorer 5.01 and higher or NT Service Pack 6.0 

• Microsoft® Windows 98,NT, 2000, XP 

 

AZedit Installation and Configuration 

During installation, AZedit creates three subfolders within the application folder. These folders are named Firmware, 
Logs, and Setups. The Firmware folder is the default folder where the application looks for firmware update files. The 
Logs folder is the default location where the application saves log files. The Setups folder is the default location 
where the application saves setup files. When you remove the application, these subfolders will not be removed. 

To install AZedit, do the following, 

1) Insert the AZedit CD into the into CDRom drive. 

2) Take all the defaults, when prompted. 

Uninstalling AZedit 

To uninstall the software, use the Uninstall program supplied on the AZedit disk 
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Intercom Configuration Description 

The intercom configuration is split into two groups: resources and options. 

Resources are the number of intercom ports, party lines, etc. that are available. 
Options describe such things as the number of talk levels for each talk key, or the number of setup pages for each 
keypanel.  

Some options slightly modify the operation of the intercom system. Some resource and option settings are limited by 
the amount of available hardware. For example, in a Resource list, the number of Ports is limited to the number of 
Audio I/O Cards in the intercom system. For other resources and options, the quantity is primarily limited by the 
amount of available memory in the master controller. For example, a party line does not represent any hardware. It is 
a definition of who is a member of the party line. However, each party line definition requires a certain amount of 
master controller memory. Similarly, in the Options list, you can define 2-4 talk levels for all talk key assignments. The 
more talk levels you define, the more master controller memory is required. 

The intercom configuration is actually defined in 3 places within your intercom system: 1) within the master controller 
2) within AZedit and 3) within each setup file. We normally recommend that you set the intercom configuration in the 
master controller first, then apply these settings to AZedit afterward. Once you have done this, your setup files will 
automatically be set to the same settings as the master controller and AZedit. The only time where a user might not 
want all 3 settings to match is when configuring several independent intercom systems. The following paragraphs 
contain a more detailed discussion of the 3 resource settings, and also how to manage the memory limitations. 

 

Connecting and Disconnecting 

There are three different modes AZedit can run in: File, Online, and Server mode. 

File: File mode indicates the computer is not communicating with the intercom system. In this mode, the user can 
create new setup files and open/edit new startup files, without the worry of interrupt users. 

File mode is an excellent way to make a lot of changes that can be uploaded to the software at a later time when the 
system has downtime or a low user base. 

The changes made in File mode can be saved to a disk for upload at a later time. This is also a great way to have a 
backup of changes made to the system.  

 

Online: Online mode indicates the computer is communicating with the intercom system. Users can make changes to 
the intercom configuration or manually send setup files to the intercom system. 

Online mode is a quick and easy way to update or configure a few setup files or intercom configurations. When 
complete, changes are uploaded straight to the system. 

Note: Remember, if a lot of changes are necessary, it is best to use FILE mode because you can 
upload your system changes when user traffic is lowest. 

 

Server: Server mode indicates the computer is online and operating in Server mode. Users can view current intercom 
system configurations, as well as intercom activity. 

While in Server mode, no changes can be made. This is to eliminate any redundancy of effort by more than one user. 
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Connecting to ONLINE Mode from FILE Mode 

Once you have finished making changes to the intercom system in File mode and have saved the changes to a disk, 
you can connect to the intercom system from File mode to upload the changes.  

To connect to ONLINE mode, do the following: 

1. From the menu bar, select Online. 
The Online drop-down menu appears. 

2. From the drop-down menu, select Connect. 
The word ONLINE appears in the lower right-hand corner of the main AZedit window. 

 

To disconnect from ONLINE mode, do one of the following: 

New 

1. From the File menu, select New. 
A message indicating, "you are about to exit ONLINE mode and edit a default intercom setup" appears. 

2. Click OK to accept. Otherwise, click Cancel. 
The word FILE appears in the lower right-hand corner of the main AZedit window. 

Open 

1. From the File menu, select Open. 
A message indicating, "You are about to Exit ONLINE mode and open a file" appears. 

2. Click OK to accept. Otherwise, click Cancel. 
The Setups browse screen appears for you to choose the setup you would like to open. Also, the word FILE 
appears in the lower right-hand corner of the main AZedit window. 

Save 

1. From the File menu, select Save. 
The Save (Online setup) browse screen appears. 

2. In the File Name text box, enter the setup file name to be saved (for example, Setup_9302003.adm). 

3. Click Enter. 
The Confirmation – ONLINE Save As screen appears. 

4. When the option to stay online or enter file mode appears, select Enter FILE Mode. Otherwise, select 
ONLINE. 

5. Click Continue. 
The upload of the setup file begins. You will see a status bar until it is finished uploading the data. Once the 
file is uploaded the word FILE appears in the lower right-hand corner of the main AZedit window 

Otherwise, click Cancel to cancel the upload and return to the main AZedit screen. 

 

Connecting / Disconnecting – SERVER Mode 

Following the status of the Intercom system is vital to effective and efficient operation. Server Mode allows the user to 
monitor real-time intercom activity. Remember, changes to the Intercom system may not be made in SERVER Mode. 

 

Note: You must be in ONLINE Mode before you can enter SERVER Mode. 
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To connect using SERVER Mode, do the following: 

1. From the Online menu, select Server Mode. 
A check mark appears next to Server Mode when it is active, the background in all fields turns purple, and 
the word SERVER appears in the lower right corner of the main AZedit window. 

 

To disconnect from SERVER Mode, do the following: 

1. From the Online menu, click Server Mode. 
The check mark is removed from Server Mode, the background in all fields returns to white, and the work 
ONLINE appears in the lower right corner of the main AZedit window. 

 

Trouble Connecting? 

If you are having trouble connecting to the intercom system, try the following: 

• Verify the power to the Intercom is ON. 

• Verify the Intercom cable is properly connected to the PC. Refer to the cable information in your Intercom 
System. 

• Verify the COM Port and the Baud rate settings are correct 

To adjust the Com port and Baud rate settings, do the following: 

1. From the main menu select Options > Communications. 
The Communications screen appears. 

2. Verify or select the proper settings. 

3. Click OK. 
The Communications screen closes. 

 

By default, AZedit is set for COM1 and 38,400 kbps (38.4 K baud). The baud rate set in AZedit MUST match the 
baud rate setting of the master controllers in the ADAM or ADAM CS frame (DIP Switch #1). The 38,400 kbps setting 
provides the fastest possible file uploads and downloads, but you may experience more communication errors 
operating at this speed than at a lower baud rate setting. Cable lengths of 30-50 ft. (9-15 meters) have been used 
successfully with the 38,400 kbps setting. However, this may not always work under all operating conditions. 

If you suspect that you are experiencing communication problems operating at this speed, check the Master 
Controller Status screen (Status>Master Controller Status). Rapid accumulation of communication errors on the 
right side of that screen indicates a problem. In such cases, check cable construction or cable routing, or use a 
shorter cable. You may have to try different scenarios before one will permit operation at 38,400 kbps.  

 

Configure AZedit 

To ensure the AZedit configuration matches your requirement for the intercom system configuration, make a 
connection to your intercom system 

This can be done from the menu Online and from the sub menu connect or by using the connect button on the 
toolbar. If the toolbar is not displaying a purple plug on this icon the PC connection will need to be adjusted for a 
suitable Com port setting and Baud rate, see, Trouble Connecting, page 7. 

It is also possible the intercom system is not properly configured to show the correct amount of resources. 

To verify that the basic intercom configuration is correct, do the following: 
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1. If you have been working on a setup file, perform a Save. 

2. If you are not connected to the Intercom system, make a Connection. See Connecting – ONLINE mode, 
page XXX. 

3. From the Options menu, select Intercom Configuration. 
A message indicating, "Warning! Changing these settings my cause a mismatch between ADAMedit and the 
settings in the intercom" appears. 

4. Click OK. 
The Intercom Configuration screen appears. 

5. Verify the current settings for Frames and Intercom Type match your intercom system. If needed, make 
any changes to the Resource tab. 

Note: From the Intercom Configuration screen, you may make other setting changes. However, 
many users find the standard settings satisfactory. For more information about the Intercom 
Configuration screen, see the AZedit Help. 

 

Master Controller Intercom Configuration 

In ADAM CS and ADAM intercom systems, the master controller configuration is the key to your intercom system, 
because whatever is defined here is all that will be allowed for actual intercom operation. As you may have guessed, 
it is possible to increase or decrease the quantities of some types of resources and options in the master controller to 
free up memory for larger quantities of other resources. There are also reasons why you might want to reduce or 
eliminate quantities of resources and options that are not required: 

Advantages of reducing master controller intercom configuration settings 

• The intercom system will power up faster with fewer resources. 

• Less memory resources will be used in the system controller. For example, in larger, multi-frame intercom 
systems, where the number of intercom ports can exceed several hundred, the configuration information 
for the ports themselves will require a large portion of the system memory. In such cases, unused IFB's, 
ISO's etc. can be removed from the resource configuration to make room for resources that are being 
used. 

• Scroll lists will be smaller (when viewing them both in AZedit or from a keypanel). 

• AZedit will connect to the intercom system faster (fewer items to upload). 

• AZedit will update faster (fewer items to query). 

• Saving/Loading files will be faster (less data to upload, less data to save/load). 

• Setup files will require less disk space with fewer resources. 

• Checks for duplicate names (alphas) will be faster with fewer resources. 

• Sending changes to the intercom system will be faster with fewer resources. 

• You will not mistakenly configure resources that do not exist (i.e. using ports that do not have Audio I/O 
Cards). 

Disadvantages of reducing master controller intercom configuration settings 

• If you add more hardware later (More Audio I/O Cards, for example) you will have to readjust your master 
controller and AZedit configuration settings. Changing settings in the master controller can take up to 10 
minutes. You may also have to reconfigure your setup files. This may require 2-3 minutes per file if you 
have several files. 
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Procedure to change the master controller intercom configuration settings  

AZedit Intercom Configuration Settings 

Initially, AZedit defines the quantity for each resource and option. However, these quantities may be changed to fit 
your intercom system. 

To assure you are viewing the intercom configuration for the application, and not for a setup file or the master 
controller, do the following: 

If you have been working on a setup file in FILE mode, save any changes you have made. If you have been 
working on the online setup file in ONLINE mode, send your changes to the intercom system. 

 

1. From the File menu, select New, or click the New File button. 

2. From the Options menu, select Intercom Configuration. 
A message indicating, "Warning! Changing these settings my cause a mismatch between ADAMedit and 
the settings in the intercom" appears. 

3. Click OK. 
The Intercom Configuration screen appears with Resource options showing. 

 

Note: When you first install AZedit, it is set to the default resources for a 1-frame ADAM intercom 
system. If you are using AZedit with an ADAM CS Intercom System, or with a multi-frame 
ADAM Intercom System, be sure to make the necessary changes that reflect your intercom 
system size. 
Although you can change the AZedit resource settings at this time, we recommend that you 
change the master controller configuration settings first, then select those settings as the 
AZedit default settings when prompted to do so. 

Setup File Configuration Settings 

When a setup file is opened, the intercom configuration settings for that setup file are loaded. You can change the 
intercom configuration to different settings other than the AZedit default settings. 

The only time you might want to do this is when you are creating setup files for several different 
intercom systems, each with its own set of resources. Usually, you create your setup files using the 
default application resources. 

To create a new file with either the default or the intercom configuration settings, do the following: 

1. From the File menu, select New. 
One of two messages may occur: 
A message indicating, "The current intercom configuration is different than the default configuration. Before 
opening a file, or creating a new file you must select which configuration to use:" appears. 

Note: If you are not prompted, the default settings are already selected. 

A message indicating, "You are about to exit ONLINE mode and edit a default intercom setup" appears. 

2. If prompted, choose to use either the default configuration or the current configuration. 

3. Click OK. 
The word FILE appears in the lower right-hand corner of the main AZedit window. 

Note: You may have previously created AZedit setup files that you want to reconfigure to match the 
current AZedit default settings, or some other settings. For further information, see Changing 
the Configuration Settings in Setup files. 

I
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Screen Descriptions 
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Keypanels and Ports 

 

The Keypanel/Ports screen displays essential keypanel information, such as Port numbers, Keypanel and Port 
Settings, Port Status, Key Assignments, etc.: 

KEYPANEL SETUP: Use this screen whenever you want to connect a keypanel to a particular intercom port and then 
set up that keypanel. Keypanel setup includes assigning the keys and setting other keypanel options. 

NON-KEYPANEL USAGE OF A PORT: Even if you are not using a keypanel at a port, there may still be a few items that 
you will want to configure, like belt pack systems, fiber devices, 2-way radios, PA Systems, Telephone Hybrids, 
etc… Basically, anything that would be a non-data device. 

VIEW KEYPANEL ACTIVITY: View keypanel activity, such as key activations, during operation in ONLINE or SERVER 
mode. 

GPI INPUT ASSIGNMENT: Use GPI inputs to simulate keypanel keys even when no keypanel is connected at an 
intercom port. Use GPI Input setup to define which "key" to activate at a specific port. Then, use the keypanel setup 
to select the port and assign the "key". 

Zeus, ADAM and ADAM CS intercom systems have a General Purpose Interface port (GPI). The GPI port has 8 
control outputs (also referred to as Relays in AZedit) and 8 control inputs located: 

• Zeus: Located on Zeus Back panel, J27 

• ADAM: Located on XCP-ADAM-MC Master Controller Breakout Panel, J11 

• ADAM CS: Located on ADAM CS back panel, J903 

Additionally, all of these intercom systems can connect to one or more UIO-256 Universal Input / Output frames, 
each of which provides 16 control outputs and 16 control inputs. 

 

General Keypanel Setup Procedure 

AZedit helps configure and manage keypanels in the intercom system. Being thorough when setting up the keypanel 
is essential in organizing and effectively managing the intercom system through AZedit. 

To setup a keypanel in AZedit, do the following: 

1. Open AZedit. 

2. In the Port field, enter the port number you want to assign a keypanel. (You can also select a port alpha 
from the Alpha drop down list.) 

Note: If all key assignments are disabled (grayed out) on the selected intercom port, and "Trunk 
Port" displays at the top of the window, the port is reserved for trunking. This means it 
cannot be used for any other purpose. To reclaim the port, run CSTrunk and remove the 
trunking allocation. 

3. Click Edit. 
The Keypanel/Port Configuration screen appears. 

4. Verify or make changes to the various keypanel properties. For more information on the keypanel properties, 
see Keypanel / Ports Configuration. 

Setup Tab: contains basic keypanel configuration options. 

Advanced Tab: contains more advanced configuration options 
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5. Click OK. 
The changes you made are applied to the program and the Keypanel / Port Configuration screen closes. 

Note: While editing the Setup and Advanced tabs, you can click Apply at any time to apply the 
changes without closing the screen. This gives you the freedom to make more changes, if 
needed. 

 

 

 

Screen Items 

Screen Item Field Type Description 

Port text field The Port field displays the identification numbers assigned to 
individual channels to which devices are connected. Intercom 
ports have identification numbers 1, 2 etc. These numbers 
cannot be changed and are not usually commonly referred to by 
intercom system users. 

 

1. In the Port field, enter the port number for which you 
want to configure. 

Alpha drop-down list Each intercom port also has a default name, called an "Alpha". 
This name appears in the alphanumeric display on a keypanel 
when you assign ports to keys for talking and listening. 

The default alpha names are N001, N002 etc. These default 
alpha names can be changed to names that are meaningful to 
keypanel operators using Port Alpha 

 

For more information on changing Alpha Names, see Changing 



 Telex Communications 18 

Screen Item Field Type Description 

Alpha Names. 

 

1. From the Alpha drop down list, select the Alpha 
assigned to the port. 

Scroll Enable check boxes The Scroll Enable check box controls who can view destinations 
in scroll lists and assign those destinations to keypanel keys. 
Scroll lists are lists of names (alphas) for intercom ports. You use 
these scroll lists in AZedit when assigning keys on keypanels. 
Scroll enable check boxes appear in the setup views for the 
following destination types: intercom ports, party lines, IFB's, 
Special Lists, GPI Outputs, UPL Resources, and ISO's. 

Keypanel operators can also use these scroll lists at their 
keypanels to assign keys. If your intercom system is part of a 
larger trunked* intercom system, AZedit operators in remote 
intercom systems, as well as keypanel operators in remote 
intercom systems can use scroll lists to assign destinations in 
your intercom system to keys in their intercom system. You can 
control access to scroll lists, and therefore control the ability of 
other people to assign keys, by changing the Scroll Enable 
parameter. 

When you are using AZedit within your own intercom system, 
you always have access to complete scroll lists. However, 
access for everyone else is controlled as follows:  

Local: If Local is checked, any keypanel operator in your 
intercom system that has a programmable keypanel can find the 
destination name in a scroll list and assign it to a key. If you 
remove this check mark and send the change to the intercom 
system, keypanel operators will not see the destination name in 
their scroll lists, and therefore, will not be able to assign it to a 
key. They will also not be able to assign it using keypad numeric 
entry (KP9X series keypanels). And, if the destination name 
appears in any display on their keypanel, they will not be able to 
copy it to any other key.  

Trunk: The Trunk check box is only selectable if trunking has 
been activated. If you place a check mark here, any keypanel 
operator in a remote intercom system that has a programmable 
keypanel can view the destination in a scroll list and assign it to a 
key on their keypanel. If you remove this check mark and send 
the change to the intercom system, remote keypanel operators 
will not be able to view the destination or assign it to a key. 

AZedit: This item is only selectable if trunking has been 
activated. If you place a check mark here, an AZedit user in a 
remote intercom system will be able to view the destination in a 
scroll list and assign that destination to keypanel keys in the 
remote intercom system. If you do not want remote AZedit users 
to have access, remove the check mark and send the change to 
the intercom system.  

LCP-102: This item appears only in the Keypanels/Ports main 
screen. If this item is enabled and checked, the intercom port will 
be displayed in the IFB input scroll list of an LCP-102 operating 
in PAP mode. This means the port can be selected as the 
program source for an IFB input. 

In the Scroll Enable field, select one or more of the following, 
Local, Trunk, AZedit, or LCP-102. 

Keypanel /Port Settings drop-down list The Keypanel/Port drop down list displays the default page of 
keypanels the user can currently view. The user can select 
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Screen Item Field Type Description 

different pages to edit page setups. 

1. From the Keypanel/Port Settings drop down list, 
select the keypanel type you are configuring. 

Edit button Use the Edit button to open the Keypanel/Port Configuration 
screen. 

For more information on the Keypanel Port Configuration screen, 
see Keypanel Port Configuration. 

Gain Setup for Output 
Port 

button 
   

Opens the Gain Setup for Output Port screen 

1. Click the Gain Setup button. 
The Gain Setup for Output Port screen appears. 

For more information on Gain Setup, see Gain Setup for Output 
Port. 

Port Status icon display The following informational icons are displayed in the Port 
Status group (located in the upper-right corner of the Keypanels 
/ Ports screen): Most of these icons are activated based on 
keypanel features detected by the intercom system master 
controller. 

 Heartbeat Icon: Indicates a data device (keypanel, TIF, or 
Camera Delegate Panel) is connected to the intercom port. 

 Warning Icon: Indicates the intercom port is defined as an 
IFB output (in the IFB Setup screen). 

 Headset Icon: Indicates the connected keypanel has a 
headset selected. 

 LED Icons: Indicate the on/off state of any local 
GPI inputs and outputs. These indicators function only when a 
keypanel with a local GPI port is connected, and the operation is 
controlled by UPL  

Green    =       ON (Asserted) 
Red       =       OFF (Inhibited) 
Gray      =       None 
IN          =       GPI Input 
OUT      =       GPI Output 

 Question Mark Icon: Indicates the keypanel type selected 
(with the Edit button) does not match what is reported by the 
intercom. 

Listen Keys check box and 
text field 

The Listen keys are assigned different ports or alphas. These 
alphas can only listen on these keys. 

Use the D and/or R check box to either latch disable or restrict 
the alpha assigned to that key. 

 

1. In the Listen Key 1 text field, enter the alpha or port 
number you wish to assign to the key. 

2. Select the relevant D check box to disable the key 
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Screen Item Field Type Description 

latching function of the alpha or port number assigned 
to the corresponding key. 

3. Select the relevant R check box to restrict the alpha or 
port number assigned to that corresponding key 
Repeat this step to assign alphas or port numbers to 
the rest of the listen key text fields. 

Note: When a talk or listen key is on, a red dot will appear above 
the key'. 

Talk Keys check box and 
text field 

The Talk keys are assigned to different ports or alphas. These 
alphas can only talk on these keys. 

Use the D and/or R check box to either latch disable or restrict 
the alpha assigned to that key. 

 

In the Talk Key 1 text field, enter the alpha or port number you 
wish to assign to the key. 

Select the relevant D check box to latch disable the alpha or port 
number assigned to the corresponding key. 

Select the relevant R check box to restrict the alpha or port 
number assigned to the corresponding key 
Repeat this step to assign alphas or port numbers to the rest of 
the listen key text fields. 

Note: When a talk or listen key is on, a red dot will appear above 
the key. 

Mode display field The Mode display field shows what mode AZedit is running in. 
There are three modes AZedit can operate: 

Online: In Online mode, the configuration computer is connected 
to the intercom system, and AZedit is communicating with the 
intercom system. You can make changes to the intercom system 
setup, such as changing key assignments, or setting up party 
lines, etc. You can also view various types of intercom activities, 
as well as check the status of various components of the 
intercom system. When changes are made in Online mode, you 
still need to send changes to the program for them to be 
activated. 

Server: In Server mode, AZedit acts like a file server, sending 
setup files to the intercom system, either at scheduled times, or 
when certain events occur. You can send entire setup files, or 
partial setup files that were created using partial save. Server 
mode is typically used with UPL statements. 

File: In File Mode, the configuration computer is not 
communicating with the intercom system, and FILE will display in 
the lower-right corner of the screen. In FILE mode, you can 
create new setup files or open and edit existing setup files. 

FILE mode is recommended if you are making many changes 
and want to save your file to disk and do not need to immediately 
download the changes to the intercom system. 

Note: When in online or server mode, two green 
lights will flash which means there is a connection 
with the matrix. If there is only one green light 
flashing at the bottom of the screen, this means 
the application is operating in File mode. 
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Right-Click Guide to the Keypanel/Port main screen 

Built into AZedit are many different ways to get to the same information, by buttons, menus, and right-clicking. The 
following is a list of menus and screens you can access by right clicking from the Keypanel/Port main screen. 

 

Right Click Action Right-Click Result 

Right-click in the Port field A popup menu appears that gives you the option to: 

Undo – reverses the last action--for example, to 
undo a deletion, thus restoring deleted text to a 
document. 

Cut - removes part of a document, usually placing 
it temporarily in memory so that the cut portion 
can be inserted (pasted) elsewhere. 

Copy - duplicates information and reproduce it in 
another part of a document, in a different file or 
memory location, or in a different medium 

Paste - inserts text or a graphic that has been cut 
or copied from one document into a different 
location in the same or a different document. 

Delete - eliminates text, a file, or part of a 
document with the intention of removing the 
information permanently. 



 Telex Communications 22 

Right-click in a Listen Keys field A popup menu appears that gives you the options to: 

Info: displays import keypanel/port information 
such as, panel alpha, description, setup page, 
key type/level, and key assignment. 

Latch Disable: Selects the "D" (disable) checkbox 
above the Listen key. 

Key Restrict: Selects the "R" (restrict) checkbox 
above the Listen key. 

Change Assignment: Opens the Select Key 
Assignment screen. 

Change Volume: Opens the Gain Setup for 
Output Port screen 

Navigation: From the Navigation, you can: 
Go to Keypanel View (opens Keypanel/Ports 
screen) 
Adjust Crosspoint Settings for this Port 
(opens the Crosspoint Status screen) 
Go to Crosspoint Volume View (opens the 
Crosspoint gains screen 
Go to Party Line Volume View (opens the 
Party Line Gains screen) 

Changes: From the Change, you can: 
Cancel Changes to this/all alphas – this 
undoes all the changes you have made up to 
the last SAVE performed. 

Search: From the Search popup menu, you can: 
Search for this panel (opens the Search 
Status Screen) 
Search for panels with this key assignment 
(only available when a key assignment has 
been made)(opens the Search Status Screen) 

Note: You must be connected to the 
Intercom for some of these menus to 
work. 
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Right-click in a Talk Keys field A popup menu appears that gives you the options to: 

Info: displays import keypanel/port information 
such as, panel alpha, description, setup page, 
key type/level, and key assignment. 

Latch Disable: Selects the "D" (disable) checkbox 
above the Listen key. 

Key Restrict: Selects the "R" (restrict) checkbox 
above the Listen key. 

Change Assignment: Opens the Select Key 
Assignment screen. 

Change Volume: Opens the Gain Setup for 
Output Port screen 

Navigation: From the Navigation, you can: 
Go to Keypanel View (opens Keypanel/Ports 
screen) 
Adjust Crosspoint Settings for this Port 
(opens the Crosspoint Status screen) 
Go to Crosspoint Volume View (opens the 
Crosspoint gains screen 
Go to Party Line Volume View (opens the 
Party Line Gains screen) 

Changes: From the Change, you can: 
Cancel Changes to this/all alphas – this 
undoes all the changes you have made up to 
the last SAVE performed. 

Search: From the Search popup menu, you can: 
Search for this panel (opens the Search 
Status Screen) 
Search for panels with this key assignment 
(only available when a key assignment has 
been made)(opens the Search Status Screen) 

Note: You must be connected to the 
Intercom for some of these menus 
to work. 

Right-click anywhere else on the screen (besides a 
Listen or Talk field) 

A popup menu appears that gives you the options to: 

Undo: reverses the last action--for example, to 
undo a deletion, thus restoring deleted text to 
a document. 

Redo: will redo up to 20 consecutive changes that 
you previously canceled with the Undo 
Button. 

Go Back: lets you go back to previously viewed 
screens (up to 20). 

Go Forward: lets you go forward again when you 
have used Go Back to look at previously 
viewed screens. 

Search: From the Search popup menu, you can: 
Search for this panel (opens the Search 
Status Screen) 
Search for panels with this key assignment 
(only available when a key assignment has 
been made)(opens the Search Status Screen) 

Show Grid: Opens key assignment grid. 
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General Keypanel Setup 

To setup a keypanel do the following: 

1. On the Keypanel / Ports screen, select the intercom port you want to setup. 
Use either of the following methods:  
 
In the Port text box, enter the intercom port number, and then press Enter. 
OR 
From the Alpha drop down list, select the port alpha. 

Note: If all key assignments are disabled (grayed out) on the selected intercom port and "Trunk 
Port" displays at the top of the screen, this means the port is reserved for trunking and cannot be 
used for any other purpose. To reclaim the port, you must run CSTrunk and remove the trunking 
allocation. 

 

2. Click Edit. 
The Keypanel / Port Configuration Setup screen appears. 

3. Verify or make the necessary changes to the Setup screen. 

4. Click the Advanced tab. 
The Advanced screen appears. 

5. Verify or make the necessary changes to the Advanced screen. 

Note: While editing the Setup or Advanced settings you can click Apply at any time to enter your 
changes without closing the screen. 

6. Click OK to save the changes made. Otherwise click Cancel. 
The Keypanel / Port Configuration screen closes. 



 Telex Communications 25 

Port Configuration for Non-Keypanel Usage 

The following are items that you may want to configure in an intercom port when connecting non-keypanel devices. 

Scroll Enable Settings 

Scroll enable check boxes appear in the setup views for intercom ports, party lines, IFB's, Special Lists, GPI Outputs, 
UPL Resources, and ISO's. The Scroll Enable check boxes controls who can view destinations in scroll lists and 
assign those destinations to keypanel keys. When you are using AZedit within your own intercom system, you always 
have access to the complete scroll lists. 

By default, any keypanel operator can assign keypanel keys to talk or listen to intercom ports. You may want to make 
some or all intercom ports inaccessible for key assignment, including intercom ports where there are no keypanels 
connected. 

To enable scroll enable, do the following: 

1. On the Keypanels / Ports screen, select Local, Trunk, ADAMedit, and/or LCP-102 check box. 
The check boxes will highlight with yellow to distinguish the changes made. 

 

Gain Settings 

There may be occasions where you need to adjust the listen gain for a non-keypanel devise that is listening to a party 
line or to some specific intercom port. For example, a belt pack operator may want to monitor a party line, but at a 
lower level than the normal intercom volume. Or, a belt pack operator may want to listen to the background music 
coming from some intercom input port, but at a reduced level. 

To make gain adjustments, do the following: 

1. On the Keypanels / Ports screen, click the gain button. 

 
The Gain Setup for GPI Output screen appears. 

2. Make changes to the gain settings, if necessary. 

3. Click OK. 
The Gain Setup for GPI Output screen closes. 
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Restricting Setup Page Reassignment for all Intercom Ports Using Copy and Paste 

This procedure shows you how to quickly restrict the setup page for all intercom ports. This will prevent any keypanel 
operator at any intercom port from changing the setup page assignments. 

To restrict setup page reassignments for all Intercom ports using copy and paste, do the following: 

1. Select the port for which you want to work. 

2. On the Keypanels / Ports screen, click Edit. 
The Keypanels / Ports Configuration screen appears. 

3. Verify you are on the Setup screen. 

4. Under Setup Page Options, select the Setup Restriction checkbox. 

5. Click OK. 
The Keypanels / Ports Configuration screen closes after recording the changes made. 

6. From the Edit menu, select Copy. 
The entire setup for the selected intercom port is copied. 

7. From the Edit menu, select Paste Special. 
This opens the Paste Special screen, where you can select items you want to paste to the other intercom 
ports. 

 

Note: By default, all items in the Paste Special screen are checked. 

8. Click Clear All. 
All the check boxes are deselected 

9. Under Miscellaneous, select Setup Restrict. 

10. Under Destination, select All Ports. 

11. Click Paste. 
The Paste Special screen closes. On the Keypanels / Ports screen, the setup restrict icon has appeared for 
all ports. 
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Key Restriction Setup using Copy and Paste Special 

This procedure shows you how to quickly set all the restriction check boxes for all intercom ports. This prevents any 
keypanel operator at any intercom port for changing the assignment on any key. 

Note: You must be running in FILE mode. For more information on FILE mode, see 
Connect/Disconnect to FILE mode. 

1. On the Keypanels / Ports main screen, select the port with which you want to work. 

2. Click Edit. 
The Keypanel / Ports Configuration screen appears. 

3. Verify that View by Setup Page is selected. 

4. When verified, click OK. 
The Keypanel / Ports Configuration screen closes. 

5. From the Page drop down list, select any setup page (except the one assigned to Main keypanel). This 
allows you to select the restrict check box for key 16. 

 

6. In the combo box for Listen Key 1, press Ctrl + Shift + r. 
The R check boxes for all listen keys are now selected. 

 

7. In the combo box for Talk Key 1, press Ctrl + Shift + r. 
The R check boxes for all talk keys are selected. 

8. From the Edit menu, select Copy. 
The entire setup page for the intercom is copied. 

9. From the Edit menu, select Paste Special. 
The Paste Special screen appears. 

 

Note: By default, all items in the Paste Special screen are selected. 
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10. Click Clear All. 
All items in the Paste Special screen are deselected. 

Note: You must select All Setup Pages, and then deselect All Setup Pages to activate the 
Individual Key Settings check boxes. 

11. Select All Setup Pages. 
All Setup Pages are selected, as well as Individual Key Settings and All Keys are selected. 

12. Deselect All Setup Pages. 
All Setup Pages are deselected, however, Individual Key Settings and All Keys stays selected. 

13. Select All Ports. 
All Ports are selected. 

14. Under Individual Key Settings, deselect all check boxes, except the Talk Key Restrictions and Listen Key 
Restrictions. 

 

15. Under Copy Setup Pages, deselect all check boxes except for the page you are configuring (for example 
Page 2 to…). 

16. Click Paste. 
It may take a few moments to copy the listen key settings for all intercom ports. Once complete, the Paste 
Special screen closes. 

17. Repeat steps 9 through 16 for all pages. 
Once you are finished, you will see all the R boxes are selected on all the pages. 

Hints: 
• You can save a setup file where you have only configured the R settings. When you want to create a new setup 
file, open the R setup file and use Save As to save the file under a new name. Add your other configuration 
settings, such as talk key assignments, party lines, etc. 
 
• To add R assignments to the ONLINE configuration, SAVE the ONLINE configuration to disk, and then open it 
in FILE mode. Add the R assignments as described. Resave the file. Connect to the intercom system and use 
Send File to update the intercom system. 
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Assigning Auto-Follow to all Listen Keys using Copy and Paste Special 

This procedure shows you how to quickly set all listen keys to auto-follow for all intercom ports. You must be running 
in FILE mode while configuring this setting. 

1. On the Keypanel / Port screen, select the port with which you want to work. 

2. Click Edit. 
The Keypanels / Ports Configuration screen appears. 

3. Verify that View by Setup Page is selected. 

4. Click OK. 
The Keypanels / Ports Configuration screen closes. 

5. From the Page drop down list, select any setup page (except the one assigned to Main keypanel). This 
allows you to select the restrict check box for key 16. For this exercise, Page 2 is selected. 

 

6. In the combo box for Listen Key 1, type AF (Auto-Follow). 

 

7. Press Tab. 
The cursor moves to Listen Key 2. 

8. Repeat steps six and seven until all the listen keys are assigned AF (Auto-Follow). 

9. From the Edit menu, select Copy. 
The entire setup page for the intercom is copied. 

10. From the Edit menu, select Paste Special. 
The Paste Special screen appears. 

 

Note: By default, all items in the Paste Special screen are selected. 

11. Click Clear All. 
All items in the Paste Special screen are deselected. 
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Note: You must select All Setup Pages, and then deselect All Setup Pages to activate the Individual 
Key Settings check boxes. 

12. Select All Setup Pages. 
All Setup Pages are selected, as well as Individual Key Settings and All Keys are selected. 

13. Deselect All Setup Pages. 
All Setup Pages are deselected, however, Individual Key Settings and All Keys stays selected. 

14. Select All Ports. 
All Ports are selected. 

15. Under Individual Key Settings, deselect all check boxes, except the Talk Key Restrictions and Listen Key 
Restrictions. 

 

16. Under Copy Setup Pages, deselect all check boxes except for the page you are configuring (for example 
Page 2 to…). 

17. Click Paste. 
It may take a few moments to copy the listen key settings for all intercom ports. Once complete, the Paste 
Special screen closes. 

18. Repeat steps 9 through 16 for all pages. 
Once you are finished, AF is assigned on all setup pages at all intercom ports. 

Hints: 
• You can save a setup file where you have only configured the AF settings. When you want to create a new 
setup file, open the AF setup file and use Save As to save the file under a new name. Add your other 
configuration settings, such as talk key assignments, party lines, etc. 
 
• To add AF assignments to the ONLINE configuration, SAVE the ONLINE configuration to disk, and then open it 
in FILE mode. Add the AF assignments as described. Resave the file. Connect to the intercom system and use 
Send File to update the intercom system. 
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Assigning Keys 

Warning: Before attempting any kind of key assignment make sure the "Upload Alphas" message is not displayed in 
the lower-left corner of the screen. When starting AZedit, the names for key assignments and intercom systems will 
not display properly until all alphas are uploaded. In a very large intercom system, this could take several minutes. 

 

1. From the Keypanels / Ports screen, right-click in a Talk or Listen combo box. 
A pop up menu appears. 

2. Select Change Assignment. 
The Select Key Assignment screen appears. 

 

Note: "Phones" will only appear in the list if a TIF-951 is connected and operating. In this case, 
you can select Phones" rather than "Ports" to assign a phone key. 

3. In the System drop down list, select the intercom system where the destination is located that you want to 
assign. 

4. In the key type list, select the type of intercom key you want to assign. 

5. In the name list (on the right), select a name (alpha) for the key. 

6. Click OK. 
The Selected Key Assignment screen closes and the selected name appears in the key assignment combo 
box on the Keypanels / Ports screen. 

Note: When you select Special Functions, you can use the no assignment name (----) as a way 
to erase a previous assignment. 

Notes: 
• For the setup page that is assigned to the main keypanel, you cannot assign or use key 16, as this is used for 
incoming messages (this is also referred to as the call waiting window, CWW). For all other setup pages, you 
may assign and use key 16. 
 
• If you are working with keypanels and expansion panels that have 16 keys, it is highly recommended you set 
the Default View (found on the Keypanel/Port Setup page) to by Panel Type. However, if you are using the by 
Setup Page view, you can switch to the by Panel Type view by pressing Ctrl+Tab on the keyboard. 

M
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• You can assign a key by position the cursor in the key assignment text box and then entering the name. Be 
aware, if there are duplicate alphas in the system, the key may take on the wrong assignment. 
 
• After a talk key is assigned, you will notice a new key assignment text box activates under the talk key (except 
the KP-32 in View by Panel Type mode). This can be used as a second key assignment that will activate along 
with the first key assignment. This is referred to as a level 2 talk key. 
 
If more than two talk levels are defined in the intercom configuration (or if you are working with KP-32 in View by 
Panel Type mode) you will also see a scroll arrow at the right side of the screen. Use this scroll arrow to select 
which talk levels you want to view. 
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Keypanel/Ports Configuration 

The Keypanel/Ports configuration screen is used to configure a keypanel in the intercom system. From this screen, 
you can setup your keypanels, choose different screen View options, restrict users from setup, set specific priorities, 
set delay times, IFB listen destinations, enable tone, keypanel privacy, TIF dial out restrictions, and assign a port as a 
TIF. 

The Setup page of the Keypanel/Port Configuration screen is for higher-level configuration options, while the 
Advanced Tab allows you to assign more specific options and restrictions to a keypanel. 

To open the Keypanel/Port Configuration screen, do the following: 

1 From the Keypanel setup screen, click Edit…. 
The Keypanel/Port Configuration screen appears. 

Setup  

Use the Setup tab to configure an intercom port for use with a keypanel. Each keypanel can have up to four setup 
pages of key assignments, and each setup page can assign up to 16 pairs of talk and listen keys. Typically, one 
setup page is used for the main keypanel, and one setup page is used for each expansion panel connected to the 
main keypanel. 

 

Note: Some keypanels may have more or less than 16 keys. There may be cases where all 16 
keys on a setup page are not used. There may also be cases, such as with the KP-32 keypanel, 
where the keypanel itself uses all of the keys on more than one setup page. 
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Screen Items 

Screen Item Field Type Description 

Panel display The Panel field displays which panel is being configured (i.e., 
Main Panel, Expansion Panel 1, etc.). 

Type drop-down list The Type field gives users a list of keypanels that can be 
assigned to the main panel. For example, KP-32, TIF 2000, 
etc. 

 

From the Type drop down list, select the type of keypanel 
being assigned. 

Setup Page drop-down list The Setup Page drop down list gives users a list of pages 
available for configuration on the keypanel. For more 
information, see Pages in the glossary 

 

From the Setup Page drop down list, select the page to be 
configured (i.e., page 1, page 2, etc.). 

Default View radio button Default View gives the user the option of how to view 
keypanels in the application. 

 

by Panel Type: The Keypanel / Ports screen will only display 
the correct quantity of Talk and Listen keys based on the Type 
settings. For example, a setup page that is assigned to the 
KP-12 will display only 12 Talk and Listen keys. Typically, view 
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Screen Item Field Type Description 

by Panel Type is the preferred mode because the user cannot 
assign more keys than are actually available on the keypanel.  

 by Setup Page: The Keypanel / Ports screen displays 
all 16 Talk and Listen key assignments available on a setup 
page, regardless of whether the keypanel or expansion panel 
has that number of keys. 

Note: When viewing the setup pages for a particular 
intercom port, you can switch back and forth between 
view by Panel Type and view by Setup Page by pressing 
Ctrl+Tab on the computer keyboard. If you want to 
change the view mode for all intercom ports, use 
Shift+Ctrl+Tab. 

 

In the Default View field, select either the by Panel Type or by 
Setup Page radio button. 

Show Type radio button The Show Type gives the user the option to manually choose 
the type of keypanel being configured or to let the intercom 
automatically set the type of keypanel. 

Note: You must be working in ONLINE mode to select 
Reported by Intercom. 

 

In the Show Type field, select either Set by User or Reported 
by Intercom. 

Setup Page Options check box The Setup Page Options field gives the user the option to 
restrict other users to change the setup configuration from a 
keypanel.  

By default, keypanel operators can change the setup page 
usage from their keypanels. 

Note: You may want to select the Setup Restrict check 
box for all intercom ports. 

 

From the Setup Page Options field, select the Setup Restrict 
check box if you want to restrict users from changing setup 
options on the keypanel. 

OK button Accepts the changes made and closes the Keypanel/Port 
Configuration screen. 

 

Click OK. 
The Keypanel/Port Configuration screen closes and changes 
are saved. 

Cancel button Clears the changes made and closes the Keypanel/Port 
Configuration screen. 

 

Click Cancel. 
The Keypanel/Port Configuration screen closes and changes 
are not saved. 

Apply button Applies the changes made to the keypanel/port configuration 
screen and leaves the window open. 

 

Click Apply. 
The changes made to the Keypanel/Port Configuration screen 
are applied and the screen stays open. 
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Right-Click Guide to the Keypanel/Port Configuration Setup screen 

There are no right-click menus for this screen. 
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Keypanel / Ports Configuration 

Advanced 

Use the Advanced tab to further configure an intercom port for use with a keypanel. Set priorities for keypanels in 
IFB, Trunk IFB, and Trunk situations. Set the Panel Poll Delay (the amount of time the keypanel waits for data 
transmission). Panel Poll Delays are used when remote keypanels are in the system configuration. On this screen, 
set the IFB Listen Destination port and set Options, such as Enable Tone, Keypanel Privacy, Dial-Out restrictions, 
and Port is TIF parameters. 

The following icons are displayed in the Keypanel / Port Settings group (they appear beneath the Edit button) 

These icons are to remind you certain selections have been made using the Edit button.  

 Musical Note Icon: Indicates that Enable Tone is checked. 

 Sunglass Icon: Indicates that Keypanel Privacy is checked. 

 No Phone Dial Icon: Indicates that TIF Dial-Out Restrict is checked. 

 Modem Icon: Indicates that a Panel Poll Delay has been specified. 

 Phone Icon: Indicates that Port is TIF is checked. 

 "No" Symbol: Indicates that Setup Restrict is checked. 

 

To open the Advanced Keypanel / Ports Configuration screen do the following:  

1. Click Edit 
The Edit Keypanel / Ports Configuration screen appears. 

2. Click the Advanced Tab. 
The Advanced screen appears. 
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Screen Items 

Screen Item Field Type Description 

Priorities text field The Priorities field gives the user a numerical option to 
select which keypanel receives first access to an IFB, trunk 
IFB or Trunk in cases where two or more keypanels are 
trying to access the same port at the same time. 
IFB Priorities Description 

IFB priorities determine which keypanel gets first access to an 
IFB in cases where two or more keypanels are trying to access 
the same IFB at the same time. By default, the IFB priority for 
each intercom port can be individually set to any number from 0 
through 3. With 3 being the highest priority. 

With the priority set to 3, the keypanel overrides any other 
keypanel set at a lower priority. Keypanels that are set to the 
same priority can simultaneously access IFB's.  

To add more IFB priority levels in the intercom configuration 
settings, see Adding more IFB Priority Levels. 

Trunk IFB Description 

Trunk IFB priority determines which keypanel gets first access to 
a remote IFB in cases where two or more keypanels are trying 
to access it at the same time. 

For each keypanel, the trunk IFB priority can be set to any 
number from 1 through 3. With priority 3 being the highest 
priority. With the priority set to 3, the keypanel overrides any 
other keypanel set to a lower priority. Keypanels that are set to 
the same priority can simultaneously access IFB's. 

To add more Trunk IFB priority levels in the intercom 
configuration settings, see Adding more IFB Priority Levels. 
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Screen Item Field Type Description 
Trunk Priority Description 

Depending on how many trunking ports are setup, there may be 
occasions when there are not enough available for everyone to 
use. In such cases, trunk priority settings control the order in 
which keypanels gain access to trunked ports. 

Each keypanel can be assigned a trunk priority ranging from 1 
through 10. With 10 being the highest priority. With a trunk 
priority setting of 10, a keypanel will take over a trunking port 
from a keypanel with a lower setting when there are no other 
trunking ports available. 

 

Note: Before changing intercom 
configuration settings, we recommend you 
read the intercom configuration description. 

1. In the Priorities field, enter a priority for IFB, Trunk 
IFB, or Trunk. 

Panel Poll Delay  text field Panel Poll Delay is used when a keypanel's data line is 
connected to the intercom port via a modem link from a 
remote location. In this situation, there may be a slight delay 
in data transmission from the remote keypanel to the 
intercom system. This can cause sporadic operation or no 
operation at all. 

The panel poll delay first must be activated through the 
Options > Preferences menu. For more information on 
Activating the Panel Poll Delay option, see Panel Poll Delay 
Activation. 

1. In the Panel Poll Delay field, enter the delay time 
the intercom system will wait for data 
transmissions. 

Reset button The Reset button clears the Panel Poll Delay field and sets 
the delay at zero. Zero is the default setting. 

1. Click Reset. 
The Panel Poll Delay resets to zero. 

IFB Listen Destination text field and drop 
down list 

IFB Listen Destination is a keypanel setting used with the 
IFB Listen Source feature. It redirects the IFB listen audio 
from the keypanel speaker or headset to an external device, 
such as a studio monitor, when the keypanel operator 
activates a key to listen to the talent. 

For information on IFB Setup Procedures, see IFB Setup 
Procedures. 

1. In the Port field, enter the port to which you want to 
redirect the audio. 
Once the Port number is entered, the Port Alpha 
field will automatically fill with the Alpha for that 
port. 

Options check box There are four options that can be configured from the 
Options field: 
Enable Tone: 
Digital matrix keypanels are equipped with internal tone generators 
for signal tracing and troubleshooting. The tone signal feeds directly 
into the matrix so it can be used as a voice substitute for testing 
purposes. 

Keypanel Privacy 
The keypanel privacy feature prevents other keypanels from 
listening to another keypanel by means of a point-to-point listen key. 
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Screen Item Field Type Description 
However, if the private keypanel talks to another keypanel, it will be 
heard. The keypanel privacy feature requires ADAM Master 
Controller Firmware Version V9.5.0 or greater. 
Note: Keypanel privacy does not prevent someone from listening to 
a private panel via other means. For example, if the private 
keypanel is a member of a party line or special list, it can be heard 
by anyone listening to the party line or special list. 

TIF Dial Out Restrict 
TIF Dial-Out Restrict prevents a keypanel operator at an intercom 
port from dialing out via a TIF-2000 Telephone Interface. The 
keypanel operator is able to receive incoming phone calls but 
cannot dial out or send a hang-up signal from the keypanel.  

In most cases, the TIF-2000 will detect that the caller at the far end 
has hung up and it will also hang up. However, some telephone 
systems do not provide any hang up indication. In this case, if an 
incoming call is answered from a keypanel that has TIF dial-out 
restrict activated, the phone line will remain engaged after the caller 
at the other end hangs up. 

Port is TIF 
Port is TIF appears only when TIF-2000 support is set up. This 
check box enables the enhanced dialing features of the KP-32 
keypanels. 

 

1. In the Options field, select one or more of the options 
check boxes. 

OK button Accepts the changes made and closes the Keypanel/Port 
Configuration screen. 

1. Click OK if you want to accept the changes, 
otherwise click Cancel. 
The Keypanel/Port Configuration screen closes 
and changes are saved. 

Cancel button Clears the changes made and closes the Keypanel/Port 
Configuration screen. 

1. Click Cancel. 
The Keypanel/Port Configuration screen closes 
and changes are not saved. 

Apply button Applies the changes made to the keypanel/port configuration 
screen and leaves the window open. 

1. Click Apply. 
The changes made to the Keypanel/Port 
Configuration screen are applied and the screen 
stays open. 

Right-Click Guide to the Keypanel/Port Configuration Advanced screen 

Built into AZedit are many different ways to get to the same information, by buttons, menus, and right-clicking. The 
following is a list of menus and screens you can access by right clicking from the Advanced main screen. 
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Right Click Action Right-Click Result 

Right-click in any of the following fields: 
 
IFB Priority 
Trunk IFB Priority 
Trunk Priority 
Panel Poll Delay 
Port Number 

A popup menu appears that gives you the option to: 

Undo – reverses the last action--for example, to undo 
a deletion, thus restoring deleted text to a 
document. 

Cut - removes part of a document, usually placing it 
temporarily in memory so that the cut portion can 
be inserted (pasted) elsewhere. 

Copy - duplicates information and reproduce it in 
another part of a document, in a different file or 
memory location, or in a different medium 

Paste - inserts text or a graphic that has been cut or 
copied from one document into a different location 
in the same or a different document. 

Delete - eliminates text, a file, or part of a document 
with the intention of removing the information 
permanently. 
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Panel Poll Delay Activation 

Panel Poll Delay is typically used when a keypanel's data line is connected to the intercom port via a modem link 
from a remote location. By setting a delay time, the intercom system waits longer for data transmissions from the 
remote keypanel. The delay time can be set anywhere from 0 milliseconds (1/1000 of a second) to 500 milliseconds 
(500/1000's of a second, or 1/2 second). 

Important: Connect only one remote keypanel per Audio I/O card, and assign only one panel poll delay per Audio I/O 
card. Also, since excessive poll delay can impair system performance, use the minimum delay required to assure 
proper operation of the remote keypanel. However, allow for the possibility of fluctuations in the delay time. 

To activate the panel poll delay, do the following: 

1. From the Options menu, select Preferences. 
The Application Preferences screen appears. 

2. Select the Advanced tab. 
The Advanced screen appears. 

3. Select the Enable panel poll delay support check box. 

4. Click Apply. 

5. Click OK. 
Panel Poll Delay is activated and may be adjusted in the Keypanel / Ports Configuration Advanced screen. 
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Gain Setup for Output Port 

Gain is simply the increase of a signal accomplished by increasing the size of the amplitude. AZedit uses Unity Gain. 
Unity Gain is when the amplitude that the audio comes into the matrix system is sent out at the same amplitude. For 
example, if +10 dB comes into the matrix that is set with 0 gain, then +10 dB will leave the matrix. However, if +10 dB 
comes into the matrix that is set with –4 dB gain, then +6dB will leave the matrix. The unity point is seen as zero dB, 
by default. The minimum adjustment for gain levels in AZedit is  +/-.5 dB. A negative gain is known as attenuation 

There are three gain adjustments that can be manipulated from this screen: 

Point-to-Point - Use point-to-point listen gain to adjust the level at which the currently selected intercom port hears a 
selected other intercom port. Point-to-point listen gain is the same thing as Crosspoint Gain, and the adjustment can 
be made on this screen or the Crosspoint Gain screen. 

Note: When you adjust the level at which one port hears another port, keep in mind this affects all 
communications between the two ports. Use the following examples using various types of 
communication where port 1 is talking to port 2 follow to learn what can happen when you adjust 
the gain levels: 

Example 1, Point to Point: Port 1 could press a point-to-point talk key to talk to port 2. Port 2 will 
hear port 1 at whatever level has been set in the Point-to-Point Listen dialog. 

Example 2, Special List: Port 2 could be a member of a special list. Let's say the special list is 
named CREW. Port 1 could have a key assigned to talk to special list CREW. In this case, port 2 
will also hear port 1 at the level that is set in the Point-to-Point Listen dialog for port 2. Even though 
port 1 is not using a point-to-point key, there is still a point-to-point relationship between port 1 and 
every member of special list CREW. 

Example 3, IFB: Port 2 could be specified as the output port for an IFB. Let's say the IFB is named 
TAL1. Port 1 could have a key assigned to talk to IFB TAL1. In this case, port 2 will hear port 1 at 
the level that is set in the Point-to-Point Listen dialog for port 2. Even though port 1 is not using a 
point-to-point key, there is still a point-to-point relationship between port 1 and the output specified 
by the TAL1 IFB, which is port 2. Now, let's say that port 3 also has TAL1 assigned to a key. If the 
point-to-point listen setting for port 2 listening to port 3 is different than the setting for port 2 
listening to port 1, the levels will sound different when port 1 or port 3 talk to port 2 using the TAL1 
key. 

Party Line - Use Party Line Listen Gains to adjust the level at which a specific intercom port hears a specific party 
line. 

Note: You can also set the party line listen gains using party line gain setup. 

Analog I/O - The Analog I/O Gain setting indicates the amount by which the input level to this intercom port has been 
increased or decreased from the normal 0 dB level. The Output Gain setting indicates the amount by which the output 
level from this intercom port has been increased or decreased from the normal 0 dB level. 

Note: You can view the current input and output gain settings for this intercom port, but you cannot 
make changes in this dialog box. To make changes to these settings, close the Gain Setup dialog 
box. Then, in the System menu, point to Gains, and select Analog Input/Output Gains from the pop 
up menu. This will open the Analog Input / Output Gains view. 

To Open the Gain Setup Output Port screen, do the following: 

1. From the Keypanel/Port Main screen, click the Gain button . 
The Gain Setup For Output Port screen appears. 

NOTE:  You can also access the Gain Setup For Output Port screen by right clicking a talk or listen 
key on the Keypanel/Port main screen. 
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Screen Items 

Screen Item Field Type Description 

Point to Point Listen Gains RTS Keypanels are calibrated to send and receive audio at standard operating 
levels of the intercom system. Normally, no audio gain adjustment is required 
when connecting these ports. However, many other types of devices may not 
operate at the standard intercom system levels. 

To insure signal level compatibility between the various types of devices and 
the intercom systems inputs and outputs, there are separate analog input and 
output gain adjustments for each intercom port. In addition to the analog input 
and output gain adjustments for each port, it is also possible to adjust the 
listen gain for any specific port when listening to any other specific port. This is 
called the point-to-point listen gain adjustment. 

Input Port text field The Input Port number of the keypanel to which the user is 
adjusting the listen gain level. 

Note: You can also select the Input Port Alpha first, from 
the Input Port Alpha drop down box. If the Port Alpha is 
selected first, the Input Port will automatically fill with the 
appropriate port number. 

 

1. In the Input Port field, enter the port number of 
the port for which you want to change the listen 
gain level. 
Once the Input Port field is filled, the Input Port 
Alpha will automatically fill with the correct Port 
Alpha. 

Input Port Alpha drop down list The Input Port Alpha is the recognizable name the user 
renamed the port. 

Note: If the Port Alpha is selected 
first, the Input Port will automatically 



 Telex Communications 45 

Screen Item Field Type Description 

fill with the appropriate port number. 

1. From the Input Port Alpha drop down list, select 
the Port Alpha for which you want to change the 
gain level. 

Gain drop down list Gain is the level at which the port listed at the top of the 
screen will hear the input port that you select. Gain 
adjustments can range from +6dB to –99 dB. 

1. From the Gain drop down list, select the new gain 
level. 

Note: Gain adjustments take effect 
when you send your changes to the 
intercom system. Gain settings are 
saved in your setup file if you save it 
to disk. 

Party Line Listen Gains 

Party Line text field The Input Port number of the keypanel to which the user is 
adjusting the gain level. 

Note: You can also select the Input 
Party Line Alpha first. If the Party Line 
Alpha is selected first, the Party Line 
will automatically fill with the 
appropriate port number. 

1. In the Input Port field, enter the port number of 
the port for which you want to change the gain 
level. 

Party Line Alpha drop down list The Party Line Alpha is the recognizable name the user 
renamed the party line. 

Note: You can also enter the Party 
Line first. If the Party Line is 
selected first, the Party Line Alpha 
will automatically fill with the 
appropriate port number. 

1. From the Party Line Alpha drop down list, select 
the Party Line Alpha for which you want to 
change the gain level. 

Gain drop down list Gain is the level at which the port listed at the top of the 
screen will hear the party line that you select. Gain 
adjustments can range from +6dB to –99 dB. 

1. From the Gain drop down list, select the new gain 
level. 

Note: Gain adjustments take effect 
when you send your changes to the 
intercom system. Gain settings are 
saved in your setup file if you save 
it to disk. 

Analog I/O Gains 

Input Gain text field The Input Gain is the amount of gain the input level to the 
intercom port has been increased or decreased. Gain 
adjustments can range from +20dB to –20dB. 
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Screen Item Field Type Description 

Output Gain text field The Output Gain setting is the amount of gain the output 
level to the intercom port has been increased or decreased. 
Gain adjustments can range from +20dB to –20dB. 

Port Gain Reset button The Port Gain Reset button restores the current gain 
setting to its default db. 

Note: Gain resets take effect when 
you send your changes to the 
intercom system. Gain settings can 
also be saved in your setup file, if 
you save it to disk 

1. Click Port Gain Reset, if you want to reset 
the changes you made. 

OK button Saves the changes made and closes the Gain Setup 
screen. 

1. Click OK. 
The gain setup changes are saved and the 
screen closes. 

Cancel button Clears the changes made and closes the Gain Setup 
screen. The changes are NOT saved. 

1. Click Cancel. 
The gain setup screen closes and the 
changes are not saved. 

 

Right-Click Guide to the Gain Setup to the Output Port screen 

Built into AZedit are many different ways to get to the same information, by buttons, menus, and right-clicking. The 
following is a list of menus and screens you can access by right clicking from the Gain Setup to the Output port 
screen. 

Right Click Action Right-Click Result 

Right-click in any of the following fields: 

 

• Point to Point Listen Gains 

• Party Line Listen Gains 

• Analog I/O Gains 

A popup menu appears that gives you the option to: 

Undo – reverses the last action--for example, to undo 
a deletion, thus restoring deleted text to a 
document. 

Cut - removes part of a document, usually placing it 
temporarily in memory so that the cut portion can 
be inserted (pasted) elsewhere. 

Copy - duplicates information and reproduce it in 
another part of a document, in a different file or 
memory location, or in a different medium 

Paste - inserts text or a graphic that has been cut or 
copied from one document into a different location 
in the same or a different document. 

Delete - eliminates text, a file, or part of a document 
with the intention of removing the information 
permanently. 
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Port Alpha 

Ports are the individual channels that devices are connected to within the intercom system. 

Devices can include: 

• 2-way communication devices, such as keypanels, belt packs etc. 

• Audio sources, such as broadcast feeds or background music 

• Miscellaneous audio output devices, such as powered loudspeakers, PA systems etc.  

Communication between Ports 

The audio signal from any input port can be routed to any output port. For example, during keypanel setup, you 
assign keypanel keys so that keypanel operators can talk and listen to other intercom ports. Communication of this 
type is called point-to-point communication. You can also route signals between intercom ports without keypanels. 
One way to do this is to force crosspoints in the Crosspoint Status screen. For more information on Crosspoint Status, 
see Crosspoint Status. Another way to do it is with a GPI input.  

Port ID Numbers and Alphas 

Intercom ports have identification numbers 001, 002 etc. These numbers cannot be changed. 

Each intercom port also has a default name, called an "alpha". This name appears in the alphanumeric displays on 
keypanels when you assign the ports to keys for talking and listening. The default alpha names are N001, N002 etc. 
These default alpha names can be changed to ones that are meaningful to keypanel operators using Port Alpha 
setup. 

 

 



 Telex Communications 48 

Screen Items 

Screen Item Field Type Description 

Port column display The Port column displays the port identification number for 
the intercom port. This identification number cannot be 
changed. 

Alpha column display The Alpha column displays the label given to the port 
(input/output) of the matrix. Alphas are the names that 
appear in the alphanumeric displays on keypanels when 
keys are assigned to talk to destinations in the intercom 
system. Alpha names for intercom ports are assigned using 
Port Alphas setup. Alpha names for everything else are 
assigned using Other Alphas setup. 

Note, 4 characters are shown here but alphas may be 
constructed using 4 ,6 or 8 character labels which may be 
used by keypanels with appropriate sized key displays 

To change the Alpha, do the following: 

1. From the Alpha screen, double-click the port for which 
you want to change the Alpha. 
The Edit/Alpha Description screen appears. 

2. In the Description field, enter a description of the port 
(up to 25 characters). 

3. In the Alpha field, enter a meaningful name for the 
port. For example, if Port 1 is the radio station, you 
may call it by the radio call letters. 

4. Click Done, if you are finished renaming the Ports, 
otherwise, click Next to prompt the next port. 

Alias column display The Alias column displays the Alias assigned to a port. 
Aliases are used only with trunked intercom systems. Alias 
names are used to identify destinations in your intercom 
system to AZedit administrators and keypanel operators in 
remote intercom systems. Aliases are provided because 
sometimes an Alpha name that is being used in your local 
intercom system is also being used in another remote 
intercom system. In this case, you can enter an Alias name 
that will not conflict with the name that is already in use. This 
column will not display unless trunking is enabled. For more 
information on trunking, see the TM2000 user manual. 

Description column display The Description column displays a description of what the 
port is used for (i.e., listening to a radio station, talking to a 
specific user, etc…) 

 

Right-Click Guide to the Alpha screen 

Built into AZedit are many different ways to get to the same information, by buttons, menus, and right-clicking. The 
following is a list of menus and screens you can access by right clicking from the Alpha main screen. 

 

Right-Click Action Right Click Result 

Highlight Port > Right Click Navigation and Changes Popup Menu appears. 

From the Navigation popup menu, you can:  
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Go to Keypanel View (opens Keypanel/Ports 
screen) 

Adjust Crosspoint Settings for this Port 
(opens the Crosspoint Status screen) 

Go to Crosspoint Volume View (opens the 
Crosspoint gains screen 

Go to Party Line Volume View (opens the 
Party Line Gains screen) 

From the Change popup menu, you can: 

Cancel Changes to this/all alphas – this 
undoes all the changes you have made up 
to the last SAVE performed. 

Note: You must be connected to the 
Intercom for some of these menus to 
work. 
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Assigning Alphas (names) to Intercom Ports 

Intercom ports have names called Alphas. As a default, they have generic names, such as N001, N002, etc. Alphas 
appear in the alphanumeric displays on keypanels equipped with displays. It is recommended you change the default 
alphas to names more meaningful to your keypanel operators. You can also add brief descriptions to the Alphas to 
further describe the port and help to distinguish for what the intercom port is being used. 

To assign alphas to intercom ports, do the following: 

1. From the Keypanel / Port screen, click Port Alpha. 
The Port Alphas screen appears. 

 

2. Double-click the port for which you want to change the default alpha. 
The Edit Alpha Description screen appears. 

 

3. In the Description field, enter a description of the Port. 
There is a 24-character limit on this field. 

4. In the Alpha field, enter an alpha for the port. 
There is a 4-character limit on this field. 

Note: The Alpha and Alias fields will be the same, unless you change the Alias field manually. 

5. In the Alias field, enter an alias for the port, if necessary. 
There is a 4-character limit on this field. 

For more information on Alpha vs. Alias, see the screen description for Alpha and Alias. 
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Alternative Method of Assigning Alpha 

If you want to change the name for a particular intercom port while you are viewing the keypanel setup screen for that 
port, you can use this method for assigning Alphas. However, it is not recommended for assigning multiple alphas to 
the intercom system. 

To assign alphas to a port while viewing the keypanel setup screen, do the following: 

1. While viewing the keypanel setup screen, press Ctrl + F12. 
The Edit Alpha Description screen appears. 

2. In the Description field, enter a description of the Port. 
There is a 24-character limit on this field. 

3. In the Alpha field, enter an alpha for the port. 
There is a 4-character limit on this field. 

Note: The Alpha and Alias fields will be the same, unless you change the Alias field manually. 

4. In the Alias field, enter an alias for the port, if necessary. 
There is a 4-character limit on this field. 

For more information on Alpha vs. Alias, see the screen description for Alpha and Alias. 
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Party Lines 

A party line, also called a conference line, is a group of intercom ports that can talk and/or listen to each other. Party 
lines have default names such as, PL01, PL02, etc… These names can be changed using the Other Alpha setup 
screen (for more information, see Other Alphas). Members of a party line are assigned using the Party Line setup 
screen. Once the party line is established, it can be assigned to a keypanel using the Keypanel setup screen (for 
more information, see Keypanels). When a party line is assigned to a keypanel key, this allows the keypanel operator 
to talk and/or listen to the party line without being a member. 

Important: Do not confuse party lines with special lists. A special list is used when a keypanel 
operator needs to listen or talk to a group of intercom panels that are not related. Basically, this is a 
grouping between keypanel type users. 

Party lines are typically used when several users of non-keypanel devices (such as, belt packs or cameras) are used 
in a specific common activity and need to talk/listen to each other constantly. Keypanels are never permanent 
members of party lines. However, a keypanel key can be assigned to occasionally talk or listen to a party line, if 
desired. In party lines, several ports can be made members of the same party line, if needed. 

Note: Party lines are primarily set up for party line members, with occasional access by keypanel 
operators, while special lists are set up mainly for keypanel operators to talk or listen to several 
unrelated intercom ports. 
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Screen Items 

Screen Item Field Description 

PL text box The PL box shows the number of the party line for which you want to 
view. 

Alpha drop-down list The Alpha drop-down list shows the alpha name assigned to the party 
line.  

1. From the Alpha drop-down list, select the Alpha for 
which you want to work. 

Port column display The Port column displays the port available to assign to the party line. 

Alpha column display The Alpha column displays the alpha name of the port available to assign 
to the party line selected. 

P-T column display The P-T column displays the ports that are assigned as permanent 
talkers. This means that the port can only send out signals and not 
receive. The permanent talker assignment is only used with devices that 
cannot instruct the intercom system on how to route the audio. 

Yes indicates the given port transmits audio to the currently viewed party-
line system. 

No indicates the given port does not transmit audio to the currently viewed 
party line system. 

P-L column display The P-L column displays the Permanent Listener status for each port in 
the system. This means that the port can only receive audio signals. 

Yes indicates the given port receives audio from the currently viewed 
party line. 

No indicates the given port does not receive audio from the currently 
viewed party line. 

Key? Column display The Key? Column displays when an intercom keypanel is talking or 
listening to the party line using intercom keys. This column is refreshed 
(updated with current information) frequently during normal operation. 

Note: To force a refresh, either select Refresh from the 
View menu; or press Ctrl+Space. 

Talk: The port has a talk key pressed to talk to the party line. 

Listen: The port has a listen key pressed to listen to the party line. 

Both: The port has both a talk and listen key pressed for 2-way 
communication with the party line. 

PL Talker button Use the PL Talker button to designate selected ports as permanent 
talkers for the currently viewed PL assignment. Party Line Talker 
assignments are only used with devices that cannot instruct the intercom 
system on how to route the audio. This option is usually not used with 
keypanels. 

1. Click PL Talker to make the selected port(s) permanent talkers 
(P-T) for the currently viewed PL assignment. 

PL Listener button Use the PL Listener button to designate selected ports as permanent 
listeners for the currently viewed PL assignment. Party Line Listener 
assignments are only used with devices that cannot instruct the intercom 
system on how to route the audio. This option is usually not used with 
keypanels. 

1. Click PL Listener to make the selected port(s) permanent 
listeners (P-L) for the currently viewed PL assignment. 

NOT PL Talker button Use the NOT PL Talker button to deselect a port or ports as permanent 
talkers for the currently viewed PL assignment. 

1. Click NOT PL Talker to deselect the port assignment as a 
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permanent talker. 

NOT PL Listener button Use the NOT PL Listener button to deselect a port or ports as permanent 
listeners for the currently viewed PL assignment. 

1. Click NOT PL Listener to deselect the port assignment as a 
permanent listener. 

SCROLL ENABLE 

Scroll enable check boxes appear in the setup views for the following destination types: intercom 
ports, party lines, IFB's, Special Lists, GPI Outputs, UPL Resources, and ISO's. The Scroll Enable 
check boxes controls who can view destinations in scroll lists and assign those destinations to 
keypanel keys. When you are using AZedit within your own intercom system, you always have access 
to the complete scroll lists. However, access for everyone else is controlled as follows: 

Local check box If Local is checked, any keypanel operator in your intercom system that 
has a programmable keypanel can find the destination name in a scroll list 
and assign it to a key. If you remove this check mark and send the change 
to the intercom system, keypanel operators will not see the destination 
name in their scroll lists, and therefore, will not be able to assign it to a 
key. They will also not be able to assign it using keypad numeric entry 
(KP9X series keypanels). And, if the destination name appears in any 
display on their keypanel, they will not be able to copy it to any other key. 

Trunk check box The Trunk check box is only selectable if trunking has been activated. If 
you place a check mark here, any keypanel operator in a remote intercom 
system that has a programmable keypanel can view the destination in a 
scroll list and assign it to a key on their keypanel. If you remove this check 
mark and send the change to the intercom system, remote keypanel 
operators will not be able to view the destination or assign it to a key by 
any means. 

AZedit check box The AZedit checkbox is also only selectable if trunking has been 
activated. If you place a check mark here, an AZedit user in a remote 
intercom system will be able to view the destination in a scroll list and 
assign it to keypanel keys in the remote intercom system. If you do not 
want remote AZedit users to have access, remove the check mark and 
send the change to the intercom system. 

PARTY LINE TALLIES 

Local check box Use Local Party Line Tallies when two or more keypanels have keys 
assigned to the same party line within the same Intercom system. 

Note: Typically, the tally indication is in the form of a 
flashing alphanumeric display (KP9x series keypanels) 
or a continuously lit, red LED talk key indicator (most 
other keypanels). The tally indication tells the keypanel 
operator that activating the party key will break in on a 
conversation this is in progress. 

Trunk check box Use Trunk Party Line Tallies when two or more keypanels have keys 
assigned to talk to the same party line across remote Intercom systems. 

Note: Typically, the tally indication is in the form of a 
flashing alphanumeric display (KP9x series keypanels) 
or a continuously lit, red LED talk key indicator (most 
other keypanels). The tally indication tells the keypanel 
operator that activating the party key will break in on a 
conversation this is in progress. 

Select All button Selects all list items in the current view. 

1. Click Select All to select all the items in the current view. 

De-select All button De-selects all list items in the current view that are selected. 
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1. Click De-select All to de-select all ports in the current screen 
view. 

Invert Selection button The Invert Selections button reverses the order in which the list is 
currently displayed. 

1. Click Invert Selection to reverse the list of ports from the current 
view. 

Right Click Guide to the Party Lines Screen 

Built into AZedit are many different ways to get to the same information, by buttons, menus, and right-clicking. The 
following is a list of menus and screens you can access by right clicking from the Party Line main screen. 

Right-Click Action Right-Click Result 

Highlight Port > Right Click A popup menu appears that gives you the following 
options: 

Info: The information contained here shows the party line 
number. Also, Intercom system name and the party line 
alpha will appear in brackets. 

PL Talk: designates the port as permanent talkers for the 
currently viewed PL assignment. 

PL Listener: designates the port as permanent listeners 
for the currently viewed PL assignment. 

From the Navigation menu, you can: 
Open the Party Line Alpha View screen 
Open the Keypanel View screen 
Adjust the Crosspoint Settings for this port 
Open the Crosspoint Volume View screen 
Open the Party Line Volume View screen 
Open the Port Alpha View screen 

From the Changes Menu, you can  
Clear all changes to this PL/All PL- this clears all the 
changes you have made up to the last Save 
performed. 

From the Search menu, you can: 
Search for panels that have the selected port as a key 
assignment. 
Search for panels with the selected party line as a key 
assignment. 

Note: You must be connected to the Intercom 
for some of these menus to work. 

Right-click anywhere on the screen A popup menu appears that gives you the options to: 

Undo: reverses the last action--for example, to undo a 
deletion, thus restoring deleted text to a document. 

Redo: will redo up to 20 consecutive changes that you 
previously canceled with the Undo Button. 

Go Back: lets you go back to previously viewed screens 
(up to 20). 

Go Forward: lets you go forward again when you have 
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used Go Back to look at previously viewed screens. 

 

Search: From the Search popup menu, you can: 
Search for this panel (opens the Search Status Screen) 
Search for panels with this key assignment (only 
available when a key assignment has been made)(opens 
the Search Status Screen) 

Show Grid: Opens key assignment grid. 

 



 Telex Communications 57 

Assigning Alphas to Party Lines 

Party lines have default names, such as PL01, PL02 etc. You can change these names to something more 
recognizable to keypanel operators. You can also add brief descriptions to help you distinguish between party line 
uses.  

To assign a party line alpha, do the following: 

1. From the Keypanel / Ports screen, click Other Alphas. 
The Other Alphas screen appears. 

 

2. Select Party Line Alphas. 
The Party Line Alphas screen appears. 

3. Double-click the PL port you want to assign an alpha. 
The Edit Alpha Description screen appears. 

 

4. In the Description field, enter a description of the party line. There is a 24-character limit to the field. 

5. In the Alpha field, enter a meaningful alpha for the PL port (for example, a camera connected to the PL 
port, may have a name such as CAMS). 

Note: The Alias and Alpha fields populate with the same information. You can change the Alias, if 
needed. For more information see, the Port Alphas screen description. 

6. Click Done. 
The Party Line is renamed. 
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Setting Up a Party Line 

Party lines are primarily set up for party line members, with occasional access by keypanel operators. Party lines are 
typically used when several users of non-keypanel devices, such as belt packs or cameras, are used in a specific 
common activity and need to talk/listen to each other constantly. 

To setup a party line, do the following: 

1. Start AZedit. 
The AZedit application appears. 

2. Click the PL button 
The Party Line screen appears. 

 

3. Select the Ports connected to the PL (for example, 001). 

4. Click PL Talker or PL Listener. 
A "Yes" appears in the appropriate column. 

For more information on PL Talker and PL Listener, see the Party Line screen description. 
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Assign a Party Line to the Keypanel 

Once you have assigned ports that can talk or listen to the party line, you can assign it to a keypanel so that users 
are able to access the party line.  

To assign a party line to the keypanel, do the following: 

1. Click the KP button. 
The Keypanel / Port screen appears. 

2. Right-click a Talk or Listen combo box. 
A popup menu appears. 

3. Select Change Assignment. 
The Select Key Assignment screen appears. 

4. From the Key Type List, select Party Line. 
All ports assigned to Party Lines appear in the right pane. 

 

5. From the Party Line port list, select the Party Line you want to assign to the keypanel, 
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6. Click OK. 
The party line alpha appears in the keypanel display field. 

 

Note: Remember; SEND all your changes to the Intercom System before closing the application. 
If the changes are not sent they are not saved to the intercom system. 
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Setting Audio Levels To and From a Party Line 

To set audio levels to and from a party line, do the following: 

1. From the System menu, select Gains, and then select Analog Input / Output Gains. 
The Analog Input / Output Gains screen appears. 

 

2. Highlight the port for which you want to change the audio levels. 

3. Using the Set Input Gain and Set Output Gain buttons, adjust the Input and Output levels for the port. 

Note: These are initial settings. You can return any time in the future to readjust these settings to 
you operational preferences. 
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Set Overall PL Gains 

This procedure shows you how3 to set overall gain for selected Party Lines. 

To set the overall PL gains, do the following: 

1. Click Gains. 
A popup menu appears. 

 

2. Select PL Gains. 
The Party Line Gains screen appears. 

 

3. Select the PL you want to adjust. 

4. Using the Gain Controls, adjust the gain for the party line accordingly. 

Note: Remember; SAVE all your changes to the Intercom System before closing the application. 
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IFBs (Interrupted Fold Back) 

IFB is a method for a keypanel operator to interrupt an audio source that someone is listening to and then talk to that 
listener. When the keypanel operator is finished talking and turns off the IFB key, the original audio source "folds 
back", or reconnects, to the listener. IFB could be used to interrupt background music on a PA system while someone 
is paging. Mostly, though it is used in broadcasting to cue talent, such as news anchors, field reporters, etc. 

ADAM and ADAM CS intercom systems are capable of four variations of IFB: 

• Standard one-way IFB, where the keypanel operator only needs to talk to the listener. 

• Two-way IFB, where the keypanel operator can talk and monitor the talent during IFB operation. 

• Two-way IFB, where the keypanel operator can talk and several people can monitor the talent over an 
external speaker or other device during IFB operation. 

• Tone override IFB, which uses an external control box and a 2400 kHz tone to control IFB operation. This 
type of IFB requires specialized equipment and is not generally used. 

 

 

Screen Items 

Screen Item Field Type Description 

IFB list column Displays the IFB number. This number cannot be changed. 
However, you can control how many IFB's are available for 
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However, you can control how many IFB's are available for 
use by changing the intercom configuration settings. 

Alpha list column The Alpha column displays the name assigned to the IFB. 
Default names are IF01, IF02 etc. You can change these 
names to ones that are more meaningful to keypanel 
operators. 

 

1. Click the row where you want to change the Alpha 
name, then press Ctrl + F12. 
The Edit Alpha/Description screen appears. 

DIM list column Displays the Dim Level you set in the Edit IFB screen. 

No indicates that no dimming values have been set and the 
program audio will be completely muted during IFB operation. 

LC list column The LC column displays the scroll enable settings for the IFB: 

LC = Local 
TK = Trunk 
AE = AZedit 

For each type of scrolling, the letters appear green if that type 
of scrolling is enabled, and brown (or red when selected) if that 
type of scrolling is disabled. 

TK list column The TK column displays the scroll enable settings for the IFB: 

LC = Local 
TK = Trunk 
AE = AZedit 

For each type of scrolling, the letters appear green if that type 
of scrolling is enabled, and brown (or red when selected) if that 
type of scrolling is disabled. 

AE list column The AE column displays the scroll enable settings for the IFB: 

LC = Local 
TK = Trunk 
AE = AZedit 

For each type of scrolling, the letters appear green if that type 
of scrolling is enabled, and brown (or red when selected) if that 
type of scrolling is disabled. 

Input list column The Input column displays the port settings that are set up for 
each IFB. 

Alpha list column The Alpha column displays the port settings you set up for 
each IFB 

Output list column The Output column displays the port settings you set up for 
each IFB 

Alpha list column The Alpha column displays the port settings you set up for 
each IFB 

Gain list column The Gain column displays the analog output gain for the 
intercom port that has been designated as the IFB Output. If 
the IFB listening device that is connected to the output port 
does not have a volume control, you can adjust the analog 
output gain to suit the listener's preference. The analog output 
gain be adjusted on the Analog Input / Output Gains screen or 
from an LCP-102 that is operating in PAP mode. 

NOTE: To access the Edit IFB screen, double-click an IFB from the list, the IFB edit screen will 
appear. For more information on the Edit IFB screen, see the AZedit Help file. 
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Right-Click Guide to the IFB Screen 

Built into AZedit are many different ways to get to the same information, by buttons, menus, and right-clicking. The 
following is a list of menus and screens you can access by right clicking from the IFB main screen. 

Right Click Action Result 

Highlight Port > Right Click 
A popup menu appears that gives you the following 
options: 

Info: The information contained here shows the IFB 
Name, description, default input, output, listen source, 
tone override input, and Dim setting. 

Scroll Enable: Gives the user the ability to set scroll 
enable for Local ports, Trunk ports, AZedit ports. 
 
From the Scroll Enable menu, select Local, Trunk, or 
AZedit. 

From the Navigation menu, you can: 
Go to IFB Priorities View 
Go to IFB Listen Source View 
Go to IFB Listen Destination View 
Go to IFB Alpha View 

From the Changes Menu, you can  
Clear all changes to this IFB /all IFBs..,.- clears all the 
changes you have made up to the last Save 
performed. 

From the Search menu, you can: 
Search for panels with this IFB assigned… 

Note: You must be connected to the Intercom 
for some of these menus to work. 

Right-click anywhere on the screen A popup menu appears that gives you the options to: 

Undo: reverses the last action--for example, to undo a 
deletion, thus restoring deleted text to a document. 

Redo: will redo up to 20 consecutive changes that you 
previously canceled with the Undo Button. 

Go Back: lets you go back to previously viewed screens 
(up to 20). 

Go Forward: lets you go forward again when you have 
used Go Back to look at previously viewed screens. 

Search: From the Search popup menu, you can: 
Search for this panel (opens the Search Status Screen) 
Search for panels with this key assignment (only 
available when a key assignment has been made)(opens 
the Search Status Screen) 

Show Grid: Opens key assignment grid. 
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Assign IFB Alphas 

IFB Alphas appear in the keypanel display window to whichever key it is assigned. 

To assign IFB Alphas, do the following: 

1. From the Keypanel / Port screen, click Other Alphas. 
The Other Alphas screen appears. 

2. Select IFB Alphas. 

3. Click OK. 
The IFB Alphas screen appears. 

4. Double-click the IFB you wish to assign an alpha. 
The Edit Alpha Description screen appears. 

 

5. In the Description field, enter a description for the IFB. 

6. In the Alpha field, enter a familiar name to recognize the IFB. 

Note: The Alias and Alpha fields populate with the same information. You can change the Alias, if 
needed. For more information see, the Port Alphas screen description. 

7. Click Done. 
The IFB is assigned a recognizable alpha. 
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Configure an IFB 

To configure an IFB, do the following: 

1. Click the IFB button. 
The IFB screen appears. 

2. From the IFB list, select the IFB you want to configure. 

3. Double-click the IFB. 
The Edit IFB screen appears. 

 

Note: To restrict keypanel operators from assigning this IFB to keys on their keypanels, make sure 
not to select any check boxes under Scroll Enable. 

4. In the Input field, enter the port number or select the port alpha of the intercom port where the normal 
audio source is connected. 

5. In the Output field, enter the port number or select the port alpha of the intercom port where the talent 
earset or headset is connected. 

Note:  

• By default, the audio source is muted while the keypanel operator is talking. If you want to signal 
to be diminished by a certain amount during IFB, select a different amount in the Dim Level drop 
down list. 

• The Listen Source field is only used for 2-way IFB operation. It allows keypanel operators and/or 
studio personnel to listen to the talent during IFB Operation. Connect the talent Mic signal (the 
direct mic signal, not the mix-minus signal) to an intercom port input. Then, select that port in the 
Listen Source field. For more information on Listen Source setup, see Listen Source. 

For more information on Tone Override, see Set Tone Override IFB Setup. 

6. Click Done. 
The changes are made to the screen. However, be sure to save your changes or they will be lost. 
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Listen Source 

To use the Listen Source feature, a pre-fade mic feed from the talent's mic, through the mix console, and is then 
connected to an available input port in the matrix. The port number or alpha is entered on the Edit IFB screen in the 
Listen Source Field. Remember; the port alpha for this input source must be entered first under Port Alpha settings. 
Verify this port is not a duplicate alpha in the system. 

When the listen source is set, go to the keypanel and assign the IFB to a keypanel key. For information on how to 
assign an IFB to the keypanel see, Assign an IFB to a Keypanel. 

Tone Override IFB Setup 

The Tone Override IFB is not used for Standard IFB. 

To use tone override IFB setup, do the following: 

1. From the Options menu, select Preferences. 
The Application Preferences screen appears. 

2. Click the Advanced tab. 
The Advanced screen appears. 

 

3. Select the Enable IFB tone override input support check box. 

4. Click Apply. 
The change is applied. 

5. Click OK. 
The Applications screen closes. 

6. Click the IFB button. 
The IFB screen appears. 

7. Double-click the IFB you want to set tone override IFB. 
The Edit IFB screen appears. 

8. In the Tone Override field, enter the port number or select the port alpha where the 2400 kHz 
tone source is connected. 

 

9. Click Done. 
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Assign a IFB to the Keypanel 

Once you have assigned ports that can talk or listen to the party line, you can assign it to a keypanel so that users 
are able to access the party line.  

To assign a party line to the keypanel, do the following: 

1. Click the KP button. 
The Keypanel / Port screen appears. 

2. Right-click a Talk (or Listen) combo box. 
A popup menu appears. 

3. Select Change Assignment. 
The Select Key Assignment screen appears. 

 

4. From the Key Type List, select IFBs. 
All ports assigned to IFBs appear in the right pane. 

5. From the IFB port list, select the IFB you want to assign to the keypanel, 

6. Click OK. 
The IFB alpha appears in the keypanel display field. 

 

Note: Remember; SEND all your changes to the Intercom System before closing the application. 
If the changes are not sent they are not saved to the intercom system. 
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IFB Priority Setup 

Set the IFB priority when you want to give one user access to the IFB over another user. For example, a director 
and an assistant can be setup to communicate with the same IFB. If IFB priority has been set, giving the director a 
higher priority than the assistant. Anytime the assistant is communicating with the IFB and the director wants to talk to 
the IFB, the assistant will be cut off from the IFB and see a busy signal (double asterisks) on the keypanel display 
until the director is finished talking to the IFB. 

The default IFB priority setting for all users is one. You can configure the maximum priority level (up to 8 levels). For 
more information on how to configure priority levels, see Configure System IFB Priority Levels.  

Note: A priority of zero does not allow a port the ability to interrupt an IFB if it is talking with a higher priority. 

To set IFB priority for multiple ports, do the following: 

1. From the System menu, select IFB Priority. 
The IFB Priority screen appears. 

 

2. From the Port list, select the ports you want to set the IFB priority. 

3. Under Set priority of selected ports, select the priority to set the ports (for example, 2). 

Note: Remember; SEND all your changes to the Intercom System before closing the application. 
If the changes are not sent they are not saved to the intercom system. 

 

To set IFB priority for individual ports, do the following: 

1. On the Keypanel / Port screen, select the port for which you want to set the priority. 

2. Click Edit. 
The Keypanel / Port Configuration screen appears. 
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3. Click the Advanced tab 
The Advanced screen appears. 

 

4. In the IFB priority field, enter the priority you want to assign to the individual port. 

5. Click Apply. 
The changes are applied to the application. 

6. Click OK. 
The Keypanel / Port Configuration screen closes and the priority is set. 

Note: Remember; SEND all your changes to the Intercom System before closing the application. 
If the changes are not sent they are not saved to the intercom system. 
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Configure System IFB Priority Levels 

By default, the IFB priority level ranges from one to three (one being the lowest priority). However, if your application 
needs to support more than three priority levels, you can configure the system IFB priority level as high as a level 
eight priority. 

To configure the IFB priority level, do the following: 

1. From the Options menu, select Intercom Configuration. 
A Warning screen appears. Be sure to read this carefully. 

2. Click OK. Otherwise, click Cancel. 
The Intercom Configuration screen appears. 

3. Click the Options tab 
The Options screen appears. 

 

4. In the Maximum IFB priority field, enter the maximum priority level you want (up to level eight). 

5. Click Apply. 
A warning indicating that you are changing the intercom configuration appears. 

6. Click OK. 
A message indicating, "Would you like to make this configuration the AZedit default?" appears. 

7. Click Yes, to make the setting the default and close the Options screen. 
Click No, to cancel the changes and close the Options screen. 
Click Cancel, to cancel the configuration change, but not close the Options screen. 

Note: Remember; SEND all your changes to the Intercom System before closing the application. 
If the changes are not sent they are not saved to the intercom system. 
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Special Lists 

A special list is a group of intercom ports a keypanel operator can talk or listen to by activating a single key. Special 
lists are typically used for paging, all call, group call, etc. Special lists have default names such as SL01, SL02, etc. 
The names can be changed to more meaningful names by using the Other Alpha setup screen. Members of a 
Special List are defined through the Special List setup screen. Once a special list has been set up, typically keypanel 
keys can be configured using Keypanel setup. Once the keypanels are setup, then a keypanel operator can activate 
the special list key to talk or listen to all members of the special list. 

IMPORTANT: Do not confuse special lists and party lines. A special list is used when a keypanel operator 
needs to occasionally talk or listen to a group of intercom ports that are otherwise unrelated. A party line is 
used when several users of non-keypanel devices (such as belt packs or camera intercoms) are engaged in 
a specific common activity and need to talk and/or listen to each other all the time. Keypanels are almost 
never members of party lines. However, a keypanel key can be assigned to occasionally talk or listen to a 
party line, if desired. Party lines are primarily set up for party line members, with occasional access by 
keypanel operators; while special lists are set up exclusively for keypanel operators to talk or listen to 
several unrelated intercom ports. 
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Screen Items 

Screen Item Field Type Description 

SL text box Displays the SL number assigned to the Special List being 
viewed. 

Alpha drop-down box Indicates the Alpha assigned to the Special List being viewed. 

 

To change the Special List being viewed, do the following: 

1. From the Alpha drop-down list, select the Alpha of 
the Special List you want to view. 
The information of the Alpha you select appears. 

Port list column The Port column displays a list of ports within the intercom 
system. 

Alpha list column The Alpha column displays a list of alphas within the intercom 
system. 

SL Member? list column The SL Member? column indicates whether the selected port 
is a member of the special list currently being viewed. 

Scroll Enable check box Scroll enable check boxes controls who can view destinations 
in scroll lists and assign those destination to keypanel keys. 
When using AZedit within your own intercom system, access 
to the complete scroll lists is always available. However, 
access for everyone else is controlled as follows: 

Local: If Local is checked, any keypanel operator in the 
intercom system that has a programmable keypanel can find 
the destination name in a scroll list and assign it to a key. If 
the checkbox is not selected, keypanel operators will not see 
the destination name in their scroll lists, and therefore, will not 
be able to assign it to a key. They will not be able to assign it 
using a keypad numeric entry (KP9x series keypanels). And, if 
the destination name appears in any display on their keypanel, 
they will not be able to copy it to any other key. 

Trunk: The Trunk checkbox is only selectable if trunking is 
activated. If the Trunk checkbox is selected, any keypanel 
operator in a remote intercom system that has a 
programmable keypanel can view the destination in a scroll list 
and assign it to a key on their keypanel. If this checkbox is not 
selected, remote keypanel operators cannot view the 
destination or assign it to a key on their keypanel. 

AZedit: The AZedit check box is only selectable if trunking has 
been activated. If the check box is selected, an AZedit user in 
a remote intercom system will be able to view the destination 
in a scroll list and assign it to keypanel keys in the remote 
intercom system. If the check box is not selected, AZedit users 
will not have access to view and assign keypanel keys. 

Note: To turn off the Scroll Enable check boxes for all 
intercom ports, party lines, etc., see Scroll Enable setup. 

Relay / Alpha text box and drop 
down box 

The Relay text box displays the number assigned to the 
selected GPI Output. Relays are optional in special lists. If a 
relay is selected, the relay will close when the special list 
currently being viewed is activated from a keypanel. 

The Alpha drop down list contains the alpha or name 
assigned to the selected relay. 

Add to SL button The Add to SL button removes the selected port(s) from the 
special list. 
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1. Highlight the port(s) you want to remove from the 
special list, and then click Add to SL. 
The port(s) you highlighted is added to the special list 
and YES appears in the SL Member? column. 

Note: To select multiple ports, press the Ctrl key, and then 
select the ports. 

Remove from SL button The Remove from SL button removes the selected port(s) 
from the special list. 

1. Highlight the port you want to remove from the 
special list, and then click Remove from SL. 
The port(s) you highlighted is removed from the 
special list and NO appears in the SL Member? 
column. 

Note: To select multiple ports, press the Ctrl key, and then 
select the ports. 

Select All button The Select All button selects all the available ports in the Port 
list. 

1. Click Select All. 
All the ports in the port list are highlighted. 

De-select All button The De-select All button removes the select highlight from the 
all the ports in the port list. 

1. Click De-select All. 
All the ports highlighted in the port list are 
deselected. 

Invert Selection button The Invert Selection button reverses the selections made. 
For example, if 3 ports are highlighted, and Invert Selection is 
clicked, the three ports that were highlighted are no longer 
highlighted while the rest of the port list becomes highlighted. 

1. Click Invert Selection. 
The highlighted ports are no longer highlighted, while 
ports that were not highlighted become highlighted. 

Right-click guide to the SL screen 

Built into AZedit are many different ways to get to the same information, by buttons, menus, and right-clicking. The 
following is a list of menus and screens you can access by right clicking from the SL main screen. 

 

Right-Click Action Result 

Highlight Port > Right Click 
A popup menu appears that gives you the following 
options: 

Info: The information contained here shows the 
Special List Name, description, the number of 
members for the special list, selected port, and the 
description of the port. 

Member: Gives the user the ability to select or de-
select a port for the Special List. 

From the Navigation menu, you can: 
Go to Special Lists Alpha View 
Go to Keypanel View 
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Adjust Crosspoint Settings for this Port 
Go to Crosspoint Volume View 
Go to Party Line Volume View 
Go to Port Alpha View 

From the Changes Menu, you can  
Clear all changes to this SL /all SLs..,.- clears all 
the changes you have made up to the last Save 
performed. 

From the Search menu, you can: 
Search for panels with this port alpha as a key 
assignment. 
Search for panels with this special list alpha as 
a key assignment. 

Note: You must be connected to 
the Intercom for some of these 
menus to work. 

Right-click anywhere on the screen A popup menu appears that gives you the options 
to: 

Undo: reverses the last action--for example, to 
undo a deletion, thus restoring deleted text to a 
document. 

Redo: will redo up to 20 consecutive changes that 
you previously canceled with the Undo Button. 

Go Back: lets you go back to previously viewed 
screens (up to 20). 

Go Forward: lets you go forward again when you 
have used Go Back to look at previously viewed 
screens. 

Search: From the Search popup menu, you can: 
Search for this panel (opens the Search Status 
Screen) 
Search for panels with this key assignment (only 
available when a key assignment has been 
made)(opens the Search Status Screen) 

Show Grid: Opens key assignment grid. 
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Assign Special List Alphas 

Special lists have default names, SL01, SL02, etc. You can change the defaults to more meaningful names. You can 
also enter a brief description to give further information and keep track of the special lists that you use. 

To assign alphas to multiple special lists, do the following: 

3. In AZedit, click Other Alphas. 
The Other Alphas screen appears. 

4. From the Other Alphas screen, select Special List Alpha. 
The Special List Alpha screen appears. 

5. Double-click a Special List. 
The Edit Alpha Description screen appears. 

 

6. In the Description field, enter a description of the special list (for example, Sound Techs). The description 
field has a 24-character field limit. 

7. In the Alpha field, enter a meaningful name that users would recognize for the special list (for example, 
SND1). The Alpha and Alias fields have 4-character field limits. 

Note: The Alias and Alpha fields populate with the same information. You can change the Alias, if 
needed. For more information see, the Port Alphas screen description. 

8. Click Next to assign another alpha. Otherwise, click Done. 
The Special List default alpha is changed. 

To assign a special list alpha during the special list setup, do the following: 

1. In AZedit, click SL. 
The Special Lists screen appears. 

2. Press Ctrl + F12. 
The Edit Alpha Description screen appears. 

 

9. In the Description field, enter a description of the special list (for example, Sound Techs). The description 
field has a 24-character field limit. 

10. In the Alpha field, enter a meaningful name that users would recognize for the special list (for example, 
SND1). The Alpha and Alias fields have 4-character field limits. 

Note: The Alias and Alpha fields populate with the same information. You can change the Alias, if 
needed. For more information see, the Port Alphas screen description. 

11. Click Done. 
The Special List default alpha is changed. 
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GPI Out 

ADAM and ADAM CS intercom systems have a General Purpose Interface (GPI) port. GPI ports have eight control 
outputs (also referred to as relays) and eight control inputs. The location of the GPI port on the ADAM and ADAM CS 
is as follows: 

ADAM: Located on XCP-ADAM-MC Master Controller Breakout Panel, J11. 

ADAM CS: Located on ADAM CS back panel, J903. 

GPI Port Pin-out 

All 25-pin GPI Port connectors have the same pin-out as follows: 

Pin No. Function: 

 

1. GPI In #1 (+5 to +18 VDC) 

2. GPI In #2 (+5 to +18 VDC) 

3. GPI In #3 (+5 to +18 VDC) 

4. GPI In #4 (+5 to +18 VDC) 

5. GPI In #5 (+5 to +18 VDC) 

6. GPI In #6 (+5 to +18 VDC) 

7. GPI In #7 (+5 to +18 VDC) 

8. GPI In #8 (+5 to +18 VDC) 

9. Common 

10. Common 

11. Common 

12. Common 

13. Common 

14. GPI Out #1 

15. GPI Out #2 

16. GPI Out #3 

17. GPI Out #4 

18. GPI Out #5 

19. GPI Out #6 

20. GPI Out #7 

21. GPI Out # 

22. Common 

23. Common 

24. Common 

25. Common 

 

GPI Inputs for UIO-256, ADAM, and ADAM CS: Connect +5 to +18 VDC between any GPI input and common to 
activate that GPI input. 

GPI outputs UIO-256: Activating a GPI output causes a relay contact closure between that output and common. The 
relay contacts are rated for 0.5A at 120 VAC; 1A at 24 VDC; 0.3A at 60 VDC. 

GPI Outputs for ADAM and ADAM CS: Activating a GPI output causes an active high output. This can be changed 
to active low by going to the Options menu and selecting Intercom Configuration (on the Options sheet, select the 
Configure onboard GPI Outputs in FR9528 mode). 

 

GPI Outputs 

Also, referred to as Relays, GPI Outputs can be used to activate external devices directly from keypanel keys. For 
example, an external lighting control device can be activated from a keypanel key. A GPI Output can also be set up to 
activate when a person talks to a certain port. For example, connect a 2-way radio to an intercom port and then set 
up a GPI output to activate whenever anyone talks into the transmitter. GPI Outputs can also be used to activate 



 Telex Communications 79 

external devices from User Programming Language (UPL) statements. For example, you can set up a UPL state that 
says to activate external lights everyday at 5:00 pm every day. By setting up a UPL, the lights are controlled by the 
GPI Output. Additionally, GPI Outputs can be used as input conditions for UPL statements, as well. For example, use 
the GPI Output statement that activates the external lights as input for another UPL statement. The output action for 
this UPL statement could be to activate another GPI output, which lights a console LED to provide confirmation that 
the external lights are on. 

GPI Outputs have default names RY01, RY02, etc. Use Other Alpha Setup to change these names to something 
more meaningful for key assignments. Once a name has been assigned to the GPI Output, setup of the action that 
GPI Output can be setup through GPI Output setup. 

 

Screen Items 

Screen Item Field Type Description 

RY list column The RY (relay) column displays the GPI Output number. This 
number cannot be changed. However, you can control how 
many GPI Outputs are available for use by changing the 
Intercom configuration. For example, basic system hardware has 
8 GPI outputs. If additional UIO-256 frames are attached, the 
GPI outputs can be extended beyond this limit. 

Alpha list column The Alpha column displays the name assigned to the GPI 
Output. Default names are RY01, RY02, etc… 

To change this name to a more familiar name, do the following: 

1. Select a row, and then press Ctrl+F12. 
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The Edit Alpha / Description screen appears. 

Note: The Ctrl+F12 may need to be activated before it will 
function properly. 

LC list column The LC column displays the scroll enable settings for the GPI 
Output port. 

LC indicates Local 

TK indicates Trunk 

AE indicates AZedit 

For each type of scrolling, the letters will appear green if that 
type of scrolling is enabled, brown (or red when selected) if that 
type of scrolling is disabled. 

TK list column The TK column displays the scroll enable settings for the GPI 
Output port. 

LC indicates Local 

TK indicates Trunk 

AE indicates AZedit 

For each type of scrolling, the letters will appear green if that 
type of scrolling is enabled, brown (or red when selected) if that 
type of scrolling is disabled. 

AE list column The AE column displays the scroll enable settings for the GPI 
Output port. 

LC indicates Local 

TK indicates Trunk 

AE indicates AZedit 

For each type of scrolling, the letters will appear green if that 
type of scrolling is enabled, brown (or red when selected) if that 
type of scrolling is disabled. 

Input list column The Input column displays the port settings set up for each GPI 
Output. 

Alpha list column The Alpha column displays the name of the input port settings 
set up for each GPI Output. 

Output list column The Output column displays the output port settings for each 
GPI Output. 

Alpha list column The Alpha column displays the name of the output port settings 
for each GPI Output. 

Status list column The Status column displays information in ONLINE or SERVER 
mode only.  

If the GPI Output is activated, ON will display, otherwise OFF will 
display. 

 

NOTE: To access the Edit GPI Out screen, double-click an RY from the list, the Edit GPI Out edit 
screen will appear. For more information on the Edit GPI Out screen, see the AZedit Help file. 

 

Right-Click Guide to the GPI Out screen 

Built into AZedit are many different ways to get to the same information, by buttons, menus, and right-clicking. The 
following is a list of menus and screens you can access by right clicking from the GPI Out main screen. 
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Right-Click Action Result 

Highlight Port > Right Click 
A popup menu appears that gives you the following 
options: 

Info: The information contained here shows the GPI 
Output Name, input, and output. 

Scroll Enable: Gives the user the ability to set scroll 
enable for Local ports, Trunk ports, AZedit ports. 

From the Scroll Enable menu, select Local, Trunk, or 
AZedit. 

From the Navigation menu, you can: 
Go to GPI Input view 
Go to Alpha Output view 
Go to Input Alpha view 

From the Changes Menu, you can  
Clear all changes to this RY /all RYs..,.- clears all the 
changes you have made up to the last Save 
performed. 

From the Search menu, you can: 
Search for panels with this RY assigned… 

Note: You must be connected to the 
Intercom for some of these menus to 
work. 

Right-click anywhere on the screen A popup menu appears that gives you the options to: 

Undo: reverses the last action--for example, to undo a 
deletion, thus restoring deleted text to a document. 

Redo: will redo up to 20 consecutive changes that you 
previously canceled with the Undo Button. 

Go Back: lets you go back to previously viewed screens 
(up to 20). 

Go Forward: lets you go forward again when you have 
used Go Back to look at previously viewed screens. 

Search: From the Search popup menu, you can: 
Search for this panel (opens the Search Status Screen) 
Search for panels with this key assignment (only 
available when a key assignment has been made)(opens 
the Search Status Screen) 

Show Grid: Opens key assignment grid. 
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Assign GPI Output Alphas 

GPI Outputs have default names, RY01, RY02, etc. You can change the defaults to more meaningful names. You 
can also enter a brief description to give further information and keep track of the GPI outputs that you use. 

To assign alphas to multiple special lists, do the following: 

1. In AZedit, click Other Alphas. 
The Other Alphas screen appears. 

2. From the Other Alphas screen, select GPI Output Alphas. 
The GPI Output Alphas screen appears. 

3. Double-click a RY (relay). 
The Edit Alpha Description screen appears. 

 

4. In the Description field, enter a description of the GPI Output (for example, Turn External lights 
on). The description field has a 24-character field limit. 

5. In the Alpha field, enter a meaningful name that users would recognize for the GPI Output (for 
example, UPL1). The Alpha and Alias fields have a four-character field limit. 

Note: The Alias and Alpha fields populate with the same information. You can change the Alias, if 
needed. For more information see, the Port Alphas screen description. 

6. Click Next to assign another alpha. Otherwise, click Done. 
The GPI Output default alpha is changed. 

 

To assign a special list alpha during the special list setup, do the following: 

1. In AZedit, click GPI Output. 
The GPI Output screen appears. 

2. Press Ctrl + F12. 
The Edit Alpha Description screen appears. 

 

3. In the Description field, enter a description of the GPI Output (for example, Turn External lights on). The 
description field has a 24-character field limit. 

4. In the Alpha field, enter a meaningful name that users would recognize for the GPI Output (for example, 
UPL1). The Alpha and Alias fields have a four-character field limit. 

Note: The Alias and Alpha fields populate with the same information. You can change the Alias, if 
needed. For more information see, the Port Alphas screen description. 

5. Click Done. 
The GPI Output default alpha is changed. 



 Telex Communications 83 

ISO 

ISO is a means for a keypanel operator to isolate a particular intercom port for private communication. While the 
intercom port is isolated, it can only hear audio from the keypanel operator. There is also an option called ISO Self 
that cuts the keypanel operator off from the rest of the intercom system as well during the ISO operation. When the 
ISO key is released, normal intercom operation is automatically restored. ISO is often used in a broadcasting 
environment, and may be referred to as "Camera ISO". In this application, camera operators are often assigned to a 
party line. ISO provides a means for a keypanel operator to isolate a particular camera from the party line and then 
direct that camera operator without outside interference. 

Each ISO can be given a name that is meaningful to keypanel operators, which is done through the Other Alpha 
setup screen. 

Once an ISO has been setup and named, it can be assigned to any keypanel key (provided that ISO assignment has 
not been restricted or disabled in AZedit). Use the ISO Setup screen to define the intercom port that will be isolated. 
Then, use keypanel setup to assign the ISO to an intercom key. After all changes have been sent to the intercom 
system, the keypanel operator will be able to isolate the specified ISO output by pressing the ISO key. 
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Screen Items 

Screen Item Field Type Description 

ISO list column The ISO column displays the ISO number. This number cannot be 
changed. However, control over the number of ISOs available for 
setup can be configured into the intercom system. 

Alpha list column The Alpha column displays the name assigned to each ISO. 
Default names are ISO1, ISO2, etc. These names can be changed 
to more meaningful names by selecting an ISO from the list and 
pressing Ctrl+F12. 

Self? list column The Self? Column displays whether or not a keypanel operator is 
isolated from the rest of the intercom system during ISO operation. 

When the ISO key is released, normal intercom operation is 
automatically restored. 

LC list column The LC column displays the scroll enable settings for the GPI 
Output port. 

LC indicates Local 

TK indicates Trunk 

AE indicates AZedit 

For each type of scrolling, the letters will appear green if that type 
of scrolling is enabled, brown (or red when selected) if that type of 
scrolling is disabled. 

TK list column The TK column displays the scroll enable settings for the GPI 
Output port. 

LC indicates Local 

TK indicates Trunk 

AE indicates AZedit 

For each type of scrolling, the letters will appear green if that type 
of scrolling is enabled, brown (or red when selected) if that type of 
scrolling is disabled. 

AE list column The AE column displays the scroll enable settings for the GPI 
Output port. 

LC indicates Local 

TK indicates Trunk 

AE indicates AZedit 

For each type of scrolling, the letters will appear green if that type 
of scrolling is enabled, brown (or red when selected) if that type of 
scrolling is disabled. 

Output Port list column The Output Port column displays the number of the port selected. 

Output Port Alpha list column The Output Port Alpha column displays the name of the port 
selected. 

 

NOTE: To access the Edit ISO screen, double-click an ISO from the list, the Edit ISO screen 
appears. For more information on the Edit ISO screen, see the AZedit Help file. 
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Right-Click Guide to the ISO screen 

Built into AZedit are many different ways to get to the same information, by buttons, menus, and right-clicking. The 
following is a list of menus and screens you can access by right clicking from the ISO main screen. 

Right-Click Action Result 

Highlight ISO > Right Click 
A popup menu appears that gives you the following 
options: 

Info: The information contained here shows the ISO, 
Description, and output. 

Scroll Enable: Gives the user the ability to set scroll 
enable for Local ports, Trunk ports, AZedit ports. 
 
From the Scroll Enable menu, select Local, Trunk, or 
AZedit. 

From the Navigation menu, you can: 
Go to ISO Alpha view 

From the Changes Menu, you can  
Clear all changes to this ISO /all ISOs..,.- clears all 
the changes you have made up to the last Save 
performed. 

From the Search menu, you can: 
Search for panels with this ISO assigned… 

Note: You must be connected to the 
Intercom for some of these menus to 
work. 

Right-click anywhere on the screen A popup menu appears that gives you the options to: 

Undo: reverses the last action--for example, to undo a 
deletion, thus restoring deleted text to a document. 

Redo: will redo up to 20 consecutive changes that you 
previously canceled with the Undo Button. 

Go Back: lets you go back to previously viewed screens 
(up to 20). 

Go Forward: lets you go forward again when you have 
used Go Back to look at previously viewed screens. 

Search: From the Search popup menu, you can: 
Search for this panel (opens the Search Status Screen) 
Search for panels with this key assignment (only 
available when a key assignment has been made)(opens 
the Search Status Screen) 

Show Grid: Opens key assignment grid. 
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Assign ISO Alphas 

ISOs have default names, IS01, IS02, etc. You can change the defaults to more meaningful names. You can also 
enter a brief description to give further information and keep track of the ISOs that you use. 

To assign alphas to multiple ISOs, do the following: 

1. In AZedit, click Other Alphas. 
The Other Alphas screen appears. 

2. From the Other Alphas screen, select ISO Alphas. 
The ISO Alphas screen appears. 

3. Double-click an ISO. 
The Edit Alpha Description screen appears. 

 

4. In the Description field, enter a description of the ISO (for example, Anchor talent). The description field 
has a 24-character field limit. 

5. In the Alpha field, enter a meaningful name that users would recognize for the ISO (for example, ANC1). 
The Alpha and Alias fields have a four-character field limit. 

Note: The Alias and Alpha fields populate with the same information. You can change the Alias, if 
needed. For more information see, the Port Alphas screen description. 

6. Click Next to assign another alpha. Otherwise, click Done. 
The ISO default alpha is changed. 

 

To assign a special list alpha during the special list setup, do the following: 

1. In AZedit, click ISO. 
The ISO screen appears. 

2. Press Ctrl + F12. 
The Edit Alpha Description screen appears. 

 

7. In the Description field, enter a description of the ISO (for example, Anchor talent). The description field 
has a 24-character field limit. 

8. In the Alpha field, enter a meaningful name that users would recognize for the ISO (for example, ANC1). 
The Alpha and Alias fields have a four-character field limit. 

Note: The Alias and Alpha fields populate with the same information. You can change the Alias, if 
needed. For more information see, the Port Alphas screen description. 

9. Click Done. 
The ISO default alpha is changed. 
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GPI In 

General Purpose Inputs and Outputs (GPIO or GPI) controls devices that use switch contact closures, DC 
voltages, or similar methods. GPI Inputs can be used to activate key assignments. For example, a lighting system 
can be controlled from keypanel keys or key a transmitter during transmission. GPI Inputs can also be used as inputs 
to UPL statements. For example, you could program a console switch to load an entirely new intercom system setup 
file.  

ADAM and ADAM CS intercom systems have a General Purpose Interface (GPI) port. GPI ports have eight control 
outputs (also referred to as relays) and eight control inputs. The location of the GPI port on the ADAM and ADAM CS 
is as follows: 

ADAM: Located on XCP-ADAM-MC Master Controller Breakout Panel, J11. 

ADAM CS: Located on ADAM CS back panel, J903. 

GPI Port Pin-out 

All 25-pin GPI Port connectors have the same pin-out as follows: 

Pin No.   Function     Pin No.   Function 

 

1 GPI In #1 (+5 to +18 VDC) 

2 GPI In #2 (+5 to +18 VDC) 

3 GPI In #3 (+5 to +18 VDC) 

4 GPI In #4 (+5 to +18 VDC) 

5 GPI In #5 (+5 to +18 VDC) 

6 GPI In #6 (+5 to +18 VDC) 

7 GPI In #7 (+5 to +18 VDC) 

8 GPI In #8 (+5 to +18 VDC) 

9 Common 

10 Common 

11 Common 

12 Common 

13 Common 

14 GPI Out #1 

15 GPI Out #2 

16 GPI Out #3 

17 GPI Out #4 

18 GPI Out #5 

19 GPI Out #6 

20 GPI Out #7 

21 GPI Out #8 

22 Common 

23 Common 

24 Common 

25 Common 
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GPI Inputs for UIO-256, ADAM, and ADAM CS: Connect +5 to +18 VDC between any GPI input and common to 
activate that GPI input. 

 

Screen Items 

Screen Item Field Type Description 

GPI Input column display The GPI Input column displays the number assigned to the GPI 
Input. This number cannot be changed. Changing the intercom 
configuration can control the number of GPI Inputs. For example, 
basic system hardware has eight GPI Inputs. If no additional UIO-
256 frames are attached to the system, the GPI Inputs can be 
limited to eight. 

Keypanel column display The Keypanel column displays the keypanel number assigned to 
the GPI Input (i.e., 003).  

Keypanel Alpha column display The Keypanel Alpha column displays the name of the Keypanel 
assigned to the GPI Input.  

Note: To change the default name of the Keypanel Alpha, 
see Port Alpha. 

Key column display The Key column displays the keypanel key assigned to the GPI 
Input. This is the key used to trigger a GPI Input action. 

Key Type column display The Keypanel Type column indicates the type of key assigned to a 
GPI Input. Talk or Listen is displayed in the column indicating the 
key type. 
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Note: When No Key is assigned as the key type, the Key 
Type column will be blank. 

Status column display The Status column displays whether the GPI Input is activated, 
ON; otherwise, OFF will display. This information will periodically 
update. 

To force an update: 

1. From the View menu, select Refresh. 
The display status field updates. 

Or, press Ctrl+Space from the keyboard. 

 

NOTE: To access the Edit GPI In screen, double-click a GPI In from the list, the Edit GPI In screen 
appears. For more information on the Edit GPI In screen, see the AZedit Help file. 

Right-Click Guide to the GPI Input Screen 

Built into AZedit are many different ways to get to the same information, by buttons, menus, and right-clicking. The 
following is a list of menus and screens you can access by right clicking from the GPI Input main screen. 

Highlight GPI Input > Right Click 
A popup menu appears that gives you the following 
options: 

Info: The information contained here shows the GPI 
Input, Description, Keypanel, Description (keypanel), Key 
Number and Type. 

From the Navigation menu, you can: 
Go to GPI Output view 
Go to GPI Output Alpha view 
Go To GPI Input Alpha view 
 

From the Changes Menu, you can  
Clear all changes to this GPI Input /all GPI Inputs..,.- 
clears all the changes you have made up to the last 
Save performed. 

From the Search menu, you can: 
Search for panels with this ISO assigned… 

Note: You must be connected to the 
Intercom for some of these menus to 
work. 

Right-click anywhere on the screen A popup menu appears that gives you the options to: 

Undo: reverses the last action--for example, to undo a 
deletion, thus restoring deleted text to a document. 

Redo: will redo up to 20 consecutive changes that you 
previously canceled with the Undo Button. 

Go Back: lets you go back to previously viewed screens 
(up to 20). 

Go Forward: lets you go forward again when you have 
used Go Back to look at previously viewed screens. 

Search: From the Search popup menu, you can: 
Search for this panel (opens the Search Status Screen) 
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Search for panels with this key assignment (only 
available when a key assignment has been made)(opens 
the Search Status Screen) 

Show Grid: Opens key assignment grid. 
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Assign GPI In Alphas 

GPI Inputs can be used to activate key assignments. GPI Inputs can also be used as inputs to UPL statements. 
Unlike other Alpha descriptions, GPI Inputs only allow you enter a description in the Alpha screen. 

To assign alphas to multiple GPI Input descriptions, do the following: 

10. In AZedit, click Other Alphas. 
The Other Alphas screen appears. 

11. From the Other Alphas screen, select GPI Input Descriptions. 
The GPI Input Descriptions screen appears. 

12. Double-click a DI (data input number). 
The Edit Alpha Description screen appears. 

 

13. In the Description field, enter a description of the GPI Input (for example, Switch #1). The description field 
has a 24-character field limit. 

14. Click Next to assign another alpha. Otherwise, click Done. 
The GPI Input Description is entered. 

 

To assign a GPI Input description during the special list setup, do the following: 

3. In AZedit, click GPI In. 
The GPI Input screen appears. 

4. Press Ctrl + F12. 
The Edit Alpha Description screen appears. 

 

15. In the Description field, enter a description of the GPI Input (for example, Switch #1). The description field 
has a 24-character field limit. 

16. Click Done. 
The GPI Input description is entered. 
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UPL 

ADAM, ADAM CS, and Zeus matrices contain a feature called User Programmable Language (UPL) based on logical 
statements to be implemented by the system. 

UPLs give users the ability to automate or schedule certain actions to occur. For example, a building's internal 
communication system via an intercom system may regulate who is contacted at different times during the day (the 
receptionist from 8:30 – 4:30 and from 4:30 to Midnight all calls are sent to the security officer). A simple UPL 
statement can accomplish the desired result by scheduling a Close Crosspoint on one port and Inhibit Crosspoint on 
another port. 

Using UPL users can construct program statements based on Boolean logic that allows the following conditions to be 
met: 
Output from a previous UPL statement 
GPI Input 
Local GPI Input 
Status of GPI Output 
Status of Local GPI Output 
Talk Key Status 
Listen Key Status 
UPL Resource 

Crosspoint Status 
Input Talking 
Output Listening 
Headset Transfer Switch Status 
Current Date 
Current Time 
IFB Interrupted 
Counter 

 

UPL Operator Usage 

The standard operators for input conditions (except for Current Time, Current Date, and Counter) 
are: 

AND both Input A and Input B must be true 

OR either of Input A or Input B must be true 

XOR exactly one of Input A or Input B must be true (but not both) 

 

The following operators are only available to be used when Input A is set to "Current Date", 
"Current Time", or "Counter", and in these cases Input B is then used as the value to be compared 
with. 

= equal to 
!= not equal to 
< less than 
> greater than 
<= less than or equal to 
>= greater than or equal to 

Tests are chained with other conditions through the use of AND, OR, and XOR to cause one or more of the following 
actions to occur: 

Close Crosspoint 
Inhibit Crosspoint 
Assert GPI Output 
Inhibit GPI Output 
Assert GPI Output Local 
Inhibit GPI Output Local 
Force Talk Key Closed 

Force Talk Key Open 
Dim Crosspoint Volume 
Load Setup File 
Force Listen Key Closed 
Force Listen Key Open 
Clear Counter 
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Users can construct these statements easily using the drop-down lists on the Edit UPL Statement screen. There are 
cases where the actions to be implemented require external devices. For this purpose, RTS has included a serial 
RS-232 control language called Command Line Protocol. This protocol allows simple ASCII communications between 
the matrix and the external computer. Command Line Protocol comes standard on ADAM, ADAM CS and Zeus 
matrices. 

In AZedit, the number of UPL's is set in the configuration of the matrix "options" intercom configuration. For Zeus, the 
UPL statement limit is set to 128; for ADAM CS, the UPL statement is 256. For a single frame ADAM, the number of 
UPL statements is 256, however this is adjustable. The number can be increased, but it may degrade other dynamic 
capabilities, such as the number of party lines (this is limited to the amount of memory available on the master 
controller card). The available memory test is available when these matrix settings are adjusted. The Allow Intercom 
Resizing in Online Mode checkbox must be selected. This is done by going to the Options menu and selecting 
Preferences. 

 

Screen Items 

Screen Item Field Type Description 

UPL Statement display column The UPL Statement column displays the number assigned to the UPL 
statement. 

Enabled display column The Enabled column indicates if a statement is enabled to run or 
disabled. If the column shows YES, this indicates enabled. If the 
column shows NO, this indicated disabled. 

To enable or disable the UPL statement, do the following: 

1. Right-click the UPL statement you want to enable/disable. 
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A popup menu appears. 

2. From the Popup menu, select Enable or Disable. 
The UPL statement is enabled (YES) or disabled (NO). 

Input A display column The Input A column displays the input condition that must be met 
before the output result becomes active (for example, GPI Input, 
Counter, etc.). 

Operation display column The Operation column displays the operator used (AND, OR, XOR). 

Input B display column The Input B column displays a second input condition that must be met 
before the output result becomes active. It can be thought of as linking 
two conditions together. However, you can also have one or the other 
of the conditions being met before the result becomes active. 

Output display column The Output column displays the type of output, such as a key closure, 
crosspoint force or inhibit, etc. 

State display column The State column indicates the current state of the UPL statement.  

True indicates the output condition is true when the condition (s) for A 
or A and B is met. 

False indicates the output condition wasn't met. 

 

NOTE: To access the Edit UPL screen, double-click a UPL Statement from the list, the Edit UPL 
Statement screen appears. For more information on the Edit UPL Statement screen, see the 
AZedit Help file. 

Right-Click Guide to the UPL Screen 

Built into AZedit are many different ways to get to the same information, by buttons, menus, and right-clicking. The 
following is a list of menus and screens you can access by right clicking from the UPL main screen. 

Highlight UPL statement > Right Click 
A popup menu appears that gives you the following 
options: 

Info: The information contained here shows the UPL 
Statement, any Comments, and the State of the 
statement. 

From the Navigation menu, you can: 
Go to UPL Resources view 
Go to UPL Resource Alpha view 

From the Changes Menu, you can  
Clear all changes to this UPL /all UPLs..,.- clears all 
the changes you have made up to the last Save 
performed. 

From the Search menu, you can: 
Search for panels with this ISO assigned… 

Note: You must be connected to the 
Intercom for some of these menus to 
work. 

Right-click anywhere on the screen A popup menu appears that gives you the options to: 

Undo: reverses the last action--for example, to undo a 
deletion, thus restoring deleted text to a document. 

Redo: will redo up to 20 consecutive changes that you 
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previously canceled with the Undo Button. 

Go Back: lets you go back to previously viewed screens 
(up to 20). 

Go Forward: lets you go forward again when you have 
used Go Back to look at previously viewed screens. 

Search: From the Search popup menu, you can: 
Search for this panel (opens the Search Status Screen) 
Search for panels with this key assignment (only 
available when a key assignment has been made)(opens 
the Search Status Screen) 

Show Grid: Opens key assignment grid. 

Assign UPL Alphas 

UPL's have default names, 001, 002, etc. You can change the defaults to more meaningful names. You can also 
enter a brief description to give further information and keep track of the UPL's that you use. 

To assign alphas to multiple UPL's, do the following: 

17. In AZedit, click Other Alphas. 
The Other Alphas screen appears. 

18. From the Other Alphas screen, select ISO Alphas. 
The ISO Alphas screen appears. 

19. Double-click a UR (UPL resource). 
The Edit Alpha Description screen appears. 

 

20. In the Description field, enter a description of the UR (for example, Statement 1). The description field has 
a 24-character field limit. 

21. In the Alpha field, enter a meaningful name that users would recognize for the UR (for example, ST 1). The 
Alpha and Alias fields have a four-character field limit. 

Note: The Alias and Alpha fields populate with the same information. You can change the Alias, if 
needed. For more information see, the Port Alphas screen description. 

22. Click Next to assign another alpha. Otherwise, click Done. 
The UR default alpha is changed. 
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UPL Statement Examples 

Timed Setup File Example 

This example shows how a UPL statement works. Let's say you have broadcast news show every day at 5pm and 
you want the intercom system to automatically load and entire intercom system setup file every day at 4:30pm for the 
broadcast. Using UPL statements you could have the setup file load automatically every day. 

To write the UPL statement, do the following: 

1. In AZedit, open the setup file that will be running BEFORE the file you want to load at 4:30. 

2. Click UPL. 
The User Programmable Logic Statements screen appears. 

3. Double-click a UPL Statement. 
The Edit UPL Statement screen appears. 

 

4. In the Comment field, enter a description of the UPL statement you are creating (for example, Load Nightly 
News Setup). This serves as a reminder of what the UPL statement does. 

5. Verify the Enabled checkbox is selected. 

6. From the Input A Type drop-down list, select Current Time. 
This is part of the input condition that has to be met before the UPL statement initiate and load the setup file. 

7. From the Operation drop-down list, select = (equal).  
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Operator Usage 

The standard operators for input conditions (except for Current Time, Current Date, and Counter) 
are: 

AND both Input A and Input B must be true 

OR either of Input A or Input B must be true 

XOR exactly one of Input A or Input B must be true (but not both) 

 

The following operators are only available to be used when Input A is set to "Current Date", 
"Current Time", or "Counter", and in these cases Input B is then used as the value to be compared 
with. 

= equal to 
!= not equal to 
< less than 
> greater than 
<= less than or equal to 
>= greater than or equal to 

 

8. In the Time field, enter the time. The time is based on a 24-hour clock. For example, 4:30pm is thought of as 
16:30:00. 

9. From the Output Action Type drop-down list, select Load File. 
A File Name drop-down list appears. 

Note: All setup files are kept in the Setup file located in the TELEX folder on your C:\ drive. 

10. From the File Name drop down list, select the file that will load (for example, test.adm). 

Note: There is a description box near the bottom right that provides an English text description of 
what the UPL statement you create will do. This allows you to play around with inputs, outputs, and 
operators to see what the effect of each is. 

The UPL statement is now created. Once these changes are sent to the intercom system, the setup file prepared 
will automatically load at the specified time. 

IMPORTANT: Activate SERVER mode. AZedit must be operating in SERVER mode for the intercom system 
to be able to load the files. For more information on SERVER mode, see Connecting and Disconnecting. 
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Use a UPL Resource Key to Load a Setup File 

This example shows how you can set up a keypanel key that will load an intercom system setup file when the key is 
pressed. As an example, suppose that you want to set up a key on a keypanel that will load an intercom setup file for 
a broadcast program at 5pm. Then, at 4:55, an operator can press the key on the keypanel thereby loading the setup 
file for the broadcast. 

To set up this process, a UPL Resource needs to be named, the UPL resource needs to be assigned to a key on the 
keypanel, and then, a UPL statement needs to be created to load the setup file. 

To use a UPL resource key to load a setup file, do the following: 

1. In AZedit, open the setup file that will be running BEFORE the file you want to load just before 5pm. 

2. Click Other Alphas. 
The Other Alphas screen appears. 

3. On the Other Alphas screen, select UPL Resource Alphas. 
The UPL Resource Alphas screen appears. 

4. Double-click a UR (UPL Resource) from the UR list. 
The Edit Alpha Description screen appears. 

 

5. In the Description field, enter a description of the UPL Resource (for example, Loads 5pm Setup). This 
should be something to remind you what the UPL resource is being used for. 

6. In the Alpha field, enter the name you want displayed as the UPL Resource (for example, 5PM). The Alpha 
appears in the alphanumeric display of a keypanel. 

7. Click Done. 
The Edit Alpha Description screen closes and the UPL Resource is renamed. 

8. In the bottom tool bar, click KP (or press F2). 
The Keypanels / Ports main screen appears. 

9. In the Port field, enter the port number with which you want to work. (You can also select an Alpha from the 
Alpha drop-down box. 

10. Right-click in a talk key combo box. 
A popup menu appears. 
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11. Select Change Assignment. 
The Select Key Assignment screen appears. 

 

12. In the key type list, select the type of intercom key you want to assign (for example, UPL Resource). 

13. In the name list (on the right), select a name (alpha) for the key (for example, 5PM). 

14. Click OK. 
The Selected Key Assignment screen closes and the selected name appears in the key assignment combo 
box on the Keypanels / Ports screen. 

15. Click UPL. 
The User Programmable Logic Statements screen appears. 

16. Double-click a UPL Statement. 
The Edit UPL Statement screen appears. 

 

17. In the Comment field, enter a description of the UPL statement you are creating (for example, Load 5PM 
file from 5PM key). This serves as a reminder of what the UPL statement does. 

18. Verify the Enabled checkbox is selected. 

19. From the Input A Type drop-down list, select UPL Resource. 
This is part of the input condition that has to be met before the UPL statement initiates and loads the setup 
file. 
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20. From the Output Action Type drop-down list, select Load File. 
A File Name drop-down list appears. 

Note: All setup files are kept in the Setup file located in the TELEX folder on your C:\ drive. 

21. From the File Name drop down list, select the file that will load (for example, test.adm). 

Note: There is a description box near the bottom right that provides an English text description of 
what the UPL statement you create will do. This allows you to play around with inputs, outputs, and 
operators to see what the effect of each is. 

 

 

The UPL statement is now created. Once these changes are sent to the intercom system, the setup file prepared 
will load when the keypanel key is pressed. 

IMPORTANT: Activate SERVER mode. AZedit must be operating in SERVER mode for the intercom system 
to be able to load the files. For more information on SERVER mode, see Connecting and Disconnecting. 
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Use Keypanel Keys to Control Talk and Listen for Non-Keypanel Devices 

This example demonstrates an IMPORTANT note about certain types of UPL statements; when you use a UPL 
statement to activate a key assignment, you must also create another UPL statement to deactivate the key 
assignment. 

In this example, you have a keypanel connected at intercom port one. A camera director in a television broadcast 
studio is using this keypanel. Also, there is a camera intercom connected at intercom port 2. There are four possible 
party lines (CAM1, CAM2, CAM3, and CAM4). The following setup is one example of how to set up the four keys on 
the camera director's keypanel so he can control which party line the camera operator communicates. 

To set up keypanel keys to control talk and listen for non-keypanel devices, do the following: 

1. In AZedit, click Other Alphas. 
The Other Alphas screen appears. 

2. From the Other Alphas screen, select UPL Resource Alphas. 
The UPL Resource Alphas screen appears. 

3. On the UPL Resource Alphas screen, double-click a UR (UPL Resource). 
The Edit Alpha Description screen appears. 

 

4. In the Description field, enter a description of the UPL resource to remind you what it is being 
used as (for example, Party Line 1). 

5. In the Alpha field, enter the name you want displayed as the UPL Resource (for example, PL1)  

6. Click Next. 
The next UPL Resource Edit Alpha Description screen appears. 

Repeat Steps 4 through 6 until you have created 4 UPL resources called PL1, PL2, PL3, and PL4. 
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7. Once you have created the UPL Resource Alphas, click Done. 
The Edit Alpha Description screen closes and the Resource Alphas you renamed appear in the 
UPL Resource Alpha list 

 

8. Click KP. 
The Keypanels / Ports main screen appears. 

9. In the bottom tool bar, click KP (or press F2). 
The Keypanels / Ports main screen appears. 

10. In the Port field, enter the port number with which you want to work. (You can also select an Alpha 
from the Alpha drop-down box. 

11. Right-click in a talk key combo box. 
A popup menu appears. 

12. Select Change Assignment. 
The Select Key Assignment screen appears. 

 

13. In the key type list, select the type of intercom key you want to assign (for example, UPL 
Resource). 

14. In the name list (on the right), select a name (alpha) for the key (for example, PL 1). 

15. Click OK. 

Repeat steps 11 through 15 until you have assigned all the UPL resources to talk keys. 



 Telex Communications 103 

Once you have finished assigning the UPL Resources to keypanel keys, access the keypanel setup 
screen for the intercom port where the camera intercom station is connected. 

1. Assign each of the Party Lines (PL1, PL2, PL3, and PL4) to a talk key 

2. Assign auto-listen to the listen keys. 

 

3. Once you are finished assigning the party line UPL resources and AF to the talk and listen keys, 
click UPL. 
The User Programming Logic Statements screen appears. 

4. Double-click a UPL Statement. 
The Edit UPL Statement screen appears. 

 

5. In the Comment field, enter a description of the UPL statement to remind you what it is being used 
as (for example, Party Line). 

6. From the Input A Type drop-down box, select UPL Resource. 
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7. From the UPL Resource drop-down box, select the first UPL resource you created (for example, 
PL1). 

8. From the Output Action Type drop down box, select Force Talk Key. 

9. In the Port # field, enter or select the port number where the talk key is located. 

10. In the Key # field, enter or select the key number you want to activate. 

11. Click Next. 
The next UPL statement appears in the Edit screen. 

 

12. In the Comment field, enter a description of the UPL statement to remind you what it is being used 
as (for example, Party Line 2). 

13. From the Input A Type drop-down box, select UPL Statement. 
Because you are creating a counter-action to UPL Statement 1, you are going to use that 
statement as the Input (or condition) for the second UPL Statement. 

14. Select the Invert Input A check box. 

15. In the Statement # field, verify the field shows the UPL statement you just created. 

16. From the Output Action Type drop-down box, select Force Talk Key Open. 

17. In the Port # field, enter or select the same port # you used for the first UPL statement. 

18. In the Key # field, enter or select the same key # you used for the first UPL statement. 

Now, repeat steps 1 through 18 substituting party lines 3 and 4 where party lines 1 and 2 were. 

19. Send these changes to the intercom system. 

The statements you created will work as follows - When the PL1 key on the director's keypanel is currently off, this 
means the first UPL statement is FALSE. Therefore, the PL1 Talk key will not be activated. However, the second 
statement is true, and this will Force the PL1 talk key off. When the PL1 key is pressed, the first UPL statement 
become true, which forces the talk key on. Since the second UPL statement is now false, it is ignored. When the PL1 
key is release, the second UPL statement again becomes true, which forces the PL 1 key on the directors keypanel 
to be turned off. 
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Inter-panel Dim Tables 

An Inter-panel Dim Table is simply a list of two or more keypanels that are located in close proximity to one another. 

Dim is placed on the talk key as a second level function. When entered, the Dim invokes the processor to search all 
the dim tables whenever the talk key is pressed. In this situation, if the keypanels are using a speaker/microphone 
combination, feedback could occur if two keypanels have keys activated to communicate with the same destination, 
or if one keypanel has a key activated to talk to the destination and the other is receiving audio from the destination. 
By using an inter-panel dim table, the intercom system automatically mutes, or dims, one or both keypanel speaker 
outputs while this situation exists. When you configure a dim table, you can also define the amount of speaker 
dimming. For example, suppose you and I are seated near each other in a VTR room (video tape recorder room in a 
broadcast studio). We each have a talk key assigned to talk to the director. Suppose I am currently listening to the 
director (either the director is talking to me, or I have a listen key activated). At this moment, you press your talk key 
to the director, and feedback is immediately noted in the keypanel speakers. This is because your audio enters your 
mic, then comes out the director's speaker, then re-enters the director's mic, then comes out my speaker, then re-
enters your mic to create a continuous feedback loop. 

To eliminate the feedback, we set up a DIM table with you and I as members, and we set the dim value to -9dB. We 
then assign the DIM function on Talk Level 2 of our keys that talk to the director. Now suppose the director is talking 
to me, and your talk key to the director is off. I will hear the director at the normal level. However, when you press 
your talk key to the director, you activate the DIM function (via the talk level 2 assignment on your talk key). The 
master controller searches for any DIM tables in which you are a member, then dims the volume from the director to 
all other members of the same DIM table by the dim amount specified in that DIM table. In this case, there is only one 
DIM table, with you and I as members, and with a dim amount of -9dB. So, when you press your talk key, the volume 
from the director to me is dimmed by 9dB, which should hopefully reduce or eliminate the feedback. If I were to then 
press my talk key to the director, the volume from the director to you would also be dimmed by 9dB. 

Suppose there are three of us in the VTR room (Ralph is on your right and I am on your left). We all have talk keys 
assigned to the director. Suppose that there is a feedback problem between you and I, and between you and Ralph, 
but Ralph and I can talk and listen to the director without feedback occurring. In this instance we create two DIM 
tables, one with you and I as members, and one with you and Ralph as members. When you then press your talk key 
to the director, both of the DIM tables with you as member become active. If I am listening to the director, the listen 
volume from the director to me is dimmed by the amount specified in the DIM table where you and I are members. If 
Ralph is also listening to the director, the volume from the director to Ralph is dimmed by the amount specified in the 
DIM table where you and Ralph are members. 

If there were a feedback problem between Ralph and me, we could use one DIM table with all three of us as 
members (with only one dim amount). Or, we could use a third DIM table with Ralph and me as members (say with 
only -6db dimming since we sit further apart). 
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Screen Items 

Screen Item Field Type Description 

DIM text field The DIM text box displays the DIM entry number. The Dim entry 
number is a representation of the Dim table. The 
number/description is generated from the Other Alpha's listing 
(Shift + F12). Keypanels can be members of more than one Dim 
table. For each dim table, a different number of members and 
amount of dimming may be set. 

Note: The Dim entry number cannot ever be changed. 

Gain drop-down list The Gain drop down box displays the amount of Dim associated 
with the Dim entry number. Users can also change the decibels 
of gain to be dimmed from the entry. 

1. From the Gain drop down list, select the amount of 
gain for the Dim Entry Number. 

Port column display The Port column displays a list of ports in the intercom system. 

Alpha column display The Alpha column displays the name associated with the 
port. 

DIM Member? column display The DIM Member? column indicates if a given port is a member 
of the current DIM assignment being viewed. 

Add to DIM button The Add to DIM button adds selected ports to the Dim 
Assignment. 
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Assignment. 

Note: To select more than one port at a time, press Ctrl on 
the keyboard and then select the ports to add. 

1. Highlight the selected ports, and then click Add to DIM. 
The highlighted ports are added to the DIM assignment. 

Remove from DIM button The Remove from DIM button removes selected ports from the 
Dim Assignment. 

Note: To select more than one port at a time, press Ctrl on 
the keyboard and then select the ports to remove. 

1. Highlight the selected ports, and then click Remove 
from DIM. 
The highlighted ports are removed the DIM assignment. 

Select All button The Select All button selects all the available ports in the Port 
column. 

1. Click Select All. 
All the ports in the port column are highlighted. 

De-select All button The De-select All button removes the highlight from the all the 
ports in the port column. 

1. Click De-select All. 
All the ports highlighted in the port column are de-
selected. 

Invert Selection button The Invert Selection button reverses the selections made. For 
example, if 3 ports are highlighted, and Invert Selection is 
clicked, the three ports that were highlighted are no longer 
highlighted, while the rest of the port list becomes highlighted. 

1. Click Invert Selection. 
The highlighted ports are no longer highlighted, while 
ports that were not highlighted become highlighted. 

 

Right-Click Guide to the Inter-panel Dim Tables 

Built into AZedit are many different ways to get to the same information, by buttons, menus, and right-clicking. The 
following is a list of actions, menus and screens you can implement and access by right clicking from the Inter-panel 
Dim main screen. 

Highlight Dim Assignment > Right Click 
A popup menu appears that gives you the following 
options: 

Info: The information contained here shows the 
Inter-panel Dim assignment, description, members, 
selected port for the Dim, and a description of the 
port. 

Member: Gives the user the ability to select or de-
select a port for the Dim Assignment. 

From the Selection menu, you can: 
Add 
Remove 
Invert 

From the Navigation menu, you can: 
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Go to Special Lists Alpha View 
Go to Keypanel View 
Adjust Crosspoint Settings for this Port 
Go to Crosspoint Volume View 
Go to Party Line Volume View 
Go to Port Alpha View 

From the Changes Menu, you can  
Clear all changes to this SL /all SLs..,.- clears all 
the changes you have made up to the last Save 
performed. 

From the Search menu, you can: 
Search for panels with this port alpha as a key 
assignment. 
Search for panels with this special list alpha as 
a key assignment. 

Note: You must be connected to the 
Intercom for some of these 
menus to work. 

Right-click anywhere on the screen A popup menu appears that gives you the options 
to: 

Undo: reverses the last action--for example, to 
undo a deletion, thus restoring deleted text to a 
document. 

Redo: will redo up to 20 consecutive changes that 
you previously canceled with the Undo Button. 

Go Back: lets you go back to previously viewed 
screens (up to 20). 

Go Forward: lets you go forward again when you 
have used Go Back to look at previously viewed 
screens. 

Search: From the Search popup menu, you can: 
Search for this panel (opens the Search Status 
Screen) 
Search for panels with this key assignment (only 
available when a key assignment has been made) 

Show Grid: Opens key assignment grid. 
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XPT (Crosspoint) 

When one intercom port talks to another intercom port it does this via what is commonly referred to as a crosspoint. 
The crosspoint is basically the connecting point between the talker and the listener. There is a separate talk and 
listen crosspoint between every intercom port and every other intercom port in the intercom system. The term 
Crosspoint, like the term Matrix, is inherited from intercom systems, such as the RTS™ CS9500, CS9600, and 
CS9700, which use a switching matrix to route the intercom audio. In those systems, the crosspoint are actual 
switches that close or open to connect or disconnect talk and listen paths. RTS™ ADAM, ADAM CS, and Zeus 
intercom systems do not actually use crosspoint switches, but a technology called time division multiplexing 
(TDM), in which communications are routed as digital packets.  

Methods of Crosspoint Activation 

Keypanel Key Assignments: Crosspoints turn ON and OFF as keypanel operators press keys to talk and listen to 
each other. You assign keys using keypanel setup. 

Forced Crosspoint: You can force a specific intercom port to always talk or listen to another intercom port. You can 
force crosspoints in the Crosspoint Status screen. 

Party Lines: When an intercom port is assigned to talk and/or listen to a party line, the talk and/or listen crosspoints 
are permanently closed between that intercom port and all other intercom ports that are members of the party line. 
Removing a member from a party line will release the crosspoints. Members are assigned to party lines using party 
line setup. 

Talk vs. Listen 

In terms of crosspoints, talking from one port to a second port is the same thing as the second port listening to the 
first port. However, this does not mean that any intercom port can arbitrarily listen to another intercom port. For 
example, lets say a keypanel operator at intercom port 1 presses a talk key to talk to a keypanel operator at intercom 
port 2. This causes 2 things to happen. First, pressing the key causes a data message to be sent to the intercom 
system, which tells the intercom system to turn on the crosspoint that connects intercom port 1 to intercom port 2. 
Second, pressing the key activates the microphone amplifier in the keypanel at intercom port 1. This allows the 
person at intercom port 2 to hear the person at intercom port 1. Note that the person at intercom port 2 could activate 
the same crosspoint by activating a listen key. However, since this does not turn on the microphone in the keypanel 
at intercom port 1, nothing can be heard (unless the microphone is already on to talk to some other destination). 
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Screen Items 

Screen Item Field Type Description 

Port text box The Port field displays the system assigned number for the crosspoint 
port currently being viewed. 

Alpha drop-down list The Alpha field displays the alpha assigned to the crosspoint port 
currently being viewed. 

Is Talking To… The Is Talking To… field shows information about the port to which the 
current crosspoint port can communicate, such as the port, the alpha, 
that status of the port, and whether the crosspoint is Forced or 
Inhibited. 

Port display column The Port field displays the system assigned number for the port. 

Alpha display column The Alpha field displays the alpha assigned to the port. 

Closed  display column The Closed field displays the status of the crosspoint port. 

No means the port is Open, while Yes means the port is Closed. 

F/I display column The F / I field shows whether the port is a forced crosspoint or an 
inhibited crosspoint port. 

To Force or Inhibit a port, do the following: 

1. Right-Click the port with which you want to work. 
A pop-up menu appears. 

2. From the pop-up menu, select either Force or Inhibit. 

Is Listening To… The Is Listening To… field shows information about the port to which 
the current crosspoint port can listen, such as the port, the alpha, that 
status of the port, and whether the crosspoint is Forced or Inhibited. 
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Port display column The Port field displays the system assigned number for the port. 

Alpha display column The Alpha field displays the alpha assigned to the port. 

Closed  display column The Closed field displays the status of the crosspoint port. 

No means the port is Open, while Yes means the port is Closed. 

F/I display column The F / I field shows whether the port is a forced crosspoint or an 
inhibited crosspoint port. 

To Force or Inhibit a port, do the following: 

1. Select the port with which you want to work. 
A pop-up menu appears. 

2. Click either Force or Inhibit. 

Force button The Force button establishes a crosspoint between an audio input and 
an audio output. This switch is MADE and cannot be released under 
any other matrix condition. You can use the force function to establish a 
link inside the matrix where there is no panel to allow intelligent 
switching; alternatively, it is used to enable communications from 
panels when the route must be established without permanently using a 
key on the panel. 

1. Click Force. 
A crosspoint closure has been forced to the port selected. 

Inhibit button The Inhibit button restrains a crosspoint closure between the port 
currently being viewed and the port selected. Inhibit prevents 
communication from an audio source to a specific destination. 

1. Click Inhibit. 
The port is inhibited. 

Release button The Release button forces the crosspoint closure between the port 
currently being viewed and the port selected to be released. 

1. Click Release. 
The port is released. 

Inspect button The Inspect button provides detailed status information on the 
crosspoint connection between the port currently being viewed and the 
port selected. 

Note: You can also access the crosspoint Inspection Results 
screen by double clicking a port from either the Is Talking To… or 
the Is Listening To…. list. 

1. Click Inspect. 
The Crosspoint Inspection Results screen appears. 

Select All button The Select All button selects all the available ports in the Port column. 

1. Click Select All. 
All the ports in the port column are highlighted. 

De-select All button The De-select All button removes the highlight from the all the ports in 
the port column. 

1. Click De-select All. 
All the ports highlighted in the port column are de-selected. 

Invert Selection button The Invert Selection button reverses the selections made. For 
example, if 3 ports are highlighted, and Invert Selection is clicked, the 
three ports that were highlighted are no longer highlighted, while the 
rest of the port list becomes highlighted. 

1. Click Invert Selection. 
The highlighted ports are no longer highlighted, while ports 
that were not highlighted become highlighted. 
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Gain 

Gain is simply the increase of a signal accomplished by increasing the size of the amplitude. AZedit uses Unity Gain. 
Unity Gain is when the amplitude that the audio comes into the matrix system is sent out at the same amplitude. For 
example, if +10 dB comes into the matrix that is set with 0 gain, then +10 dB will leave the matrix. However, if +10 dB 
comes into the matrix that is set with –4 dB gain, then +6dB will leave the matrix. The unity point is seen as zero dB, 
by default. The minimum adjustment for gain levels in AZedit is  +/-.5 dB. A negative gain is known as attenuation 

 

CROSSPOINT GAIN 

Crosspoint Gain adjusts the level at which the currently selected intercom port hears a selected intercom port. 
Crosspoint gain is the same thing as Point to Point Listen Gain, and the adjustment can be made on this screen or 
the Crosspoint Gain screen. 
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Screen Items 

Screen Item Field Type Description 

Port text field The Port field displays the system generated port number currently being 
viewed. 

Alpha drop-down list The Alpha field displays the number of the Alpha currently being displayed. 

Listens To… The Is Listening To… field shows the port, the alpha and the gain level of 
the port  

1. From the Port field, select the port for which you want to set the 
crosspoint listen gain level for the currently viewed port. 
The port you select becomes highlighted. 

Port display column The Port field displays the selected port for which the crosspoint listen gain 
can be set. 

Alpha display column The Alpha field displays the selected alpha for which the crosspoint listen 
gain can be set. 

Gain display column The Gain field displays the selected ports gain level for the currently viewed 
crosspoint port. 

Gain Controls The Gain Controls area gives users the ability to set the gain level for each 
port the currently viewed crosspoint port listens to. The amount of gain can 
be manipulated from this area. 

Gain drop-down list The Gain drop-down list displays the different levels of gain available for the 
selected port. 

From the Gain drop-down list, select the amount of gain for the selected 
port. 

Set Gain button The Set Gain button sets the gain for the selected port(s). 

1. Click Set Gain. 
The gain is set for the selected port. 

Gain up/Gain Down button The Gain Up/Gain Down arrows give the user the ability to increase or 
decrease the gain incrementally without modifying the Set Gain amount. 

1. Click the Up arrow to increase the gain. 
or  
Click the Down arrow to decrease the gain. 

Options 

Show NON-Unity 
Only 

checkbox The Show NON-Unity Only check box, when selected, will show only Non-
unity gain levels.  

If the Show Non-Unity Only is selected, only those intercom ports that are 
not set at the default level will display. 

The default level of +0.0 dB is also called the unity gain level. Normally, the 
list in the center of the screen will show the gains for all intercom ports. 

Reset Gain button The Reset Gain button resets the gain to its default level (+0.0 dB) for ports 
that are currently selected in the list in the center of the screen. 

1. Click Reset Gain. 
The Gain is reset for the selected port. 

Select All button The Select All button selects all the available ports in the Port column. 

1. Click Select All. 
All the ports in the port column are highlighted. 

De-select All button The De-select All button removes the highlight from the all the ports in the 
port column. 

1. Click De-select All. 
All the ports highlighted in the port column are de-selected. 
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Invert Selection button The Invert Selection button reverses the selections made. For example, if 3 
ports are highlighted, and Invert Selection is clicked, the three ports that 
were highlighted are no longer highlighted, while the rest of the port list 
becomes highlighted. 

1. Click Invert Selection. 
The highlighted ports are no longer highlighted, while ports that 
were not highlighted become highlighted. 

 

PARTY LINE GAINS 

Party Line Gain adjusts the level at which the currently selected party line port hears a selected party line.  

Use the Party Line Gain screen to adjust the level at which a selected intercom port listens to one or more selected 
party lines. 

To set the Party Line Gain, do the following: 

1. Select an intercom port. 

2. In the Port text box, enter the intercom port number. 
Or  
From the Alpha drop-down list, select the port name. 

3. Select one or more party lines from the list in the center of the screen.  

Use any of the following methods to select party lines: 

To select an individual party line, click a party line in the PL List. 

To select several consecutive party lines, click and drag the mouse down the list. Or, click the first 
party line, then hold down the Shift key on the computer keyboard and click the last party line. 

To select several random party lines, hold down the Ctrl key on the computer keyboard, and then 
click the desired party lines in the list 

To select or de-select all party lines, click on the Select All or De-select All button on the right side 
of the screen 

To select all party lines that are not currently selected, click the Invert Selections button. 

4. Adjust gain using either of two methods: 
Method 1: Absolute Adjustment 

Use this method to set all selected party line gains to the same level. 

1. From the Gain List box, select a gain value. 

2. Click the Set Gain button. 
The new gain value(s) will appear in the list in the center of the screen. 

Method 2: Relative Gain Adjustment 

Use this method to change each selected party line gain up or down from its current level. 

1. Click the up/down arrows  
The new gain value(s) appear in the list in the center of the screen. 

5. Send the changes to the intercom system.  
After you send changes, the intercom port that you selected in step 1 will hear the party line(s) that 
you selected in step 2 at the new level that you set in step 3. 
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Note: The default level of +0.0 dB is also called the unity gain level. Normally, the list in the center 
of the screen will show the gains for all party lines. If you check Show Non-Unity Only, you will 
see only those party lines that are not set at the default level.  

Use the Reset Gain button to reset the gain for whichever party lines are currently selected in the 
center of the screen. This will reset gains to the default level of +0.0 dB. 

 

Note: It is also possible to adjust the party line gains for a specific intercom port while viewing the 
setup screen for that port. Access the keypanel setup. Then, select the desired intercom port in 
the upper-left corner of the screen and click the Gain button. 

 

Screen Items 

Screen Item Field Type Description 

Port text field The Port field displays the system generated port number currently 
being viewed. 

Alpha drop-down list The Alpha field displays the number of the Alpha currently being 
displayed. 

Listens To… The Is Listening To… field shows the PL (party line) number, the alpha and the gain level 
of the selected party line. 

PL display column The PL field displays the selected port for which the crosspoint listen 
gain can be set. 

1. From the Port field, select the port for which you want to set 
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the crosspoint listen gain level for the currently viewed port. 
The port you select becomes highlighted. 

Alpha display column The Alpha field displays the selected alpha for which the party line 
gain can be set. 

Gain display column The Gain field displays the selected party line gain level for the 
currently viewed party line. 

Gain Controls The Gain Controls area gives users the ability to set the gain level for each party line the 
currently viewed party line listens to. The amount of gain can be manipulated from this area. 

Gain drop-down list The Gain drop-down list displays the different levels of gain available 
for the selected party line. 

From the Gain drop-down list, select the amount of gain for the 
selected party line. 

Set Gain button The Set Gain button sets the gain for the selected party line(s). 

1. Click Set Gain. 
The gain is set for the selected party line. 

Gain up/Gain 
Down 

button The Gain Up/Gain Down arrows give the user the ability to increase 
or decrease the gain incrementally without modifying the Set Gain 
amount. 

1. Click the Up arrow to increase the gain. 
or  
Click the Down arrow to decrease the gain. 

Options 

Show NON-Unity 
Only 

checkbox The Show NON-Unity Only check box, when selected, will show 
only Non-unity gain levels.  

If the Show Non-Unity Only is selected, only those party lines that are 
not set at the default level will display. 

The default level of +0.0 dB is also called the unity gain level. 
Normally, the list in the center of the screen will show the gains for all 
party lines. 

Reset Gain button The Reset Gain button resets the gain to its default level (+0.0 dB) 
for party lines that are currently selected in the list in the center of the 
screen. 

1. Click Reset Gain. 
The Gain is reset for the selected party lines. 

Select All button The Select All button selects all the available party lines in the PL 
column. 

1. Click Select All. 
All the party lines in the port column are highlighted. 

De-select All button The De-select All button removes the highlight from the all the party 
lines in the PL column. 

1. Click De-select All. 
All the party lines highlighted in the PL column are de-
selected. 

Invert Selection button The Invert Selection button reverses the selections made. For 
example, if 3 party lines are highlighted, and Invert Selection is 
clicked, the three party lines that were highlighted are no longer 
highlighted, while the rest of the PL list becomes highlighted. 

2. Click Invert Selection. 
The highlighted party lines are no longer highlighted, while 
party lines  that were not highlighted become highlighted. 
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Other Alphas 

The Other Alphas screen lets the user assign names and descriptions for party lines, IFB's, UPL Resources, etc. 
These names appear in the alphanumeric displays on keypanels after you assign the keypanel keys. 

Note: You can also change the name for a particular party line, IFB etc. in the relevant setup view 
by pressing Ctrl+F12 on the computer keyboard. For example, suppose you just clicked the PL 
button on the toolbar to set up a party line. Let's say you've decided to set up party line PL01 for 
use with a group of camera operators, but you also want to change the name of the party line 
from PL01 to CAMS. You can do this at the same time that you are assigning ports to the party 
line. Just press Ctrl+F12. 
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Party Line Alphas 

 

Screen Items 

Screen Item Field Type Description 

PL display column The PL column displays the system generated party line number. This 
number cannot be changed. 

Alpha display column The Alpha column displays the name of the party line. The default 
names may be changed to more meaningful names. The maximum 
characters allowed for an alpha is four. 

Alias display column The Alias column displays the alias of the party line. The alias can be 
changed to a  

The maximum characters allowed for an alias is four. 

Description display column The Description column displays a short description of the party line. 
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IFB Alphas 

 

Screen Items 

Screen Item Field Type Description 

IFB display column The IFB column displays the system generated IFB number. This 
number cannot be changed. 

Alpha display column The Alpha column displays the name of the IFB. The default names 
may be changed to more meaningful names. The maximum characters 
allowed for an alpha is four. 

Alias display column The Alias column displays the alias of the IFB. The alias can be 
changed to a  

The maximum characters allowed for an alias is four. 

Description display column The Description column displays a short description of the IFB. 
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Special List Alphas 

 

Screen Items 

Screen Item Field Type Description 

SL display column The SL column displays the system generated special list number. This 
number cannot be changed. 

Alpha display column The Alpha column displays the name of the SL. The default names 
may be changed to more meaningful names. The maximum characters 
allowed for an alpha is four. 

Alias display column The Alias column displays the alias of the SL. The alias can be 
changed to a  

The maximum characters allowed for an alias is four. 

Description display column The Description column displays a short description of the SL. 
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GPI Output Alphas 

 

Screen Items 

Screen Item Field Type Description 

RY display column The RY column displays the system generated GPI Output number. 
This number cannot be changed. 

Alpha display column The Alpha column displays the name of the GPI Output. The default 
names may be changed to more meaningful names. The maximum 
characters allowed for an alpha is four. 

Alias display column The Alias column displays the alias of the GPI Output. The alias can be 
changed to a  

The maximum characters allowed for an alias is four. 

Description display column The Description column displays a short description of the Output. 
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ISO Alphas 

 

Screen Items 

Screen Item Field Type Description 

ISO display column The ISO column displays the system generated ISO number. This 
number cannot be changed. 

Alpha display column The Alpha column displays the name of the ISO. The default names 
may be changed to more meaningful names. The maximum characters 
allowed for an alpha is four. 

Alias display column The Alias column displays the alias of the ISO. The alias can be 
changed to a  

The maximum characters allowed for an alias is four. 

Description display column The Description column displays a short description of the ISO. 
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UPL Resource Alphas 

 

Screen Items 

Screen Item Field Type Description 

UR display column The UR column displays the system generated UPL Resource number. 
This number cannot be changed. 

Alpha display column The Alpha column displays the name of the UPL Resource. The default 
names may be changed to more meaningful names. The maximum 
characters allowed for an alpha is four. 

Alias display column The Alias column displays the alias of the UPL Resource. The alias 
can be changed to a  

The maximum characters allowed for an alias is four. 

Description display column The Description column displays a short description of the UPL 
Resource. 
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GPI Input Descriptions 

 

Screen Items 

Screen Item Field Type Description 

DI display column The DI column displays the system generated Data Input number. This 
number cannot be changed. 

Description display column The Description column displays a short description of the GPI Input. 
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Inter-panel Dim Descriptions 

 

Screen Items 

Screen Item Field Type Description 

DIM display column The DIM column displays the system generated DIM number. This 
number cannot be changed. 

Description display column The Description column displays a short description of the Inter-panel 
Dim. 
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Common Tasks 

Move a User to a New Intercom Port 

As you set up your intercom system, you will establish many types of relationships between ports and the other types 
of intercom resources. The most obvious relationships are the point-to-point key assignments that let users talk to 
one another. If you move a user from one intercom port to another, you will have to search the intercom system and 
find all keys at all other intercom ports that are assigned to talk or listen to the user at the original port. Once all the 
assignments are found, you will need to reassign them to the updated port. If the user was defined in one more party 
lines, special lists, IFBs, or ISOs, you will have to update those designations as well. In order to make sure that all 
affected resources are properly updated the following procedure is recommended. 

Check for Assignments in the Intercom System 

 

Check for Party Line Participation 

1. From AZedit, click PL. 
The Party Lines setup screen appears. 

2. Check all party lines currently set up in your intercom system. If the user is a member of the party line, 
remove them from the PL Talker and/or PL Listener lists. If you know the new port number to which you are 
reassigning the user, select that port and add the user to the PL Talker and/or PL Listener list. 

Check for IFB Participation 

1. From AZedit, click IFB. 
The IFB setup screen appears. 

2. Scroll through IFB list checking to see if the old port is included in any of the Input or Output columns. 
If the old port is included, double-click the IFB and change the port setting from the old port to the new port. 

Check for GPI Output Participation 

1. From AZedit click GPI OUT. 
The GPI Out setup screen appears. 

2. Scroll through GPI Outputs checking to see if the old port is included in any of the Input or Output columns. 
If the old port is included, double-click that GPI Output and change the port setting from the old port to the 
new port. 

Check for ISO Participation 

1. From AZedit, click ISO. 
The ISO setup screen appears. 

2. Scroll through ISO list checking to see if the old port is included in the Output column. 
If the old port is included, double-click the ISO and change the port setting from the old port to the new port. 

Check for GPI Input Participation 

1. From AZedit, click GPI IN. 
The GPI Input setup screen appears. 

2. Scroll through GPI Input list checking to see if the old port is included in the keypanel column. 
If the old port is included, double-click the GPI Input and change the port setting from the old port to the new 
port. 

Check for UPL Statement Participation 
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1. From AZedit, click UPL. 
The User Programming Logic setup screen appears. 

2. Scroll through UPL Statements list checking to see if the old port is included in any of the Input or Output 
columns. 
If the old port is included, double-click the UPL Statement and change the port setting from the old port to 
the new port. 

Check Dim Tables Participation 

1. From AZedit, click Dim. 
The Inter-panel Dim Table setup screen appears. 

2. Check all Dim Table ports currently set up in your intercom system. 
If the user is a member of Dim table, remove them from the Dim Table. If you know the new port number to 
which you are reassigning the user, select that port and add the user to a Dim table on that port. 

Check for Forced or Inhibited Crosspoint Participation 

1. From AZedit, click XPT. 
The Crosspoint Status setup screen appears. 

2. Check all Crosspoints for the old port. If the old port is setup with force or inhibit, Release the port. 

 

Search for Key Assignments 

The key assignment search is an efficient and effective tool in searching for key assignments throughout the AZedit 
application. 

To use Search, do the following: 

1. Press Ctrl+F on the keyboard. 
The Search for Key Assignment screen appears. 

OR 

From the Edit menu, select Search for Key Assignment. 
The Search for Key Assignment screen appears. 

OR 

From the tool bar, click the Search button.  
The Search for Key Assignment screen appears. 

2. From the Key Type list, select the type of key assignment you want to search (for example, ports). 

 

3. From the list on the right, select the port, party line, etc. you want to search. 
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4. Click Do Search. 
The Search Status screen appears showing the results of your search. 

 
This list contains the names of all ports that have keys assigned to the target user. 

5. Select the key assignment you are searching for and click the Go to Panel button. 
The Keypanel / Port screen appears with the selected keypanel information populated. Notice, the Search 
Status screen did not close. Do NOT close the Search Status screen. 

Note: Sometimes there may not be a key assigned to the target user. In this case, you 
can change pages and perform the key assignment search. You may have to search all 
four pages. 

6. With the key assignment still selected, click Gain. 
The Select Gain Type screen appears. 

7. Select Crosspoint Gain and click OK. 
The Gain setup screen appears. 

Note: The default gain setting should be +0.0dB. If the setting is different, note the setting, 
and then reset it to +0.0dB. 

8. Click Done. 
Click 'Next' to work with another key assignment. 

9. Use normal key assignment procedures to assign keys. (See, Assigning Keys for Party Lines, IFBs, etc.). 
Enter the name of the new intercom port to which the user will be connected. (It does not matter if the port 
currently has the wrong name). 

10. When you finish reassigning a key, click Gain. 
The Gain Setup screen appears. 

11. Reset the gain, if necessary. 

Repeat steps 1 through 11 until all intercom ports in search are reassigned. 

12. Move the users configuration information (key assignments, restrictions, etc.) to the new intercom port. If 
there is no configuration information, skip steps 8-12) 

13. In AZedit, click KP. 
The Keypanel / Port main screen appears. 

14. In the Port / Alpha field, enter or select the users old port number/name. 

15. From the Edit menu, select Copy. 
The users old setup is copied. 

16. In the Port / Alpha field, enter /select the new intercom port the user will be connected. 

17. From the Edit menu, select Paste. 
The user's information should now appear in the Alpha box. 
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18. Using the normal procedure for assigning alphas to the ports, assign alphas in the intercom port. 
For information on Assigning Alphas, see Assigning Alphas) 

19. From the File menu, select SAVE. 

20. Once you save the file, click the Send icon.  
The changes are sent to the intercom system. 

21. Disconnect the users intercom cable from the old intercom port and reconnect to the new intercom port. 

The user has been moved from one intercom port to a new intercom port. All personnel who could previously 
communicate with the user at the old location will now be able to communicate at the new location. 
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Enable Trunking 

Trunking allows you to connect up to 32 systems together. One reason for a trunked system is to allow for more 
users. AZedit has the ability to support trunked systems, however, the application must be configured to accept 
trunking. 

To enable trunking, do the following: 

1. From the Options menu, select Preferences. 
The Applications Preferences screen appears. 

2. Click the Advanced tab 
The Advanced screen appears. 

3. Select the Enable Trunking check box. 

 

4. Click Apply. 

5. Click OK. 
The Application Preferences screen closes. 

Trunking is now enabled for AZedit trunking support. You DO NOT need to send this change to the Intercom. 
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Download Firmware Updates 

 

Updating Master Controller Firmwaree 

 

Warning! The following procedure will cause one or more brief disruptions in intercom communications. Also, save 
your intercom system configuration before proceeding. 

From the File menu, select Save. 

Later, if you need to restore the intercom configuration from disk, use Send File in the Online menu. 

 

Master Controller Update: ADAM CS, ADAM Single Frame, ADAM DBX System, Zeus, Zeus II 

Before you begin, be sure to verify that SERVER mode has been disabled. Also, it is very important to take the 
Standby Controller card out of the frame, if one is installed. 

Note: The Active Master Controller will have a red LED ON in the status LED window. 

To update the master controller, do the following: 

1. From the Status Menu, select Software Versions. 
A popup list appears. 

2. From the Software Versions popup list, select Master Controllers. 
The Master Controller Version Information screen appears. 

3. Right-click the active Master Controller, and then select Download Firmware. 
The Firmware Download screen appears. 

Note: You can also press Ctrl+Shift+D to open the Download Firmware screen once the Master 
Controller is highlighted. 

4. From the Download Firmware screen, select the firmware update file. 

5. Click Open. 
The firmware update appears in the Download Firmware screen. 

6. Click Begin Download. 
This process can take from one to five minutes depending on the baud rate you have selected. 

Note: If there is any disruption in the communications link during the download, you will get an error 
message. In this case, repeat the download. 

7. When the file has been completely downloaded, the master controller will begin processing the 
update.  
IMPORTANT: Any disruption at this point, such as a loss of power, removing or resetting cards 
(ADAM, ADAM CS, etc.) will result in Master Controller failure! 

If this happens, you will either have to return the affected unit for replacement or you will have to 
remove the EEPROM chip(s) from the affected unit and manually reprogram them with an 
EEPROM programming tool. 
ADAM and ADAM CS users do NOT proceed with the update of any more cards until you 
identify the problem. 

The AZedit session goes offline for 15-20 seconds when the card performs a reset. It automatically 
will reconnect when it is finished. 

M
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When the Master Controller is finished, the new software version will appear in the version field of 
the Version Status screen. 

If you do not have a Standby Controller Card, you can skip steps 8 and 9. 

8. Once the Active Master Controller is updated, remove the Controller card from the frame. 

9. Insert the Standby Controller card and repeat steps 4-8  

10. When the Standby Controller card is finished, insert both controllers and resend your system 
setup file. 
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 Appendix A 
AZedit Keyboard Shortcuts 
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Keyboard 
Shortcut 

Description Context 

CTRL+R Toggle key restriction state 
Keypanel 
assignment 

CTRL+SHIFT+R 
Toggle key restriction state, and set all keys to the right to the same 
state 

Keypanel 
assignment 

CTRL+ALT+R 
Toggle key restriction state, and set all keys to the left to the same 
state 

Keypanel 
assignment 

CTRL+D Toggle latch disable state 
Keypanel 
assignment 

CTRL+SHIFT+ALT+D 
Toggle latch disable state, and set all keys to the right to the same 
state 

Keypanel 
assignment 

CTRL+ALT+D 
Toggle latch disable state, and set all keys to the left to the same 
state 

Keypanel 
assignment 

CTRL+ENTER Display key assignment selection dialog 
Keypanel 
assignment 

SHIFT+ENTER Display port volume dialog 
Keypanel 
assignment 

PAGE DOWN Display next setup page / panel 
Keypanel 
screen 

PAGE UP Display previous setup page / panel 
Keypanel 
screen 

PAGE DOWN Display next LCP-102 mode 
LCP-102 
screen 

PAGE UP Display previous LCP-102 mode 
LCP-102 
screen 

CTRL+PAGE DOWN Display next keypanel, PL, SL, etc… Most screens 

CTRL+PAGE UP Display previous keypanel, PL, SL, etc… Most screens 

CTRL+TAB Toggle between setup page and panel oriented views 
Keypanel 
screen 

CTRL+SHIFT+TAB Toggle between setup page and panel oriented views (for all ports) 
Keypanel 
screen 

ALT+< 
Shift keypanel display to the left (when panel has more than 16 
keys) 

Keypanel 
screen 

ALT+> 
Shift keypanel display to the right (when panel has more than 16 
keys) 

Keypanel 
screen 

CTRL+T Toggle KP-32 key assignment viewing between talk and listen keys 
Keypanel 
screen (KP32) 

CTRL+1 View talk level 1 key assignments 
Keypanel 
screen 
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CTRL+2 View talk level 2 key assignments 
Keypanel 
screen 

CTRL+3 View talk level 3 key assignments 
Keypanel 
screen 

CTRL+4 View talk level 4 key assignments 
Keypanel 
screen 

CTRL+SHIFT+1 View listen level 1 key assignments 
Keypanel 
screen 

CTRL+UP View previous key level 
Keypanel 
screen 

CTRL+DOWN View next key level 
Keypanel 
screen 

CTRL+HOME Move focus to port number edit box 
Keypanel 
screen 

CTRL+SPACE Refresh data, re-upload screen data from intercom 
All screens 
(ONLINE) 

CTRL+LEFT Go back to previous view All screens 

CTRL+RIGHT Go forward to next view All screens 

CTRL+SHIFT+F12 Refresh alphas, re-upload alphas from intercom 
All screens 
(ONLINE) 

CTRL+N Create a new file All screens 

CTRL+O Open a file All screens 

CTRL+M Merge a file 
All screens 
(FILE) 

CTRL+S Save current file All screens 

CTRL+A Save current file with a new name (Save As) All screens 

CTRL+P Perform a partial save All screens 

CTRL+G Go online 
All screens 
(FILE) 

CTRL+L Load a file and mark changes for sending 
All screens 
(ONLINE) 

SHIFT+F10 Send changes to intercom 
All screens 
(ONLINE) 

CTRL+C Copy All screens 

CTRL+V Paste All screens 

ALT+BACKSPACE Undo last action All screens 

CTRL+Z Undo last action All screens 

CTRL+SHIFT+Z Redo last action All screens 

CTRL+F Search for key assignment All screens 
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CTRL+F12 Edit alpha for current resource (must be enabled in preferences) All screens 

CTRL+SHIFT+D Firmware download 
Status screens 
(ONLINE) 

CTRL+SHIFT+V Firmware versions 
All screens 
(ONLINE) 

CTRL+SHIFT+ALT+1 Perform first birthday 
All screens 
(ONLINE) 

CTRL+SHIFT+M View MC/AIO memory 
All screens 
(ONLINE) 

CTRL+SHIFT+C Display AZedit communication statistics All screens 
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 Appendix B  
AZedit Quick Start 
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 Introduction 

After you are finished connecting the PC containing the installed AZedit software to the Intercom system frame, you 
can configure AZedit using this Quick Start Guide. This guide is intended to get your system up and running with the 
most basic configurations. At some point, you will need to go back to make adjustments to the software configuration 
to make it more effective and efficient. 

Getting Started for New Users 

Step 1:  Assigning Port Alphas 

Step 2:  Assigning Other Alphas (Party Lines, Special Lists, etc.) 

Step 3:  Sending the changes to the Intercom 

Step 4:  Save the file 

Step 5:  Keypanel setup 

If you are using AZedit for the time, we recommend you use the following approach to begin configuring your 
intercom system. 

To quick start setup your intercom system, do the following: 

"Get Connected" to the Intercom system. 
Getting connected accomplishes two things: 

First, when you connect, AZedit compares its intercom configuration settings to the intercom system. If the settings 
do not match, the software will prompt you and display a message asking if you want to reconfigure the application. 
Normally, you should select "Yes, reconfigure this application". This ensures all the resources in your intercom 
system are available to you in the application. 
 
Second, by creating your setup file while being connected to the intercom system, you can check your progress by 
periodically sending your changes to the intercom system. By sending your changes to the intercom system, you can 
see the effects the changes have on the system. 
 
However, you can create the setup file in FILE mode. Periodically you should Save your changes to a disk so you 
have a backup. 

To create a setup file, do the following: 

1. Name the Resources you will be using. By resources, we mean the intercom ports, party lines, special 
lists, etc. All resources have default names. For example, intercom ports are named N001, N002, etc. By 
creating your own names, you personalize the intercom system and make it easier for yourself and others 
to identify people and places in the intercom system. Enter names for intercom ports using Port Alpha 
setup. For more information on Port Alphas, see Port Alphas in the AZedit User Manual. Enter names for 
other resources using the Other Alphas screen. 

2. If you are working on the setup file in FILE mode, use Save to periodically save your changes to a disk. 
If you are connected to the intercom system and working with the ONLINE setup, use Send Changes to 
periodically upload your changes to the intercom system. 

NOTE: You should also use Save to make a disk copy of the online setup. Whenever you send 
changes, the setup information is stored in non-volatile memory in the intercom system's master 
controller. This means that you not lose the setup information even if power is lost. If the 
configuration computer loses power while you are editing the online setup, you will only lose the 
changes that you have made since the last Send Changes command. 
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3. After you have named party lines, IFB's, etc, you can start assigning keypanel keys to talk and listen to 
those assignments. Do this using keypanel setup. 

By now, you should be getting a good basic sense of how to use the AZedit software to setup your intercom 
system.  

There are many other features of AZedit that have not been mentioned in this quick guide. It is recommended 
that you read through the AZedit User Manual or go through the help files that accompany the software. 

Assigning Alphas to Party Lines 

Party lines have default names, such as PL01, PL02 etc. You can change these names to something more 
recognizable to keypanel operators. You can also add brief descriptions to help you distinguish between party line 
uses.  

To assign a party line alpha, do the following: 

7. From the Keypanel / Ports screen, click Other Alphas. 
The Other Alphas screen appears. 

 

8. Select Party Line Alphas. 
The Party Line Alphas screen appears. 

9. Double-click the PL port you want to assign an alpha. 
The Edit Alpha Description screen appears. 

 

10. In the Description field, enter a description of the party line. There is a 24-character limit to the field. 

11. In the Alpha field, enter a meaningful alpha for the PL port (for example, a camera connected to the PL 
port, may have a name such as CAMS). 

Note: The Alias and Alpha fields populate with the same information. You can change the Alias, if 
needed. For more information see, the Port Alphas screen description. 

12. Click Done. 
The Party Line is renamed. 

Configure an IFB 

To configure an IFB, do the following: 
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7. Click the IFB button. 
The IFB screen appears. 

8. From the IFB list, select the IFB you want to configure. 

9. Double-click the IFB. 
The Edit IFB screen appears. 

 

Note: To restrict keypanel operators from assigning this IFB to keys on their keypanels, make sure 
not to select any check boxes under Scroll Enable. 

10. In the Input field, enter the port number or select the port alpha of the intercom port where the normal 
audio source is connected. 

11. In the Output field, enter the port number or select the port alpha of the intercom port where the talent 
earset or headset is connected. 

Note:  

• By default, the audio source is muted while the keypanel operator is talking. If you want to signal 
to be diminished by a certain amount during IFB, select a different amount in the Dim Level drop 
down list. 

• The Listen Source field is only used for 2-way IFB operation. It allows keypanel operators and/or 
studio personnel to listen to the talent during IFB Operation. Connect the talent Mic signal (the 
direct mic signal, not the mix-minus signal) to an intercom port input. Then, select that port in the 
Listen Source field. For more information on Listen Source setup, see Listen Source. 

For more information on Tone Override, see Set Tone Override IFB Setup. 

12. Click Done. 
The changes are made to the screen. However, be sure to save your changes or they will be lost. 
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 Glossary of Terms 

Abort Changes 

 

When Abort Changes is selected, any changes made to the online configuration (since the last time changes were 
sent) are erased. 

Note: This item is available in the online menu and via the Abort button. You must be in ONLINE 
mode to select this. ONLINE mode is indicated by the word “ONLINE” in the lower-right corner 
of the screen. If SERVER or FILE is indicated, Abort Changes will not be available. 

About AZedit 

About AZedit shows the version of the software, its build date, and copyright information. 

Analog I/O Gains 

The Analog I/O Gain feature is used to set the non-standard levels needed for accurate performance. Some external 
audio sources may provide output levels that are higher or lower than what is required for the intercom system audio 
input. Also, some external devices may require an audio input level that is higher or lower than the standard intercom 
system output level.  

AIO and DBX Status 

Use AIO and DBX Status to view connection status and data communication errors between Audio Input / Output and 
DBX Cards and the active Master Controller Card. You can also use this to upgrade the firmware in Audio Input / 
Output Cards and DBX cards 

 

 AIO and DBX Card Versions 

Use AIO AND DBX Card Versions to check the firmware versions of Audio Input / Output and DBX Cards. You can 
also use this to upgrade the firmware in Audio Input / Output and DBX cards. 
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 C 

Connect 

 

If AZedit is operating in FILE mode*, click the Connect button connect to the intercom system. Before connecting, the 
program checks to see if you have made any changes to your current intercom setup file. If there are changes, you 
will be allowed to cancel the connection and save your file before connecting. If there are no changes, the current 
intercom system setup file will immediately upload from the intercom system master controller, and this will over-write 
any setup file that is currently open. 

When you connect, ONLINE will display in the lower-right corner of the screen. In ONLINE mode, you can view the 
intercom system configuration and make changes, and you can also check various intercom statistics, such as which 
crosspoints are closed, which keys are active on a specific keypanel, the versions of firmware in various system 
devices, etc. 
* FILE mode means that you are not currently connected to the intercom system. This is indicated by the word "FILE" in the lower-right corner of the screen. 

 

CANCEL CHANGES 

 

Cancel Changes gives you the ability to move from screen to screen and clear changes made to any item. When 
you select an item and then select Cancel Changes, a confirmation dialog displays a "Cancel Changes for ALL items 
of the selected type" message. 

Cancel Changes is available only in ONLINE mode and only when an item is selected that has been changed since 
the last time changes were saved or sent to the intercom system. Cancel Changes can be accessed in the Edit menu 
or via the Cancel Changes button.  

Check for Duplicate Alphas 

By default, AZedit prompts to Check for Duplicate Alphas whenever you open a file from disk. 

In a large-scale intercom system, the possibility exists that you may accidentally assign the same name (alpha) to two 
different resources. Two resources of the same type can never be named the same. For example, two intercom ports 
should not be named Dir 1. 

On the other hand, you may decide to use the same name for two resources of different types. For example, you may 
decide to use the same name for both an intercom port and an IFB. Although you can do this, we strongly 
recommend that you do not. 

Note: If you name an intercom port and an IFB the same name, turn off Scroll Enable for the 
intercom port. This ensures that keypanel operators can assign the IFB to keypanel keys. 

 

To activate or deactivate both the prompt and the check, do the following: 
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From the Options menu, select Preferences. 

1. Click the Alphas tab. 
 

To Activate: 

2. Select the Automatically check for duplicate alphas after opening a file, and Prompt before checking 
for duplicate alphas check box. 
 

To Deactivate: 

3. Deselect the Automatically check for duplicate alphas after opening a file, and Prompt before 
checking for duplicate alphas check box. 

You can also select Check for duplicate alphas... in the Alphas menu at any time to identify and correct duplicate 
alphas in your setup file or in the online configuration. 

Communications 

The communications screen allows you to select the COM port and baud rate for communication between the PC and 
the intercom system. 

To access the Communications screen, do the following: 

1. From the Options menu, select Communications. 
The Communications screen appears. 

Communication Status Pane 

The Communication Status Pane indicates the data transmission activity between the configuration computer and 
the intercom system. 

The first green light in the lower right window indicates the computer is sending data to the COM port specified in the 
Communications dialog. This indicator flickers occasionally whether the computer is connected to the intercom 
system or not, since the computer always periodically polls the port. 

The second green light in the lower right window indicates the computer is receiving data from the intercom system. 
This indicator is active only when the computer is connected to the intercom system and the configuration software is 
in ONLINE mode or SERVER mode. 

Connect on Startup 

AZedit automatically attempts to log onto the intercom system whenever the program is started. 
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Copy 

 

When selectable, Copy duplicates all of the information on the screen you are currently viewing. 

Copy is available from the Edit menu or the Copy button.  

Crosspoint Gains 
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DBX Links 

Use DBX Links to view information about the links between DBX (Dual Bus Expansion) cards in a multi-frame ADAM 
intercom system that uses this type of card. 

This item is only selectable in ONLINE mode when AZedit is connected to a DBX system.  

Any of the following indications can be given: 

<dash>: this link is not being used for audio 

###-###: this link is being used for the timeslots indicated 

Example 1 

The following information would be displayed for a 2-frame system without redundant DBX cards. There is one DBX 
card per frame (in slot 9). Both DBX cards are “active” in their frame, and ALL links are up. 

DBX       Status        Link A   Link B    Audio A   Audio B 
1:009   OK Active   OK ALL   OK ALL        -         129-252 

2:009   OK Active   OK ALL   OK ALL        -         001-124 

Link A is not being used for audio in either direction. Link B, in frame 1, is being used to drive timeslots 129-252 
from frame 2, and Link B in frame 2, is being used to drive timeslots 1-124 from frame 1. 

Note, in systems where there is only 1 DBX card per frame (2 frame, and 3 frames systems without redundant 
controllers), and if test audio is enabled, then only 124 timeslots can be forwarded between frames. A DBX link can 
forward 128 timeslots, but test audio requires 4 timeslots per link. In the 256x256 (2 frame), and 384x384 (3 frame) 
systems which have only 1 DBX card per frame, all timeslots per link are needed for audio, but if test audio is 
enabled, the last 4 timeslots in each frame are not available. 

This means that the last four ports in each frame can listen to, but not talk to ports in other frames. Similarly, ports in 
other frames can talk to, but not listen to the last four ports in each frame. Within any frame, any port can talk or listen 
to any other port in that frame, the timeslots are only lost going between frames. 

Test Audio is artificially generated audio by the DBX that it can produce, publish, forward, receive, and test. It is used 
by the DBX to ensure that the links are passing valid audio between frames. If the DBX detects that the link is up, but 
that the audio is corrupt, the DBX tears down the link and builds it up again. 

Example 2 

DBX        Status       Link A   Link B   Audio A   Audio B 
1:009   OK Active      OK 1      -  -        129-252        - 

2:009   OK Active      OK 1      -  -        001-124        - 

In this example, the link connecting Port B of 1:9 to Port B of 2:9 has been broken. The audio automatically switched 
over to the A links, and the “hop” count for the A links shows 1 instead of ALL. 

Note, even though this intercom is called a 2 frame non-redundant system, it actually has redundant audio because 
both links go between frame 1 and 2. The intercom does not have redundant control because there is only one DBX 
card per frame, and if any card fails, connectivity is lost. 

Note, it is possible for the audio from frame 1 to frame 2 to be carried on one link while audio in the other direction is 
carried on another link. 
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Dim Number 

The Dim Number is a representation of the Dim table. The number and description is generated from the Other 
Alpha's listing (SHIFT+F12). 

Dim Table 

For each Dim table, a different number of members and amount of dimming may be set. Members may be associated 
with more than one dim table.  

Dim is placed on the talk key as a second level function. It invokes the processor to search all the configured Dim 
groups whenever the talk key is depressed. 

Dim Table Alphas 

Dim Table Alphas are unique identifiers that name the table. 

Note: You can also change the description for a particular dim table using Ctrl+F12 alpha editing. 

Disable listen key latch 

 
Some keypanels feature electronic key latching. To disable latching for a key assignment, select the Disable check 
box (D) above that key assignment. (Or, press Ctrl+D on the computer keyboard while the key assignment is 
selected.) 

Disable Logging 

Disable Logging stops the logging feature from recording any talk and listen key activity. 

Disable talk key latch  

 

Some keypanels feature electronic key latching. To disable latching for a key assignment, select the Disable check 
box (D) above that key assignment. (Or, press Ctrl+D on the computer keyboard while the key  
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Edit button 

The Edit button accesses additional and advanced setup features for the current port or keypanel. 

Exit 

Select Exit to close AZedit. Normally, you will see a warning and given a chance to cancel if you have not saved your 
configuration information. You can deactivate the warning if desired. 

To deactivate the warning, do the following: 

1. In the Options menu, select Preferences. 

2. Click the Startup / Shutdown tab. 

3. Remove the check mark next to Ask for confirmation before exit. 

4. Click OK to finish. 
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Gain 

Use Gain to adjust crosspoint and party line gains. Increase the level of a sound by increasing the amplitude of the 
frequency. A volume control essentially adjusts gain for an audio/video system. Gain is simply the increase of a 
signal. Typically, higher gain is better. 

Go Back 

 

Go Back reverts to previously viewed windows, up to 20 consecutively previous screens. 

Go Back is available in the View menu and also via the Go Back button. 

Go Forward 

 

Go Forward allows you to follow the same sequence of windows you used with Go Back. Go Forward is used in 
conjunction with Go Back. 

GO FORWARD IS AVAILABLE IN THE VIEW MENU AND ALSO VIA THE GO FORWARD BUTTON.  
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ID Number Pane 

When you are viewing most screens, the ID Number Pane displays the identification number of the resource that is 
currently selected. In the keypanel setup view or the LCP-102 setup view, if you move the cursor over an assignment, 
this pane displays the identification number of the assignment. 

Note: Whenever there is a number displayed here, the pane immediately to the left of this pane will 
indicate the type of key assignment or resource: PP (point-to-point), PL (party line) etc. 

IFB 

IFB provides access to the IFB setup screen, where you define IFB inputs and outputs.  

IFB Alphas 

Use IFB Alphas assign four character names and up to twenty-four character descriptions to IFB’s. 

Note: You can also change the name for a particular IFB using Ctrl+F12 alpha editing. 

IFB Listen Destination 

IFB Listen Destination is a keypanel setting used with the IFB Listen Source feature. It lets you redirect the IFB 
listen audio from the keypanel speaker or headset to an external device, such as a studio monitor, when the keypanel 
operator activates a key to listen to the talent mic audio. 

The IFB Setup Procedures demonstrate how IFB Listen Destination is used. 

IFB priority  

Use the IFB Priority buttons to assign a priority to the selected port for use in determining override order when 
accessing IFB assignments. The higher the port number is, the higher the priority in access will be. Ports with the 
same priority level will access a given IFB at the same time. 

IFB Listen Source 

IFB Listen Source let you define a talent mic source for use with each IFB. Listen sources are used with the Auto 
Table feature so the listen key for an IFB is always assigned to listen to whatever port is assigned to the IFB talk key. 

The IFB Setup Procedures demonstrate how IFB Listen Sources are used. 
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Intercom Configuration 

Use Intercom Configuration to view the number of available resources and options, such as intercom ports, party 
lines, number of talk levels, etc. In an ADAM or ADAM CS intercom system, you can also use Intercom Configuration 
to change the resource and option settings. 

Intercom Status Pane 

The Intercom Status Pane provides any one of the following indications: 

----  No intercom detected 

LOCL  Intercom detected, but type not recognized 

SLV  Slave frame of a multi-frame ADAM system detected (won't go ONLINE, all system 
configuration is performed via the master frame connection) 

CS9X  CS9x00 intercom detected (will not go ONLINE) 

ADAM  ADAM or ADAMCS intercom detected (will only go ONLINE if running AZedit) 

name  The alpha name assigned to an ADAM or ADAM CS intercom system that is operating in 
a trunking environment (names assigned using CStrunk) 

Intercom System Name Pane (Intercom Alpha) 

When you are viewing most screens, the Intercom System Name Pane (Intercom Alpha) displays the name of the 
intercom system where the currently selected resource is located.  

In the keypanel setup view or the LCP-102 setup view, if you move the cursor over an assignment, this pane also 
displays the name of the intercom system where that assignment is located. 

If your intercom system is not interconnected with any other intercom systems, this pane displays LOCL for all 
resources. This indicates that the resource is located in the local intercom system. 

If your intercom system is part of a larger trunking* intercom system, then some resources which are being used in 
your intercom system may actually be located in a remote intercom system. For example, a key on a keypanel in your 
intercom system could be assigned to talk to a person in a remote intercom system. In such cases, this pane displays 
the name of the remote intercom system. 

ISO 

ISO provides access to the ISO (Isolate) setup screen. 

ISO Alphas 

Use ISO Alphas to assign four character names and up to twenty-four character descriptions to isolates. 

Note: You can also change the name for a particular ISO using Ctrl+F12 alpha editing. 
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Keypanel / Ports Setup 

Keypanel/Ports Setup provides access to the Keypanel / Ports setup screen, where you can set up keypanels 
(assign keys etc.), assign GPI Inputs to set scroll restrictions for intercom ports, and to view keypanel activity. 

Keypanel Versions 

Use the Keypanel Versions screen to check the firmware versions of keypanels. You can also use this to upgrade 
the firmware in certain types of keypanels. 

Keypanel Version Screen Information  
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LCP-102 Assignment 

Use the LCP-102 Assignment to set up an optional LCP-102 Level Control Panel. 

LCP key assignment 

Use the LCP Key Assignment to assign the LCP keys. To change the assignment type the new assignment in the 
box for the key of interest, or right click on the assignment of interest and choose the Change Assignment option. 

Load File 

Load File lets you select a file from disk, view its contents, and then merge it into the ONLINE configuration, if 
desired. The settings in the file that you are loading overwrite any corresponding settings in the online configuration, 
and whatever is changed is highlighted in yellow. For example, if you load a file that contains only settings for 
intercom port 1, you will notice that only items for intercom port 1 are highlighted. Note, these changes will NOT be 
sent to the intercom system until you use the Send Changes command.  

Generally, use Load File when you want to merge into the ONLINE configuration a file that was saved using the 
Partial Save command. You can either use the Send Changes command to send the partial changes to the intercom 
system or use the Save command from the File menu to create a new disk file that contains both current settings 
from the intercom system and previously saved settings from a partial intercom file. 

Load File is only available in ONLINE mode. 

Note: If your real intention is to completely overwrite the ONLINE configuration using a file from 
disk, you should use Send File (also located in the Online menu).  

Local party line tallies 

Use Local Party Line Tallies when two or more keypanels have keys assigned to talk to the same party line. For 
example, two different keypanels have the same party line assigned to a talk key. If one of the keypanels activates 
the party line talk key, the tally indication will be supplied at the other keypanel. 

Typically, the tally indication is in the form of a flashing alphanumeric display (KP9x series keypanels) or a 
continuously lit, red LED talk key indicator (most other keypanels). The tally indication tells the keypanel operator that 
activating the party line key will break in on a conversation that is in progress. 

Log to File 

When Log to File is selected from the Logging menu all talk and listen key activity is logged to a file on disk. 
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Log to Serial Port 

When Log to Serial Port is selected the output talk and listen key activity is logged in ASCII text format via an 
RS232 serial port. This requires a separate COM port connection at the computer. 

See logging description for further details. 
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Master Controller Status 

Use Master Controller Status to view connection status and data communication errors between the master 
controller and the configuration PC. You can also use this to upgrade the master controller firmware. 

Note: In an ADAM or ADAM CS intercom system this item displays status information about the active master 
controller card, and the standby master controller card status can be viewed with the Standby Controller item on the 
Status menu. 

Master Controller Versions 

Use Master Controller Versions to check the Master Controller firmware version. You can also use this to upgrade 
the Master Controller firmware. 

Maximize 

Maximize expands the AZedit window to fill the entire screen. 

Merge 

 

Use Merge to combine the contents of a previously saved file into a file that you are currently editing. Typically, use 
merge with partial setup files that have been previously saved using partial save. 

Merge is available in the File menu and also via the merge button. 

Minimize 

Minimize closes, but not exits, the AZedit window. The window is reduced to an icon in the taskbar. 
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Mode Pane 

 

The Mode Pane indicates the current operating mode as follows: 

• FILE Indicates that the computer is not communicating with the intercom system. In this mode, you can 
create new setup files, and also open and edit existing setup files. This mode is recommended if you are 
making many changes and want to save your file to disk periodically, but do not need to immediately 
download the changes to the intercom system. 

• ONLINE Indicates that the computer is communicating with the intercom system, but is not in SERVER 
mode. This means that you can make changes to the intercom configuration, or manually send new setup 
files to the intercom system. Note: if you are making many changes to an intercom setup file and want to 
save it periodically, you will be able to do this much more quickly in FILE mode. 

• SERVER Indicates that the computer is online and operating in SERVER mode. This means that you can 
view the current intercom system configuration, as well as intercom activity, but you cannot make any 
changes. 
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New 

 

If you are currently editing a file in FILE mode, clicking New will clear all settings and open a new, blank setup file 
(you will be prompted for confirmation first).  

• If you are in FILE mode, but no changes have been made, clicking New will immediately start a new setup file 
without any prompts.  

• If you are in ONLINE mode, clicking New will cause the computer to disconnect from the intercom system and 
enter FILE mode (you will be prompted for confirmation). A blank setup file is started. 

• If you are operating in SERVER mode, you cannot start a new file. 

NOT PL Listener button 

Use the NOT PL Listener button to  make the selected port(s) not permanent listeners (P-L) for the currently viewed 
PL assignment. 

NOT PL Talker button 

Use the NOT PL Talker button to make the selected port(s) not permanent talkers (P-T) for the currently viewed PL 
assignment. 
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Open 

 

• If you are currently editing a file in FILE mode, clicking Open will clear all settings and open a file that you select 
from disk (you will be prompted for confirmation first).  

• If you are in FILE mode, but no changes have been made, clicking Open will immediately let you select a file to 
open from disk without any prompts.  

• If you are in ONLINE mode, clicking Open will cause the computer to disconnect from the intercom system and 
enter FILE mode (you will be prompted for confirmation). Then, you can select a file to open. 

• If you are operating in SERVER mode, you cannot open a file. 

This item is available in the File menu and also via the Open button. 

Other Alphas 

Use Other Alphas to assign names and descriptions for party lines, IFB’s, UPL Resources, etc. These names 
appear in the alphanumeric displays on keypanels after you assign the keypanel keys. 

Note: You can also change the name for a particular party line, IFB etc. in the relevant setup view 
by pressing Ctrl+F12 on the computer keyboard. For example, suppose you just clicked the PL 
button on the toolbar to set up a party line. Let's say you've decided to set up party line PL01 for 
use with a group of camera operators, but you also want to change the name of the party line 
from PL01 to CAMS. You can do this at the same time that you are assigning ports to the party 
line. Just press Ctrl+F12. 
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PAP and LCP-102 Status 

Use PAP and LCP-102 to view connection status and data communication errors between the master controller and 
any Program Assign Panels or LCP-102 Level Control Panels that are connected to the intercom system. 

PAP and LCP-102 Status Screen Information  

Page combo box 

The Page Combo Box displays and controls the page of assignments that are displayed for the current keypanel 
view. 

 

PANEL STATUS BITMAP GRID 

The Panel Status Bitmap Grid displays icons in the Keypanel / Port Settings group (next to the Port Status group). 
These icons remind you that certain selections have been made using the Edit button. 

 

 

Musical Note Icon: Indicates that Enable Tone is checked. 

 

Sunglass Icon: Indicates that Keypanel Privacy is checked 

 

No Phone Dial Icon: Indicates that TIF Dial-Out Restrict is checked 

 

Modem Icon: Indicates that a Panel Poll Delay has been specified 

 

Phone Icon: Indicates that Port is TIF is checked 

 

"No" Symbol: Indicates that Setup Restrict is checked.  
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Panel type description 

The Panel Type Description is the current panel type as reported by the intercom or as set by the user.  

Partial Save 

Partial Save lets you save parts of the setup file you are currently working on. Later, you can send the 
partial configuration to the intercom system using the Send File command. Or, you can use the Merge 
command to merge the partial file into another setup file that you are working on. For example, you might 
use Partial Save to save all of your UPL Resources and UPL Statements in their own file. You can then 
merge this file into your other setup files, as needed, using the Merge command. 

Party Line 

Party Line provides access to the Party Line setup screen. Use the Party Line set up screen to assign intercom ports 
to party lines (conference lines). 

Party Line Alphas 

Use Party Line Alphas to assign four character names and up to twenty-four character descriptions to party lines.  

Note: You can also change the name for a particular party line using Ctrl+F12 alpha editing. 

Party Line Gains 

Use the Party-Line Gains screen to adjust the listen level from a specific party line to a specific intercom port. 

Paste 

 

Paste inserts the entire contents of the clipboard into the current configuration screen (if that screen is of the same 
type as the one that was copied). It is used in conjunction with the Copy command. 

Note: To select which items that you want to paste, or to simultaneously paste to multiple screens, use Paste Special 
instead of Paste. Paste Special is also available in the Edit menu. 

Paste is available in the Edit menu and via the Paste button. 
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Paste Special 

Paste Special gives you greater control over pasting than when using the Paste command. You can: 

• Paste portions of the Windows Clipboard to a screen 

• Paste to multiple screens. 

For important applications of the Paste Special command, see Listen Key Setup using Copy and Paste Special, or 
Scroll Enable Setup using Copy and Paste Special. 

PL Alpha combo box 

The PL Alpha Combo box shows the alpha assigned to the current party-line (PL) system. 

PL Number 

The PL Number box shows the number assigned to the current party-line (PL) system. 

PL Listener button 

Use the PL Listener button to make the selected port(s) permanent listeners (P-L) for the currently viewed PL 
assignment. The permanent listener assignment is usually only used with non-intelligent devices (i.e. devices that 
cannot instruct the intercom system on how to route the audio). 

This option is usually not used with keypanels. 

PL Talker button 

Use the PL Talker button to make the selected port(s) permanent talkers (P-T) for the currently viewed PL 
assignment. The permanent talker assignment is only used with non-intelligent devices (i.e. devices that cannot 
instruct the intercom system on how to route the audio). 

This option is usually not used with keypanels. 

Port Alphas 

Use the Port Alpha screen to assign names and descriptions to intercom ports. When you assign the ports to 
keypanel keys (using keypanel setup) these names appear in the alphanumeric displays on the keypanel. 

Note: You can also change the name for a particular intercom port by pressing Ctrl+F12 while viewing that port. 

Port Description  
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Port Edit Box 

The Port Edit Box displays the port number for the port setup currently being viewed. Typing a different port number 
in this box shows the setup information for the specified port. 

Port Status 

Use Port Status to view connection status and data communication errors between intercom ports and the master 
controller. You can also use this to upgrade the firmware in certain types of keypanels connected to intercom ports. 

Port Status Screen Information 

 

Port Status  

"--    --" 

Two consecutive dashes indicate that there has never been any data communication with a device at the port. 

Bad Cut: 

Indicates that there was communication with a data device, but communication has stopped. 

OK KP 1-7 

Indicates that the device connected to the port is a normally functioning keypanel. The numbers 1-7 indicates the 
keypanel DIP switch settings for switches SW1-1 through SW1-3 on the keypanel rear panel as summarized in the 
table below. Refer to the keypanel's installation instructions for information on DIP switch settings. In the case of a 
keypanel that does not have DIP switches on its rear panel, "KP 7" will appear to indicate that the keypanel is a 
normally functioning keypanel. 

Number      Switch Settings 

 SW1-1 SW1-2 SW1-3 

   0 Open Open Open 

   1 Open Closed Open 

   2 Closed Closed Open 

   3 Same as 2 

   4 Open Open Closed 

   5 Open Closed Closed 

   6 Closed Closed Closed 

   7 Same as 6 
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Ok ? 

Indicates that the data device connected to the port is a keypanel with an unknown or earlier version of software. 

OK TIF 

Indicates that the data device connected to the port is a TIF-951 or TIF-2000 Telephone Interface. 

Port status bitmap grid 

The Port Status Bitmap Grid displays the following icons in the Port Status group (upper-right corner of the 
Keypanels / Ports screen). Most of these icons activate based on keypanel features detected by the intercom system 
master controller. 

 

Heartbeat Icon: Indicates that a data device (keypanel, TIF, or Camera Delegate Panel) is connected to the intercom 
port 

 

Warning Icon: Indicates that the intercom port is defined as an IFB output (in the IFB Setup screen).  

 

Headset Icon: Indicates that the connected keypanel has a headset selected 

 

LED Icons: Indicate the on/off state of any local GPI inputs and outputs. These indicators function only when a 
keypanel with a local GPI port is connected. Green=On (Asserted), Red=Off (Inhibited), Gray=None, IN=GPI Input, 
OUT=GPI Output. 

 

Question Mark Icon: Indicates that the keypanel type you have selected (with the Edit button) does not match what 
is reported by the intercom system. 

Print 
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Print prints the configuration information for the current window. For example, to print the configuration information 
for party lines, press the PL button on the toolbar to view the party line configuration information, then select print. 

Print is available via the File menu and the Print button. 

Print Preview 

Print Preview lets you see how the printed page will look before you print it. 

Print Setup 

Print Setup lets you select the printer, the orientation of the paper, and any other options that are available for your 
workstation. 
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Redo 

 

Redo recreates up to 20 consecutive changes that you previously canceled with the Undo button. Redo clears every 
time you save your setup file or send your changes to the intercom system. 

Redo is available in the Edit menu and via the Redo button.  

Refresh 

In ONLINE or SERVER modes, selecting Refresh restores the most current configuration and status information 
about an intercom station in AZedit. Use Refresh with any screen that provides status information. 

For example, if you are viewing a particular Keypanel/Port screen, by selecting Refresh you can see which keys are 
currently activated. For each key that is ON, a red dot appears above the key  

Refresh is available in the View menu and also by pressing Ctrl+Space bar on the computer keyboard. 

Note: The screens refresh automatically, usually every few seconds. However, the time between refreshes can vary, 
depending on intercom activity, and the size of the intercom system. Use Refresh to ensure you are viewing the most 
recent information for a particular screen. 

Refresh Alphas 

Use Refresh Alphas to upload all current names from the intercom system to AZedit. 

This item is available only in ONLINE mode.  

Relay Alpha 

The Relay Alpha box contains the alpha assigned to the selected relay. Relays are optional in special lists.  

If a relay is selected, then the relay will close when the special list currently being viewed is activated from a 
keypanel. 

Relay Number 

The Relay Number box contains the number assigned to the selected relay. Relays are optional in special lists. 

If a relay is selected, then the relay closes when the special list currently being viewed is activated from a keypanel. 
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Remote Intercoms 

Use Remote Intercoms to view the status of remote intercoms. From this screen, you can choose to clear key 
assignments that refer to disconnected intercoms.  

Reset Capabilities 

Use Reset Capabilities to reactivate any capabilities of AZedit that may have been disabled. AZedit capabilities may 
have been disabled in several ways: 

• Some AZedit features may be disabled by default because they are not commonly used. 

• AZedit capabilities may have been disabled by directly editing the [capabilities] section of the AZedit.ini file 
(This file is located in your Windows folder and can be edited in any text editor, such as Windows Notepad.) 
Editing the [capabilities] section of the AZedit.ini file is not recommended. 

• AZedit features may have been disabled by connecting to an intercom system that uses older firmware, with 
fewer capabilities than what is supported by your AZedit version. In this case you will see a prompt that 
there is a capabilities conflict, and you will be given the choice to reset AZedit capabilities to match the 
intercom system. If you do this, some capabilities may be deactivated, and you will not be able to use those 
features. See Capabilities Conflict Message for further details. 

Reset Capabilities can only be selected in FILE mode. 

Resource Type Pane 

When you are viewing most screens, the Resource Type Pane displays the type of resource that is currently 
selected. In the keypanel setup view or the LCP-102 setup view, if you move the cursor over an assignment, this 
pane displays the type of resource that is assigned. 

Note: Whenever there is a resource type displayed here, the pane immediately to the right of this pane 
will indicate the identification number of the resource.  

Restore 

Restore returns the AZedit window to the previously changed size. 

Restrict listen key 

 

To prevent a keypanel operator from changing a key assignment, select the Restrict check box (R) above that key 
assignment. (Or press Ctrl+R on the computer keyboard while the key assignment is selected.) 

Note: You may wish to set all of the restriction check boxes for all setup pages at all intercom 
ports. You can do by using the Copy and Paste Special commands. 
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Restrict talk key  

 
To prevent a keypanel operator from changing a key assignment, select the Restrict check box (R) above that key 
assignment. (Or press Ctrl+R on the computer keyboard while the key assignment is selected.) 

Note: You may wish to set all of the restriction check boxes for all setup pages at all intercom ports. You can do this 
quite easily using the Copy and Paste Special commands. 
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Save 

 

If you are currently editing a new file in FILE mode, clicking Save will let you select a file name and location to save.  

• If you are in FILE mode, and editing a previously opened setup file, clicking Save allows you to save the file with 
the same file name or with a different name.  

• If you are in ONLINE mode, clicking Save will cause the computer to upload the current intercom system 
configuration and merge it with any changes you have made but not sent to the intercom system. This assures 
that the latest settings are saved. For example, if one or two keypanel operators change key assignments on 
their keypanels while you are editing the Online configuration, both your changes and their changes will be 
saved. 

• If you are operating in SERVER mode, you cannot save a file. 

Note: By default, all setup files are saved in a folder called Setups, which is located in your AZedit program folder. This 
folder will not be deleted if you use the Uninstall utility to remove AZedit. We recommend that you save your files in 
this folder. 

Save is available in the File menu and also via the Save button. 

Save As 

• If you are currently editing a new file in FILE mode, clicking on Save As will let you select a file name and 
location to save.  

• If you are in FILE mode, and editing a previously opened setup file, clicking Save As allow you to save the file 
with a new file name.  

• If you are in ONLINE mode, clicking Save As will cause the computer to upload the current intercom system 
configuration and merge it with any changes you have made but not sent to the intercom system. This assures 
that the latest settings are save. For example, if one or two keypanel operators change key assignments on their 
keypanels while you are editing the Online configuration, both your changes and their changes will be saved. 

• If you are operating in SERVER mode, you cannot use Save As. 

 

Note: By default, all setup files are saved in a folder called Setups, which is located in your AZedit program folder. This 
folder will not be deleted if you use the Uninstall utility to remove AZedit. We recommend that you save your files in 
this folder. 

This item is available in the File menu only. 
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Search 

 

Search helps you locate all intercom keys that are assigned to talk or listen to a particular intercom port, party line, 
etc.  

Search is useful when you move a user from one intercom port to another. You will have to search for all keypanels 
that have keys assigned to that person’s old port, and change them to the new port.  

Search is available in the Edit menu and via the Search button. 

Send Changes 

 

Send Changes can only be selected in ONLINE mode. When you make changes, the changed items are highlighted 
in yellow. When you select Send Changes, these items will be sent to the intercom system. 

Send Changes is available in the Online menu and also via the Send Changes button. ONLINE mode is indicated by 
the word “ONLINE” in the lower-right corner of the screen. If SERVER or FILE is indicated, Send Changes will not be 
available.  

Send File 

 

Send File lets you select a file from disk, view its contents, and then send it to the intercom system. If the file is a 
complete setup file, all configuration information in the intercom system will be overwritten. If the file was created 
using the Partial Save command, only those items contained in the file will be overwritten in the intercom system. 

Send File is only available in ONLINE mode. You can access Send File in the Online menu, or with the Send File 
button. 

Server Mode 

When SERVER Mode is on, you can view the online configuration and also observe intercom activity, but you cannot 
make changes or manually load or send files. However, the intercom system can request files from the computer via 
UPL statements. 

SERVER mode must be activated if you want to use UPL statements to download files. You can only select Server 
Mode when the computer is connected to the intercom system and communicating with it. (ONLINE must first appear 
in the lower-right corner of the screen. Then, when you select Server Mode, ONLINE will change to SERVER.)  

Click Server Mode from the Online menu to turn it ON.  

Click again to turn it OFF. 
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Note: You can set AZedit to always enter SERVER mode at startup:  

In the Options menu, select Preferences. 

Click the Startup / Shutdown tab. 

Select the Auto enter SERVER mode check box to enable AZedit to enter Server Mode at startup. 

Show volume buttons 

Use the Show Volume button to view the current listen levels for a keypanel. 

This is an optional description supplied by the user when defining alphas for the keypanel/port. 

Size 

Size allows you to change the size of the window using the arrow buttons on the keyboard. 

SL Number 

The SL Number box contains the number assigned to the Special List currently being viewed. 

Sort Alphas Numerically 

If checked, AZedit will sort alpha list boxes by port number.  

If not checked, alpha list boxes will be sorted alphabetically. 

Special List 

Special Lists allow users to page a group or department consisting of a number of keypanels. This is useful when to 
talk to anyone in a group or when you are looking for someone but do not know which station they are at. When 
somebody in the group answers the page, a private conversation is initiated. 

Special List Alphas 

Use Special List Alphas to assign four character names and up to twenty-four character descriptions to special lists. 

Note: You can also change the name for a particular special list using Ctrl+F12 alpha editing. 
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Standby Controller Status 

Use Standby Controller Status to view connection status and data communication errors between the standby 
master controller card and the active master controller card. 

Standby Controller Status Screen Information  

Stby MC Status - Status Column 

"--    --" 

 

The Stby MC Status - Status columns show the status between the master controller and the standby master 
controller Two consecutive dashes indicate that there has never been any data communication between the standby 
controller and the master controller during the current edit session. This could be because the device is not 
connected. 

Bad Cut: 
Indicates that there was a connection to the standby controller, but it is now not connected or there may be a power 
failure or other problem somewhere in the system. 

OK Cur: 
Indicates that the standby controller is connected and operating, and that it has been updated with the current 
intercom system configuration. 

OK Old: 
Indicates that the standby controller is connected and operating, but that it has not been updated with the current 
intercom system configuration.  

Status Bar 

 

Status Bar activates the status bar at the bottom of the AZedit window. 

Toolbar is available under the View menu. 
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Toolbar 

 

Toolbar turns the toolbar ON or OFF. 

The toolbar is located at the bottom of the screen, above the Status Bar. 

Toolbar is available under the View menu. 

Trunk Master Status 

If your intercom system uses an optional FR9589 or TM2000 Trunking Master Controller, you can use Trunk Master 
Status to view connection status and data communication errors between the TM2000 and the active master 
controller in your local ADAM or ADAM CS intercom system.  

Trunk Master Status Screen Information 

Trunk party line tallies 

Use Trunk Party Line Tallies when two or more keypanels have keys assigned to talk to the same party line. For 
example, two different keypanels have the same party line assigned to a talk key. If one of the keypanels activates 
the party line talk key, the tally indication will be supplied at the other keypanel. 

Note: This is not referring to keypanels that are members of the party line, but keypanels that can 
talk to the party line with an intercom key. 

Typically, the tally indication is in the form of a flashing alphanumeric display (KP9x series keypanels) or a 
continuously lit, red LED talk key indicator (most other keypanels). The tally indication tells the keypanel operator that 
activating the party line key will break in on a conversation that is in progress. 

Trunk Ports 

Use Trunk Ports to view a list of trunk ports in the connected intercom. Using this feature, you can inspect the trunk 
port usage (as from CStrunk). 
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UIO-256 Status 

Use UIO-256 to view connection status and data communication errors between the master controller and any UIO-
256 Universal Input / Output Frames that are connected to the intercom system.  

UIO-256 Status Screen Information  

Undo 

 

Undo cancels up to 20 previous, consecutive changes. Undo clears every time you save your setup file or send your 
changes to the intercom system in ONLINE mode. 

Undo is available in the Edit menu and via the Undo button. 

UPL Resources 

Use UPL Resources to set up the Scroll Enable feature for UPL Resources. If Ctrl+F12 Alpha Editing is activated, 
you can also use this menu item to assign names (Alphas) for UPL Resources. 

User Programmable Logic Statements 

Programmable Logic Statements create programming statements to trigger actions based on specified conditions.  
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View Log 

View Log starts an auxiliary program called Log Viewer, which lets you view files that have been saved with the Log 
to File feature. 

View Mode 

Use View Mode to toggle between normal and enhanced views for some setup screens.  

View mode is only used with the Keypanel / Ports screen to toggle between view by Panel Type and view by Setup 
Page.  

Volume button 

The Volume button accesses the gain controls for the current port or keypanel. 
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Warn on Exit 

 

A Warn on Exit message appears to confirm whenever you attempt to exit AZedit. 
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XPT (CROSSPOINT) 

Use the XPT (Crosspoint) window to view intercom ports that are currently talking and/or listening to each other. 
From this window you can turn talk and/or listen paths ON or OFF between selected intercom ports, as well as view 
all events and settings that are currently affecting the gain between two intercom ports.  

XPT Force  

Use the XPT Force button to force a crosspoint closure between the port currently being viewed and the port 
selected. 

XPT Inhibit  

Use the XPT Inhibit button to restrain a crosspoint closure between the port currently being viewed and the port 
selected. 

XPT Port alpha 

The XPT Port Alpha box contains the alpha assigned to the port currently being viewed. 

XPT Port number 

The XPT Port Number box contains the number assigned to the port currently being viewed. 
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